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Foreword
This user’s manual contains useful information about the functions and operating 
procedures of the MXLOGGER and lists the handling precautions of the software. To 
ensure correct use, please read this manual thoroughly before beginning operation.
After reading this manual, keep it in a convenient location for quick reference in the event 
a question arises during operation.
The following manuals are provided in addition to this one. Read them along with this 
manual.
Manual Title Manual No. Description
MX100 Data Acquisition Unit 
User’s Manual

IM MX100-01E Contains useful information about 
the functions, installation and wiring 
procedures, and handling precautions of 
the MX100 Data Acquisition Unit.

MX100 Data Acquisition Unit 
Installation and Connection Guide 

IM MX100-72E Describes concisely the installation and 
wiring procedures of the MX100 Data 
Acquisition Unit.

Notes
•	 License numbers will not be reissued. Please keep your license numbers in a 

safe place.
•	 This manual describes the functions and operating procedures of MXLOGGER when 

connected to style number S3 of the MX100 Data Acquisition Unit. When connected to 
a style number prior to S3 of the MX100 Data Acquisition Unit, certain functions may 
not be available.

•	 The contents of this manual are subject to change without prior notice as a result of 
continuing improvements to the software’s performance and functions. Display contents 
illustrated in this manual may differ slightly from what actually appears on your screen.

•	 Every effort has been made in the preparation of this manual to ensure the accuracy 
of its contents. However, should you have any questions or find any errors, please 
contact your nearest YOKOGAWA representative, dealer, or sales office.

•	 This user’s manual does not cover the handling and operating procedures of Windows.
•	 Copying or reproducing all or any part of the contents of this manual without 

YOKOGAWA’s permission is strictly prohibited.

Trademarks
•	 DAQWORX, DAQLOGGER, and DAQEXPLORER are registered trademarks or 

trademarks of Yokogawa Electric Corporation.
•	 Microsoft and Windows are registered trademarks or trademarks of Microsoft 

Corporation in the United States and/or other countries.
•	 Adobe and Acrobat are registered trademarks or trademarks of Adobe Systems 

Incorporated.
•	 Company and product names that appear in this manual are registered trademarks or 

trademarks of their respective holders.
•	 The company and product names used in this manual are not accompanied by the 

registered trademark or trademark symbols (® and ™).

Revisions
•	 1st Edition		 July 2003
•	 2nd Edition		 February 2005
•	 3rd Edition		 June 2007
•	 4th Edition		 March 2008
•	 5th Edition		 January 2009

5th Edition : January 2009 (YK)
All Rights Reserved, Copyright © 2003 Yokogawa Electric Corporation
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Terms and Conditions of the Software License

NOTICE - PLEASE READ CAREFULLY BEFORE USE
Thank you very much for purchasing this medium containing a software program and related documentation provided by Yokogawa Electric Corporation (hereinafter called 
“Yokogawa”), and the program contained, embedded, inserted or used in the medium (hereinafter called the “Yokogawa Software Program”).
By installing the Yokogawa Software Program, you acknowledge that you understand and fully agree to the “Terms and Conditions of the Software License” (hereinafter called 
“Terms and Conditions”) which is written in the documentation and separately attached. Accordingly, the Terms and Conditions bind you.
The Yokogawa Software Program and its related documentation including ownership of copyright shall remain the exclusive property of Yokogawa or those third parties who 
grants Yokogawa the rights.
Yokogawa hereby grants you permission to use the Yokogawa Software Program on the conditions that you agree to the Terms and Conditions before you install it in or onto 
a computer.

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS, YOU CANNOT INSTALL THIS MEDIUM, AND MUST PROMPTLY RETURN IT TO YOKOGAWA OR ITS 
DESIGNATED PARTY.

Terms and Conditions of the Software License
Yokogawa Electric Corporation, a Japanese corporation (hereinafter called “Yokogawa”), grants permission to use this Yokogawa Software Program (hereinafter called the 
“Licensed Software”) to you on the conditions that you agrees to the terms and conditions stipulated in Article 1 hereof.
You, as the Licensee (hereinafter called “Licensee”), shall agree to the following terms and conditions on the software license (hereinafter called the “Agreement”) when the 
Licensed Software is installed by the Licensee.
Please note that Yokogawa grants the Licensee permission to use the Licensed Software under the terms and conditions herein and in no event shall Yokogawa intend to 
sell or transfer the Licensed Software to the Licensee.

Article 1 (Licensed Software under these Terms and Conditions)
1.1	 The terms and conditions stipulated herein shall bind any Licensee who purchases the Licensed Software on the condition that the Licensee consents to agree to the 

terms and conditions stipulated herein.
1.2	 The “Licensed Software” and required number of license herein shall be specified in the following paragraphs (1) and (2) respectively. The Licensed Software means 

and includes all applicable programs and documentation, without limitation, all proprietary technology, algorithms, a factor, invariant, process and/or other know-how 
contained therein. These terms and conditions shall also govern any additional software to the Licensed Software inclusive of its version-up or revision-up if Yokogawa 
provides them to the Licensee.
(1)	 Licensed Software Name: Data Acquisition Software Suite DAQWORX
(2)	 Number of License: Same number as those media for the Licensed Software shall be acquired for installation.

Article 2 (Grant of License)
2.1	 Yokogawa grants the Licensee, for the purpose of single use, non-exclusive and non-transferable license of the Licensed Software with the license fee separately agreed 

upon by both parties.
2.2	 The Licensee is, unless otherwise agreed upon in writing by Yokogawa, not entitled to change, sell, distribute, transfer, or sublicense the Licensed Software.
2.3	 The Licensed Software shall not be copied in part or in whole except for keeping one (1) copy for back-up purpose. The Licensee shall secure or supervise the copy of 

the Licensed Software by the Licensee itself with great, strict, and due care.
2.4	 The Licensed Software remains the exclusive property of Yokogawa and, if any, those of third parties from whom Yokogawa is sublicensed (hereinafter such third party’s 

software is called “Third Party Software”, which may include any software program made or coded by affiliates of Yokogawa). In no event shall the Licensee dump, 
reverse assemble, reverse compile, or reverse engineer the Licensed Software so that the Licensee may translate the Licensed Software into other programs or change 
it into a man-readable form from the source code of the Licensed Software. Unless otherwise separately agreed upon by Yokogawa, Yokogawa shall not provide the 
Licensee the source code for the Licensed Software.

2.5	 The Licensed Software and its related documentation inclusive of its ownership of copyright shall be the proprietary property of Yokogawa or a third party who grants 
Yokogawa the rights. In no event shall the Licensee transfer, lease, sublicense, or assign any rights relating to the Licensed Software.

2.6	 Yokogawa may use or add copy protection in or onto the Licensed Software. In no event shall, regardless of the purpose, the Licensee remove or attempt to remove 
such copy protection.

2.7	 The Licensed Software may include the Third Party Software. In the case that Yokogawa is granted permission to sublicense to third parties by any licensors (sub-
licensor) of the Third Party Software under different terms and conditions than those stipulated in this  Agreement, the Licensee shall observe such terms and conditions 
of which Yokogawa notifies the Licensee in writing separately.

2.8	 In no event shall the Licensee modify, remove or delete a copyright notice of Yokogawa and its licenser contained in the Licensed Software, including any copy 
thereof.

Article 3 (Restriction of Specific Use)
3.1	 The Licensed Software shall not be intended specifically to be designed, developed, constructed, manufactured, distributed or maintained for the purpose of the following 

events:
a)	 Operation of any aviation, vessel, or support of those operations from the ground;
b)	 Operation of nuclear products, its facilities and/or radiation apparatus;,
c) 	 Operation of nuclear weapons, chemical weapons and/or biological weapons, or railroad; or
d)	 Operation of medical instrumentation directly utilized for humankind or the human body.

3.2	 Even if the Licensee uses the Licensed Software for the purposes in the preceding Paragraph 3.1, Yokogawa has no liability to or responsibility for any claims or 
damages arising out of the use or operations of the Licensed Software, and the Licensee agrees, on its own responsibility, to solve and settle the claims and damages 
and to defend, indemnify or hold Yokogawa totally harmless, from or against any liabilities, losses, damages and expenses (including fees for recalling the Products and 
reasonable attorney’s fees and court costs), or claims arising out of and related to the above-said claims and damages.

Article 4 (Warranty)
4.1	 The Licensee shall agree that the Licensed Software shall be provided to the Licensee on an “as is” basis when delivered. If defect(s), such as damage to the medium of 

the Licensed Software, attributable to Yokogawa is found, Yokogawa agrees to replace, free of charge, any Licensed Software on condition that the defective Licensed 
Software shall be returned to Yokogawa’s specified authorized service facility within  12 month from the delivery of Yokogawa after opening the Package at the Licensee’s 
expense. As the Licensed Software is provided to the Licensee on an “as is” basis when delivered, in no event shall Yokogawa warrant that any information on or in the 
Licensed Software, including without limitation, data on computer programs and program listings, be completely accurate, correct, reliable, or the most updated.

4.2	 Notwithstanding the preceding Paragraph 4.1, when Third Party Software is included in the Licensed Software, the warranty period and related conditions that apply 
shall be those established by the provider of the third party software.
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4.3	 When Yokogawa decides in its own judgement that it is necessary, Yokogawa may from time to time provide the Licensee with Release Upgrades specified by Yokogawa 
(hereinafter called “Release Upgrades”).

4.4	 Notwithstanding the preceding Paragraph 4.3, in no event shall Yokogawa provide Updates where the Licensee or any third party conducted renovation or improvement 
of the Licensed Software.

4.5	 Correction of nonconformity in the manner and for the period of time provided above shall be the Licensee’s sole and exclusive remedy for any failure of Yokogawa to 
comply with its obligations and shall constitute fulfillment of all liabilities of Yokogawa and any third party licensing the Third Party Software to Yokogawa (including any 
liability for direct, indirect, special, incidental or consequential damages) whether in warranty, contract, tort (including negligence but excluding willful conduct or gross 
negligence by Yokogawa) or otherwise with respect to or arising out of the use of the Licensed Software.

4.6	 THE FOREGOING WARRANTIES ARE EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES OF QUALITY AND PERFORMANCE, WRITTEN, ORAL, OR 
IMPLIED, AND ALL OTHER WARRANTIES INCLUDING ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE ARE 
HEREBY DISCLAIMED BY YOKOGAWA AND ALL THIRD PARTIES LICENSING THIRD PARTY SOFTWARE TO YOKOGAWA.

Article 5 (Infringement)
5.1	 If and when any third party should demand injunction, initiate a law suit, or demand compensation for damages against the Licensee under patent right (including utility 

model right, design patent, and trade mark), copyright, and any other rights relating to any of the Licensed Software, the Licensee shall promptly notify Yokogawa in 
writing to that effect.

5.2	 In the case of the preceding Paragraph 5.1, the Licensee shall assign to Yokogawa all of the rights to defend the Licensee and to negotiate with the claiming party. 
Furthermore, the Licensee shall provide Yokogawa with necessary information or any other assistance for Yokogawa’s defense and negotiation. If and when such a 
claim should be attributable to Yokogawa, subject to the written notice to Yokogawa stated in the preceding Paragraph 5.1, Yokogawa shall defend the Licensee and 
negotiate with the claiming party at Yokogawa’s cost and expense and be responsible for the final settlement or judgment granted to the claiming party in the preceding 
Paragraph 5.1.

5.3	 When any assertion or allegation of the infringement of the third party’s rights defined in Paragraph 5.1 is made, or when at Yokogawa’s judgment there is possibility of 
such assertion or allegation, Yokogawa will, at its own discretion, take any of the following countermeasures at Yokogawa’s cost and expense.
a)	 To acquire the necessary right from a third party which has lawful ownership of the right so that the Licensee will be able to continue to use the Licensed 

Software;
b)	 To replace the Licensed Software with an alternative one which avoids the infringement; or
c)	 To remodel the Licensed Software so that the Licensed Software can avoid the infringement of such third party’s right.

5.4	 If and when Yokogawa fails to take either of the countermeasures as set forth in the preceding subparagraphs of Paragraph 5.3, Yokogawa shall indemnify the Licensee 
only by paying back the price amount of the Licensed Software which Yokogawa has received from the Licensee. 

	 THE FOREGOING PARAGRAPHS STATE THE ENTIRE LIABILITY OF YOKOGAWA AND ANY THIRD PARTY LICENSING THIRD PARTY SOFTWARE TO YOKOGAWA 
WITH RESPECT TO INFRINGEMENT OF THE INTELLECTUAL PROPERTY RIGHTS INCLUDING BUT NOT LIMITED TO, PATENT AND COPYRIGHT.

Article 6 (Liabilities)
6.1	 If and when the Licensee should incur any damage relating to or arising out of the Licensed Software or service that Yokogawa has provided to the Licensee under 

the conditions herein due to a reason attributable to Yokogawa, Yokogawa shall take actions in accordance with this Agreement. However, in no event shall Yokogawa 
be liable or responsible for any special, incidental, consequential and/or indirect damage, whether in contract, warranty, tort, negligence, strict liability, or otherwise, 
including, without limitation, loss of operational profit or revenue, loss of use of the Licensed Software, or any associated products or equipment, cost of capital, loss 
or cost of interruption of the Licensee’s business, substitute equipment, facilities or services, downtime costs, delays, and loss of business information, or claims of 
customers of Licensee or other third parties for such or other damages. Even if Yokogawa is liable or responsible for the damages attributable to Yokogawa and to the 
extent of this Article 6, Yokogawa’s liability for the Licensee’s damage shall not exceed the price amount of the Licensed Software or service fee which Yokogawa has 
received. The Licensee agrees that Yokogawa shall be released or discharged from part or all of the liability under this Agreement if the Licensee modifies, remodels, 
combines with other software or products, or causes any deviation from the basic specifications or functional specifications, without Yokogawa’s prior written consent.

6.2	 All causes of action against Yokogawa arising out of or relating to this Agreement or the performance or breach hereof shall expire unless Yokogawa is notified of the 
claim within one (1) year of its occurrence.

6.3	 In no event, regardless of cause, shall Yokogawa assume responsibility for or be liable for penalties or penalty clauses in any contracts between the Licensee and its 
customers.

Article 7 (Limit of Export)
Unless otherwise agreed by Yokogawa, the Licensee shall not directly or indirectly export or transfer the Licensed Software to any countries other than those where Yokogawa 
permits export in advance.

Article 8 (Term)
This Agreement shall become effective on the date when the Licensee receives the Licensed Software and continues in effect unless or until terminated as provided herein, 
or the Licensee ceases using the Licensed Software by itself or with Yokogawa’s thirty (30) days prior written notice to the Licensee. When aforesaid termination or cease is 
occurred, the Licensee shall immediately destroy and/or eliminate the Licensed Software and related documents without retaining any copies or extracts thereof. However, 
upon specifically instructed by Yokogawa, they shall be returned to Yokogawa or its designated third party.

Article 9 (Injunction for Use)
During the term of this Agreement, Yokogawa may, at its own discretion, demand injunction against the Licensee in case that Yokogawa deems that the Licensed Software is 
used improperly or under severer environments other than those where Yokogawa has first approved, or any other condition which Yokogawa may not permit.

Article 10 (Termination)
Yokogawa, at its sole discretion, may terminate this Agreement without any notice or reminder to the Licensee if the Licensee violates or fails to perform this Agreement. 
However, Articles 5, 6, and 11 shall survive even after the termination.

Article 11 (Jurisdiction)
Any dispute, controversies, or differences between the parties hereto as to interpretation or execution of this Agreement shall be resolved amicably through negotiation 
between the parties upon the basis of mutual trust. Should the parties fail to agree within ninety (90) days after notice from one of the parties to the other, both parties hereby 
irrevocably submit to the exclusive jurisdiction of the Tokyo District Court (main office) in Japan for settlement of the dispute to the fullest extent allowed by applicable law.

Article 12 (Governing Law)
This Agreement shall be governed by and construed in accordance with the laws of Japan. The Licensee expressly agrees to waive absolutely and irrevocably and to the 
fullest extent permissible under applicable law any rights against the laws of Japan which may have pursuant to the Licensee’s local law.

Article 13 (Severability)
In the event that any provision hereof is declared or found to be illegal by any court or tribunal of competent jurisdiction, such provision shall be null and void with respect to 
the jurisdiction of that court or tribunal and all the remaining provisions hereof shall remain in full force and effect.

Terms and Conditions of the Software License
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1.1	 Functional Overview of MXLOGGER

Functional Overview
The MXLOGGER can be used to connect up to twenty MX100 Data Acquisition Units 
(hereinafter, “MX100s”) to a single PC and acquire data.

MX100

MX100

MX100

Connect up
to 20 units

Hub

MX100 Data
Acquisition Unit

MXLOGGER

PC

The MXLOGGER consists of the following three software programs: Logger, Viewer, and 
Calibrator.
•	 Logger
	 You can use the Logger to set data record conditions and measurement conditions, 

set up computations, set alarms, set digital outputs, start/stop data monitoring, display 
the monitor, record (save) data, and so on. 

			 

Chapter 1	 Before Using the Software
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•	 Viewer
	 You can use the Viewer to (1) display measured and computed data that has been 

recorded (saved), (2) read values and perform statistical computation over an area 
using cursors, and (3) convert the measured and computed data into various file 
formats such as Excel. 

			 

•	 Calibrator
	 You can use the Calibrator to calibrate the MX100 universal input modules. 

			 

Logger
On the Logger, the following screens (windows) are used to enter settings.

•	 System Screen
	 On this screen, you can search for MX100s in the same network segment, set 

communication parameters of the detected MX100s such as the IP address, select 
the MX100s to be connected, select measurement groups (groups that have the same 
monitor interval/record interval), and perform other functions. 

•	 Acquisition Screen
	 You can set the monitor interval of the measured data, the record step of the data, 

and the record start/stop conditions. You can also set the save destination and the file 
name of the record data, set up the file division function, and perform other functions. 

•	 Channel Setup Screen
	 For each measurement channel, you can set (1) the measurement conditions such 

as the input mode, measurement range, and measurement span, (2) whether to 
carry out measurement/recording, and (3) the alarm conditions. You can also set 
up computations such as the four arithmetical operations using the measured data 
(computation channel setting), set the signal to be output from the digital output 
module (DO channel setting), and set up modules such as the analog output and 
PWM output modules.

•	 General Display Settings Window
	 For each display group, you can set the channels to be displayed, display scale, 

display zone, trip point (the value of interest in the waveform display), display color, 
and other parameters.

1.1  Functional Overview of MXLOGGER
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On the Logger, you can also perform operations such as starting/stopping data 
monitoring, displaying the monitor window, pausing the monitor, and starting/stopping 
data recording, as well as displaying the Run screen used to monitor the communication 
status of the connected MX100s and the status of data monitoring and recording.
The types of monitor windows available are the Trend Monitor that displays the data 
using waveforms, the Numeric Monitor that displays the data using instantaneous values, 
the Meter Monitor that displays the data using three types of meters, and the Alarm 
Monitor that displays the status of alarm occurrences.

•	 Monitor Screen
	 You can display the waveforms and numerical values of the measured/computed 

data, change the display method, start/stop the recording of the measured/computed 
data, pause the monitor, manually control the digital output, analog output, and PWM 
output, and perform other operations. When the monitor is paused, you can display 
the past data and read computed/measured values using cursors.

In addition to the operations described above, you can also save the setup data (project), 
print a list of settings, and perform other operations from the menu.

Viewer
You can load the measured/computed data that was recorded (saved) in the past and 
carry out the following operations. 
•	 Synchronization
	 When the data file is opened, the measurement time is corrected based on the time 

information of the PC.
•	 Display waveforms and numeric values
•	 Display a list of alarms and marks
•	 Change the display conditions (group assignments, scale, trip point, display color and 

other parameters)
•	 Read the data values using cursors
•	 Perform statistical computation over an area
•	 Display and add marks
•	 Print the displayed waveform and numeric values 
•	 Save or load display conditions
•	 Display the file information
•	 Convert data formats (ASCII, Excel, and Lotus)
•	 Print data (waveforms, numeric values, alarm/marker list, cursor values, statistics over 

an area, and computed values)
•	 Using templates and save
•	 Join divided CF files

Calibrator
You can connect to the MX100, display the modules that can be calibrated, and carry out 
calibration of each measurement range. 

1.1  Functional Overview of MXLOGGER
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1.2	 MXLOGGER Operation Guide

Flow of Operations during Installation
The figure below shows the general flow of operation when the MX100 is installed 
initially. 

Wire the input/
output modules

Operations on the MX100 Operations on the PC

Connect the
network cable

Connect the power
cord

Turn ON the power
switch

Set up the
MXLOGGER

Set the network
parameters of the PC

Start the
logger

Search the MX100/
configure the network

Configure the system

Set the data
acquisition condition

Set the measurement
conditions/set

the computation

Acquire/Monitor the data
and monitor the alarm

Change the display
conditions

Record the data

Install the MX100

See the Installation
and Connection Guide.

Section 2.1

Section 2.2

Section 2.3

Sections 2.4 and 2.5

Section 2.10 Section 2.10

Section 2.12

Section 3.4

Start the
Viewer

Display the recorded
data

Perform statistical
computation over an

area of data

Read values using
cursors

Convert the data
format

Print the displayed
data

Sections 3.1 and 3.2

Section 3.3 Section 3.7

Section 3.8

Section 1.5

Section 1.5

Section X.X indicates the referred
sections in this manual.

*The available digital 
(DO) outputs are alarm 
output, manual DO, fail 
output, and error output.

The Installation and Connection Guide (IM 
MX100-72E) is an abridged manual provided with 
the MX100 main module. The Installation and 
Connection Guide does not explain all the 
functions and operations. It also does not cover the 
details of the precautions and limitations of usage. 
For a detailed explanation, see the MX100 Data 
Acquisition Unit User's Manual (IM MX100-01E) 
contained in the manual CD-ROM.

See the DAQWORX Installation 
and Operation Guide (IM 
WX1000-01E).

Set the appropriate IP address, 
subnet mask, and default 
gateway of the PC.

Search all connected MX100s and 
configure the network parameters 
such as the IP address of the 
connected MX100s.

Select the MX100 to be connected, 
select the acquisition interval of 
each input module, etc.

Select the acquisition interval to be 
used, select the record interval, set 
record start/stop conditions, etc.

Set the transmission 
output

Section 2.8

Set analog/PWM output and others

Set the alarm

Section 2.6
Set the alarm
See section 2.7 for digital output* 
settings.

Set up events

Section 2.9

Set individual events

Set the input mode, 
measurement range, 
measurement span, etc.
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Overview of Operations 
This section briefly explains the operations to be carried out after “Start the Logger” 
described in the “Flow of Operations during Installation” on the previous page. 

Note
For details on other operations, see the referred sections in this manual or other manuals 
indicated in “Flow of Operations during Installation.”

Before carrying out the procedure below, connect the PC and the MX100s locally via a 
hub and turn ON the power to the MX100s that are to monitor the data as indicated on 
page 1-1. 

Choose Programs > YOKOGAWA DAQWORX > MXLOGGER > Logger.
The Logger starts and the main window opens.Start the Logger

For details, see
section 1.5.

5 Select the check boxes for the MX100s whose
network settings you wish to change.

Enter the machine name and
IP address.

Default settings can be
used for local connection.

6

7 Click Apply button. Click OK in
the dialog box that opens.

8 When the network configuration
is successful, Complete appears.

Click Close.

System screen of the Main window

Search the MX100/
configure the network

For details, see
section 2.1.

1 Click here.

2 Click Search.

To identify MX100s

Click Network Config.
The Network Config.
dialog box opens.

4

3 Displays the MX100s that are connected in the
same segment.

1.2  MXLOGGER Operation Guide
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1

Click the       button or the word Undefined to select the measurement group on each
module or click Auto Assignment to automatically assign suitable measurement groups.
If you click the Auto Assignment button, the Auto Assignment dialog box opens.
Click OK.

Drag and drop the icon of the MX100 you wish to connect to the
Configuration area.

To retrieve current module information

2

Used when changing the unit number of the MX100
(move up or down) or when adding/deleting the MX100

Select the check box to delete the old data
and save the data to the CF card repeatedly.

When assigning the module to the measurement group
(see the figure below)

Assign measurement groups in the Meas Groups area

Drag and drop the module icon to the Meas Group area.

To check which MX100 is connected
(When clicked, the word "--CALL--"
appears on the 7-segment LED
of the main module.)

Configure the system

For details, see
section 2.2.

Click Yes when the dialog box below opens.

Module nameTo check the size 
of the CF

Click the       button or the word Undefine to select the measurement group on each
module or click Auto Assignment to automatically assign suitable measurement groups.
If you click the Auto Assignment button, the Auto Assignment dialog box opens.
Click OK.

Select the A/D integral time Select the temp. unit

1.2  MXLOGGER Operation Guide
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2

Set the record step for each group.

Set the record start
condition.1

3

Set the record
stop condition.1

4

Click here.1

Click here to hide the Record
information area on the right.

Set the save destination and
name of the record file.2

6

5

Set the acquisition interval for each measurement group.
You cannot set the acquisition interval of
measurement groups that do not have modules
assigned in step       of "Configure the system."2

Set the data acquisition
condition

For details, see
section 2.3.

1.2  MXLOGGER Operation Guide
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Setup display/input area
for each channel

Click here.1

Click here to hide
the right area

Select the measurement
range. Maximum/Minimum values of the scale*

Select the check boxes here to perform scaling*
Decimal point position of the scale*

Minimum/Maximum
value of span

Select the input type.
* Cannot be used when Mode is set to RRJC

Select whether to make measurements.
Select whether to record (save) the data.

Channel
number

When setting difference input*, remote RJC, unit, tab No.,
tag comment, filter, burnout, or RJC

4

2
3

5

• Set the measurement conditions

Set the measurement
conditions/set the

computation
For details,
see section
2.4 and 2.5.

Click here to hide
the right area

Constant values

Labels indicating constants

Set the unit.

Select whether to compute.

Select whether to record (save) the computed data.
Channel number

Click here.1

When setting the tag No.
or tag comment

Set the parameters here when
using timers in the computation

Set the equation.

2

3

4

5

• Set the computation

Setup display/input
area for each channel

Select the check box here to calculate 
+Over and -Over as maximum and 
minimum values of the measurement range

1.2  MXLOGGER Operation Guide
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Click here.1Set the hysteresis of alarm 1.
Set the alarm value of alarm 1.

Select the alarm 1 type.

Hysteresis of alarm 2
Alarm value of alarm 2

Alarm 2 type

For measurement
channels

Scroll the setup parameters
to the right to display the
alarm setup parameters.

Switch to alarm settings

2

3
4

5

6

Setup display/input area
for each channel

Set Ararm2 to 
Alarm 4 when 
setting 2 to 4 alarms.

Click here to hide the right area

Set the alarm

For details, see
section 2.6.

Set the manual DO button

Alarm 1/alarm 2
reference

Select the output action.
Select output/not output.

Channel number

Click here.1

Reference channel range
when outputting alarm

To set the energize/de-energize of output relay or
hold/non-hold of output relay, scroll to the right.

2
3

4

Setup display/input area
for each channel

Set these parameters
when outputting alarms.

Click here to hide the right area

Set the digital output

For details, see
section 2.7.

1.2  MXLOGGER Operation Guide
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1  Click here.

Set up analog output

For details, see
 section 2.8.

4  Select Output/Not output.
3  Select the output action.

Channel number

2  Click PWM Channel.

To set the span of PWM output, output action, 
pulse, and pattern output, scroll to the right.

Setup display/input area 
for individual channels

5  Select the reference 
channel for 
transmission output

4  Select the output action.
3  Select Output/Not output.

Channel number 5  Select the reference 
channel for 
transmission output

Click here to hide 
the right area

1  Click here.2  Click AO Channel.

To set the range of analog output, span, output action, 
and pattern output, scroll to the right.

Setup display/input area 
for individual channels

Click here to hide 
the right area

Set up PWM output

For details, see
section 2.8.

1.2  MXLOGGER Operation Guide
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Click here.

Click the event to be set.

1

2

Input or select each item4

3 Click or input items of the event to 
be set

3

Click to open the folder containing the event 
log file 

Event settings window

The Event Setting window appears. 

Set up events

For details, see
 section 2.9.

1.2  MXLOGGER Operation Guide
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Click here.1

Name of manual DO*
Manual DO ON/OFF button

Operation of an user output

Amount of used space/free space of the drive
containing the file save destination directory

Information about the record
Information of communication
status of each MX100, etc.

Main operating status of MXLOGGER and current time

To pause the display updating on the monitor
To stop data recording

Alarm monitor

Meter monitor

All Channel Monitor 

Digital monitor

Trend monitor

2 Click the icon corresponding 
to the monitor you wish to display.

Run screen

The Run screen appears when data
acquisition is started.

Start data recording,
monitor the data, and 

monitor the alarm

For details, see
section 2.10.

* Can be changed when data recording is stopped.

•	 Alarm Monitor

		

To display alarm signals per display group

Group number

Switch between channel number,
tag No., and tag comment

Alarm indication per Channel

To display alarm signals per
channelClick here.

When an alarm occurs,
yellow-green changes
to red.
If unacknowledged
alarms exist, a blinking
yellow ring appears
around the signal lamp.

Click here or choose
Display-Alarm ACK
from the Action menu
to acknowledge the
alarm. The outer ring
disappears.

1.2  MXLOGGER Operation Guide
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•	 Trend Monitor

		

Switch the display group

Displays a red bar on the group with an alarm occurring

Y-axis

Waveform display ON/OFF

Change the grid density

Channel number and
measurement unit

Change the background
darkness

Zoom in or out of the time axis

Switch the display zone

Switch the grid density

Switch the Y-axis

Switch the thickness of the
waveform

Waveform display limit
ON/OFF (Clip)

Time axis magnification

Monitor interval

Click here.

Switch between channel number, tag No., and tag comment

•	 Numeric Monitor

		

Level with respect to
the scale width

Numeric display
Unit

Channel color

Channel number

When the measured value exceeds the
measurement range

Alarm indication

Click here.

Switch between channel number,
tag No., and tag comment

1.2  MXLOGGER Operation Guide
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•	 Meter Monitor

		

Numeric
display

Unit

Channel color
Channel
number

Alarm indication Click here.

Displays a red bar on the group with an alarm occurring
Switch between channel number,
tag No., and tag comment

Thermometer Bar meterAnalog meter

	

•	 All Channel Monitor 

		

Click here.

Zoom in or out of the time axis

Turn ON/OFF the waveform 
display limit 

Monitor Interval

Change the grid density

Change the background 
darkness

Change the grid thickness 

Switch the thickness of the 
waveform

The All Channel Monitor screen opens. 

1.2  MXLOGGER Operation Guide
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Click here while data acquisition is in progress1

Display format of Y-axis

Switch the display group
Select the
channelDisplay ON/OFF

Turn ON/OFF collectively

Y-axis type (linear or logarithmic)

Turn scale ON/OFF
when displaying
multi-axes zone

Max./Min. value of the scale

Display zone position

Trip point

Number of channels assigned
automatically

Channel
color

Execute automatic
channel assignment

To copy

To not copy

Reset to default

Assign channels automatically

When making the settings the same as the first item

1

       1 To apply the setting changes, click OK. To not apply the changes, click Cancel.
 To apply the changes and keep the screen opened, click Apply.
       2 To copy/paste the settings at the channel level, click the respective buttons.

2

Group name

Meter type

2 Change the items on the General Display Settings window

Displays the General
Display Settings window

Change the display
conditions

For details, see
section 2.10.

1.2  MXLOGGER Operation Guide
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Click the Start Recording button while monitoring the data,
or choose Start Recording from the Acquisition menu.

2

Record time

To pause the monitor display,
click Pause or choose Pause
from the Acquisition menu.

To stop acquisition, click Stop Recording or
choose Stop Recording from the Acquisition menu.

To divide the data file, click Manual Save or choose Manual
Save from the Acquisition menu.

To stop recording, click Stop Recording or choose
Stop Recording from the Acquisition menu.

Changes to red when recording starts

Changes to red when
recording starts

or

A list of data files created in the past

Select a file and click the Open button
to start the Viewer. (You can also
double-click to start the program.)

For the procedure for setting the record start
conditions and setting the data file save
destination and file name, see page 1-7.

Display when the program is
waiting for the record start
condition to be met Display when processing record stop

Click the          button or choose 1 Main from the Window menu
The Main window appears.

1

When Run is
displayed

Record the data

For details, see
section 2.12.

1.2  MXLOGGER Operation Guide
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Click the         button on the Logger toolbar or
choose Data Viewer from the File menu.
If the Logger is not running, choose Programs > YOKOGAWA DAQWORX > MXLOGGER > Viewer.

The Viewer window
appears.

Start the
Viewer

For details, see
section 1.5.

Click the        button on the toolbar or choose Open from the File menu.
2

Click here.3

Select the folder that was specified as the save
destination of the record file.

Information about
the selected file

4Select the file 
you wish
to load.

5 If you open a data file that was recorded using the Logger, a dialog box opens asking you
whether you wish to synchronize the data file before the waveform display window opens.

6

Waveform 
display
window

Switch the
display group

Y-axisChannel ON/OFF

Grid density

Channel number and unit

Background
color density

Switch the display zone
Switch the active channel

Alarm display 
ON/OFF

Clip ON/OFF

Zone display
section ON/OFF

1

Click Yes or No.

Switch between channel number,
tag No., and tag comment

Move the cursor to the 
point wherethe alarm changed

* The time stamp of the MX100 main module 
is attached to the data. The measurement 
time is corrected by synchronizing. If you are 
not synchronizing the data, a Select Unit No. 
dialog box opens. Select the unit.

The Open dialog box opens.

Display the recorded
data

For details,
see section
3.1 and 3.2.

Switch the grid density

1.2  MXLOGGER Operation Guide
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1

From the Window menu, choose Control.4

Channel number and
measurement unit

Channel color

Time between Cursors A and B

Time at the Cursor B

Time at the Cursor A

Value at the Cursor B position – value at the Cursor A position

Value at the
Cursor B

Value at the
Cursor A

Alarm indication

Data number at the
Cursor A

Move Cursor A
Data number at the Cursor B

Move Cursor B

Difference in the data number between Cursors A and B

Click the tab of the group in which you wish to read values using the cursors

Measurement point

If you wish to read another 
point simultaneously,
drag the cursor.
(Cursor B)

Click the position where you 
wish to read the data value
(Cursor A)

2

3

The Control window
appears.

Read values using
cursors

For details, see
section 3.3.

From the Window menu, choose Statistics.1

Channel number
and measurement
unit

Channel
display color

Data number at the
start position of the
statistical computation
over an area

Data number at the
end position of the
statistical computation
over an area

Minimum value

Maximum value

Max. value –
Min. value

Mean value

RMS value

Scroll the
channel

The Statistics window
appears.

Perform statistical
computation over

an area of data

For details, see
section 3.4.

Copy data to the clipboard

1.2  MXLOGGER Operation Guide
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From the Convert menu, choose To ASCII, To Excel, or To Lotus.1

Range of group numbers to be converted
Select whether to set the range to be converted using groups or channels

Select the range of channels to be converted
(Show the channel selection dialog box)

Select the record interval
(Only the channels with the selected record interval 
will be converted)

Data range to be converted
(You can specify the data range using the cursor before opening this dialog box.)

Measurement time of the data at the specified start 
and stop points

When changing the save destination or file name

Step when converting data at certain intervals

Save destination and file name

2

Click OK.3

The respective conversion dialog box opens.

Set the items in the conversion dialog box.

Convert the data
format

For details, see
section 3.7.

Specify the format when converting files

From the File menu, choose Print Setting.2

3

Enter the comment to be printed

Switch to settings for numeric values
(The only item for numeric printing is Range only.)

Select the groups when Selected
Groups is selected
(Show the group selection
dialog box)

Select monochrome or color print

Select the group to be printed

Select whether to print all or the range specified by the cursors

1 Show the window you wish to print
If multiple windows are opened, click the window you wish to print to make it active.

Click OK.4

5 From the File menu, choose Print.
In the Print dialog box that opens, click OK. Printing is executed.

The Printout Setting dialog
box opens.

Set the items in the Printout Setting dialog box.

Print the displayed data

For details, see
section 3.8.

1.2  MXLOGGER Operation Guide
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1.3	 PC System Requirements

PC
A PC that runs one of the OS above, and that meets the following CPU and memory 
requirements. 
	 When Using Windows 2000 or Windows XP

Pentium 4, 1.6 GHz or faster
512 MB or more of memory

	 When Using Windows Vista
Pentium 4, 3 GHz or faster
2 GB or more of memory 

Note
•	 The specifications above are for a desktop PC, not a notebook PC. 
•	 Even if the PC meets the specifications above, monitoring/recording may not be possible as 

configured depending on the setup conditions (alarms, computations, etc.) on the Logger. 

Operating System
Run DAQWORX under any of the following operating systems. 
•	 Windows 2000 Professional SP4
•	 Windows XP Home Edition SP2, SP3
•	 Windows XP Professional SP2, SP3 (excluding Windows XP Professional x64 Edition)
•	 Windows Vista Home Premium, SP1 (excluding the 64-bit edition)
•	 Windows Vista Business, SP1 (excluding the 64-bit edition)
The language displayed by the software under different language versions of the OS are 
as follows. 

OS Language Software Language
Japanese Japanese
Other English

File System
NTFS is recommended. With FAT32, the number of files that can be saved in a single 
folder is much smaller. If the limit is reached and additional files cannot be saved, the 
software will not function normally. To prevent this, please periodically stop recording by 
the software and move the data to a different folder. 

CD-ROM Drive
The drive is used to install the software. 

Free Hard Disk Space and RPMs
Free disk space:	 200 MB or more  (more may be required depending on the amount of 

data to be acquired)
RPMs:	 7200 rpm or faster recommended

Monitor
	 When Using Windows 2000 or Windows XP
	 A monitor supported by the OS of 1024 × 768 dot or higher and 65,536 colors or more.
	 When Using Windows Vista
	 A video card recommended for use with Vista and a monitor supported by the OS of 

1024 × 768 dot or higher and 65,536 colors or more.

Printer and Mouse
Printer and mouse compatible with the OS that you are using. 
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Sound Board
A sound board is required for sounding the alarm on the PC when alarms occur. 

Ethernet Port
An Ethernet compatible  port (10BASE-T or 100BASE-TX (100BASE-TX recommended)). 

1.3  PC System Requirements
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1.4	 Setting Up MXLOGGER

Setup Procedure
Set up the MXLOGGER according to the WX1000 DAQWORX Install & Operation Guide 
(IM WX1000-01E) provided on the DAQWORX Installation CD. 

Installation Result
If the software is properly installed, a folder named MXLOGGER is created in the 
specified directory (by default, C:drive containing the OS\DAQWORX). MXLOGGER is 
registered in the program list, and Logger, Viewer, and Calibrator are registered as in the 
sub list.

		

Note
The Data folder and Work folder are created inside the Logger folder. The record files are 
saved in the Data folder. The Work folder is used to store temporary files by the Logger. Do not 
delete this folder.
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1.5	 Starting and Exiting Software Programs

Procedure
Starting the Software Programs
As shown in the figure below, choose Start > Programs > YOKOGAWA DAQWORX > 
MXLOGGER > Logger, Viewer, or Calibrator. 

		

Note
If you enable the automatic start function, Logger starts automatically upon starting of 
monitoring/recording.  For details, see section 2.3, “Setting the Data Acquisition Conditions.”

Exiting the Software
From the File menu, choose Exit. 
The figure below shows an example for the Logger.

		

Note
When exiting the Viewer, a dialog box used to confirm whether the display settings are to be 
saved opens if the display settings have been changed. 
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2.1	 Searching MX100 Data Acquisition Units and 
Configuring the Network

Procedure
Before carrying out the procedure below, turn ON the power to the relevant MX100s and 
connect the MX100s to the network using Ethernet cables.

Note
•	 Connecting MX100s and the PC to a backbone network before proper IP addresses are 

assigned to the MX100s may adversely affect other connected devices on the network.
•	 If running under Windows XP or Windows Vista, connection problems may occur if 

the firewall function is enabled.  For details, see the MX Standard Software User’s 
Manual (IM MX180-01E). 

Searching for MX100s
When Starting the Logger for the First Time
1.	 Start the Logger according to the procedure given in section 1.5.
	 The System screen of the Main window appears. Icons indicating the MX100s that 

are connected to the same network segment are displayed in the MXs nearby area. 

		

Displays the icon of the MX100 in the same segment

Click here to display detailed
communication settings of
the MX100.

Instrument number (NO.) of the MX100

Note
If multiple MX100s are connected in the same network segment, multiple icons are displayed. 
In this case, the instrument number that is marked on the name plate of the main module is 
displayed on the icon indicating the MX100 (Serial No. on the screen) allowing you to identify 
each MX100. 

Chapter 2	 Logger
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If the Logger Has Been Started Once Before
1.	 Start the Logger.
	 The screen of the Main window that was displaying when you exited the Logger the 

previous time is displayed.
2.	 Click System. 
	 The System screen appears.

		

Click here.

3.	 Click the Search button in the MXs nearby area.
	 Icons indicating the MX100s that are connected to the same network segment are 

displayed in the MXs nearby area.

		

Click here.

Displays the icon of the MX100 in the same segment and the communication settings (only during detailed display)

Setting Up the Network
1.	 Click the Network Config. button in the MXs nearby area of the System screen.
	 The Network Configuration dialog box opens.

		

Click here.Checks the MX100 to be set 
(-CALL- display)

2.1  Searching MX100 Data Acquisition Units and Configuring the Network
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2.	 Select the Edit check boxes of the MX100s whose network configuration you wish to 
change.

	 The Machine Name, Address, Subnet Mask, and Default Gateway items turn into 
text boxes. 

				  

Select this check box.
Check boxes do not appear for MX100s in use when searching (the Info. column indicates Using).

Machine name
(up to 64 characters)

IP address Default settings can be used for local connection.

3.	 Refer to the explanations below, and enter the required information in each text box. 
4.	 Click the Apply button. 
	 A dialog box with the message “Apply the edited network configuration of MXs?” 

appears. 
5.	 Click OK.
	 When the configuration is complete, the Info. column indicates Complete. If 

configuration fails, Fail is displayed.

				  

6.	 Click the Close button of the Network Configuration dialog box.

Explanation
Machine Name
As necessary, you can enter a name that is easy to identify using up to 64 characters.

Serial ID
The instrument number (NO.) marked on the name plate of the main module.

IP Address (Address)
Enter the IP address to assign to the MX100. The default address is 127.1.1.XX (where 
XX is a unique number for the device). This default address cannot be used even when 
the MX100 is connected locally to the PC. You must change to a different address such 
as 192.168.1.XX (where XX is a value between 1 and 254). When making connections 
locally, do not set the PC to obtain the IP address automatically. Enter the IP address 
manually to an address other than the one that is to be assigned to the MX100. 

Note
•	 To connect to the MX100 by entering a host name in the Host box in the Configuration 

area of the System screen, the host name (name used on the TCP/IP network) must be 
registered in a DNS server and the DNS server must be connected to the network. The 
MX100 does not have a function for registering host names to the DNS server. For the 
procedure for registering host names, consult your network administrator.

•	 To initialize all settings including the IP address to the their factory default values, turn OFF 
the power to the main module, turn OFF dipswitch number 5 on the main module, and 
turn ON the power. When the 7-segment LED displays bF, all settings are initialized. After 
confirming the bF display on the 7-segment LED, turn OFF the power to the main module, 
turn dipswitch number 5 back ON, and then turn ON the power to the main module. 

2.1  Searching MX100 Data Acquisition Units and Configuring the Network
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Subnet Mask
Enter the mask value used when determining the subnet network address from the IP 
address. The default value is 255.255.255.0. When connecting to the PC locally, this 
value does not need to be changed. In this case, set the subnet mask on the PC also to 
255.255.255.0.

Note
Consult your network administrator for the subnet mask value. You may not need to set the 
value.

Default Gateway
Set the IP address of the gateway (default gateway) used to communicate with other 
networks. The default value is 0.0.0.0. When connecting to the PC locally, this value 
does not need to be changed. In this case, you do not have to set the default gateway on 
the PC.

Note
Consult your network administrator for the IP address of the default gateway. 

Connected User (User)
Displays the computer name of the PC that is connected to the MX100. This item is  
blank (- - - - -) if there is no PC connected to it.

Software
Displays the name of the software program that is connected to the MX100. This item is 
blank (- - - - -) if there is no software program connected to it.
• MXLOGGER:	 Logger of the MXLOGGER
• MX100 Standard:	 Integration Monitor of the MX100 Standard Software
• MX Calibrator:	 Calibrator of the MXLOGGER or the MX100 Standard Software
• API:	 Software application created using the MX100/DARWIN API 	
	 (product sold separately)

			 

2.1  Searching MX100 Data Acquisition Units and Configuring the Network
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2.2	 Configuring the System

Procedure
To perform the procedure below, you usually have the icons of the MX100s you wish to 
connect shown in the MXs nearby area of the System screen according the instructions 
given in section 2.1, “Searching MX100 Data Acquisition Units and Configuring the Network.”

Selecting the MX100s That Are to Monitor the Data
Drag the MX100 icon displayed in the MXs nearby area onto the Configuration area. A dialog 
box with the message “Invalid modules exist. Do you get configuration after reconstructing?” 
appears. Click Yes. To monitor the data from multiple MX100s, repeat this procedure. 

		

Drag and drop the icon of the MX100 you wish to connect to the Configuration area

The order in which the MX100 icon is dragged and dropped determines the unit number, 
which is the highest two digits of the channel number. The unit number of the first MX100 
that is dragged and dropped is assigned the number 0. The following MX100s are assigned 
numbers 1 to 19 in order. If you wish to change the unit number, click the MX100 you wish 
to change and click the Up or Down button to move the display position up or down.

		
Unit number

To remove the MX100 that was placed in the Configuration area from the system,
click the relevant MX100 and then click here.

To change the unit number of the MX100, click the MX100 you wish to change and then click here.

Note
Instead of dragging and dropping the icons onto the Configuration area, you can also drag and 
drop the icons to the respective measurement groups under Meas Groups. If you do so, all input 
modules of the MX100 are assigned to the measurement group where the icon was dropped.
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Retrieving/Setting Module Configuration Information
If the MX100 is connected to the network and is not being used by another user, the 
module information is automatically retrieved when you drag and drop the MX100 icon. 

		

Module configuration

Slot number (see the MX100 Data Acquisition Unit User's Manual)
Red and blue indicate that a module with a minimum measurement interval of 10 ms and a module
with a minimum interval of 100 ms are installed, respectively.

If the MX100 is being used by another user and you drag the MX100 icon, the module 
configuration is not retrieved. In this case, you select the modules by slots using the 
module selection list box. If the other user releases the connection after you have 
dragged and dropped the MX100 icon, you can click the Get Information button to 
retrieve the module configuration.

If another user drops the connection with this MX100, you can click here to retrieve the module configuration.

If the target MX100 is being used by another user, select the module by slots from here.

Note
For instructions on configuring a system using MX100s that are not connected, see “Configuring 
a System Using MX100s That Are Not Connected” in this section. 

Structure Tab Slots When Selecting the VTD 30-CH Module
One unit of the VTD 30-CH module requires three slots worth of space when installing 
on the base plate. When you select the VTD 30-CH module (MX110-VTD-L30) in the 
structure tab, two slots to the left are occupied by the VTD 30-CH module. If another 
module already exists on the left, a message, “Modules of Slot□ - Slot□ will be changed. 
Ok to continue?” appears. Click OK to change to the VTD 30-CH module. You cannot 
select the VTD 30-CH module if there are not two available slots to the left of the slot 
where the module is installed.

		

Click OK to change

On slot 1 to the left where the module is selected, if you 
select the VTD 30-CH module, a dialog box is displayed.

Slots 2 and 3 cannot be selected

Changes to the VTD 30-CH module

2.2  Configuring the System
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Assigning Input Modules to Measurement Groups 
Auto Assignment 
Click the Auto Assignment button in the Configuration area. A dialog box with the 
message “Assign all modules to appropriate measuring groups?” appears.

		

Click here.

Assigned to an appropriate measurement group*Click OK.

* In this example, modules with a minimum measurement interval of 100 ms are 
assigned to Meas Group 1 and those with a minimum measurement interval 

Selecting the Measurement Group in the Configuration Area 
Click the word “Undefined” (or the  icon) of the slot with an input module selected and 
select the measurement group. The monitor interval that is assigned to the measurement 
group can be confirmed on the Acquisition setup screen.

		

Click here.

Note
To improve the PC performance, it is recommended that whenever possible, only a single 
measurement group be assigned to a single unit. 

Selecting the Measurement Group in the Meas Groups Area
Drag the module icon in the Undefined area onto the desired measurement group area.

		

Drag and drop the icon of the input module to a measurement group.

2.2  Configuring the System
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Note
You can select multiple module icons simultaneously to be dragged and dropped by selecting 
the module icons in the Meas Groups area while holding down the Shift or Ctrl key.The Shift 
key is used to select a range of icons. The Ctrl key is used to select icons individually.

Configuring a System Using MX100s That Are Not Connected
Click the Add button in the Configuration area to display a virtual MX100. In this area, 
you can configure the module and select the measurement group using the procedure 
described earlier. This function is useful when configuring MX100s that are not connected 
in advance.

		  Click here.

Virtual MX100
Enter the IP address or 
host name of the MX100 to connect

Setting the A/D Integration Time
From the A/D Integration Time list box in the Configuration area, select AUTO, 50 Hz, 
or 60 Hz.

		

Select the A/D integration time.

Setting the Temperature Unit for TC and RTD
From the Temp. Unit list box, select C or F.

		

Select the temperature unit.

MX100 Response Check
Click the Response button in each MX100 in the Configuration area. If the MX100 
is connected, the 7-segment LED on the main module of the corresponding MX100 
displays —CALL—. 

		

Click here.

2.2  Configuring the System
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CF Card Information
You can check the status, maximum size, and free area of the CF card inserted into 
the MX100. To check this information, click the CF Information button of the unit in the 
Configuration area. 

		
Click here.

Note
If communications fail when downloading the CF information, a dialog box appears with the 
message, “Failed to acquire CF information. Check the host name and instrument status.” 

Setting the Write Mode of the CF Card
If you wish to save new data files by deleting old files when there is no more free space 
on the CF card, select the Use CF Card Cyclically check box in the Configuration area. 
To stop the save operation when there is no more free space, clear the check box.

		
Click here.

Explanation
Unit Number
The unit number is assigned in the displayed order in the Configuration area of the 
System screen from 0 to 19. The unit number is the highest two digits of the five-digit 
channel number. For example, if the unit number is 2, the channel number is 02XXX  
(where XXX is the channel number in the unit).

Measurement Group
The system is capable of monitoring the data using three different measurement 
intervals. Therefore, each input module is assigned to any of the three measurement 
groups. You can set the measurement interval (Mon. Interval on the screen) of each 
measurement group on the Acquisition setup screen (see the next section).

Setting the A/D Integration Time of the Universal Input Modules
Settings are possible under the following conditions. 
•	 When the measurement interval of the 4-CH, High-Speed Universal Input Module is 50 ms
•	 When the measurement interval of the 10-CH, Medium-Speed Universal Input Module 

is 500 ms
•	 When the measurement interval of the 30CH, Medium-Speed DCV/TC/DI Input 

Module is 1s.
•	 When the measurement interval of the 6-CH, Medium-Speed 4 Wire RTD Resistance 

Input Module is 500 ms
•	 When the measurement interval of the 4-CH, Medium-Speed Strain Input Module is 200 ms 

In these cases, you can select from the following. The default setting is AUTO.
•	 AUTO:	 Automatically sets the corresponding A/D integration time for 50 Hz or 60 Hz 

according to the frequency of the power supplied to the main module. 
•	 50 Hz:	 Sets the integration time to 20 ms.
•	 60 Hz:	 Sets the integration time to 16.67 ms.

Setting the Write Mode of the CF Card
If a CF card is inserted and the connection to the MX100 is cut off while the measured/
computed is being recorded, the measured data is saved (backed up) to the CF card. 
If the Use CF Card Cyclically check box is selected and measured data is saved in 
backup mode, the data continues to be saved by deleting the oldest data file when there 
is no more free space on the CF card. If the check box is cleared, the data save operation 
stops when there is no more free space on the CF card. This setting applies to all units.

2.2  Configuring the System
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2.3	 Setting the Data Acquisition Conditions

This is an explanation of data acquisition condition settings, automatic start function 
settings, and settings for measurement and computation channels to be recorded.

Data Acquisition Conditions
Click Acquisition. The Acquisition setup screen is displayed, and the following items can 
be set. 
• Monitor interval assignments to measurement groups and record step (record interval) 
• Record start/stop conditions
• Data file settings

Note
You can set the monitor interval only when monitoring is stopped.

Procedure
Assigning Monitor Intervals to Measurement Groups and Setting the 
Record Step (Record Interval)
1. 	 In the Monitor Interval & Record Step area, select the monitor intervals of Meas 

Group 1, Meas Group 2, and Meas Group 3 from the Mon. Interval list boxes. 
	 The interval cannot be assigned while data monitoring is in progress.

		

Select the acquisition interval for each measurement group
The selectable acquisition interval varies depending on the types of modules assigned to
the same group and the measurement range.

Automatically set to the minimum acquisition interval of the measurement group with modules assigned
or 100 ms, whichever is less (cannot be changed).

2.	 Enter the record step in the Record Step text box.
	 You cannot set the step while recording is in progress. You can confirm the record 

step in the Record Information area.

		

Enter the multiplication factor with respect to the acquisition interval of
the measurement group or math group (record step)

Record interval =
acquisition interval × record step

Setting the Record Start/Stop Conditions
1.	 In the Recording Condition & File area, select On Record, Fixed Time, Interval, or 

Math under Start Condition.
	 If you select Fixed time, enter the start date/time. If you select Interval, enter the 

interval condition.
2.	 Select Continuously, Fixed Period, Fixed Time, Interval, or Math under Stop 

Condition.
	 If you select Fixed Period, enter the record time. If you select Fixed Time, enter the 

stop date/time. If you select Interval, enter the interval condition.
3.	 To reset the computed results at the same time recording is started, select the Math 

Clear on Start check box.
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Immediately start recording with record start operation
Start recording when the specified date/time is reached
Start recording when the specified interval condition is met

Stop recording when the specified time elapses
Stop recording when the specified date/time is reached

*See the explanation in this section, “Measurement and Computation Channels to Be Recorded.” 

Stop recording when the specified interval
condition is met

Stop recording when a certain condition* is
met in the computation

Immediately stop recording with record stop operation

Start recording when a certain condition* is met 
in the computation
Select this check box to reset the computed result at
the same time recording is started

Setting the Data File
1.	 Enter the file save destination in the Directory box in the Recording Condition and 

File area. 
	 Click the Browse button to open the Browse for Folder dialog box in which you can 

select the save destination folder. You can also select the save destination folder, 
click the New Folder button, and enter the folder name to create a new folder within 
the save destination folder and make it the save destination.

2.	 Enter the name of the data file in the File Name box. 
	 To add the record date to the file name, select the Add Date check box. To add the 

record time to the file name, select the Add Time check box. If you select both check 
boxes, the record data and time are added to the file name.

	 If a file with the same name already exists, a hyphen and a four-digit sequence 
number starting with 0000 is added to the end of the file name.

3.	 To divide the file at specified intervals, select Fixed Period or Interval under 
Division. If you select Fixed Period, enter the time. If you select Interval, select or 
enter Monthly, Weekly, Daily, Hourly, date/day, or time.

4.	 To attach a comment to the file, enter the comment text in the Comment box.
5.	 To apply a limit to the number of files per measurement that can be created in 

the folder, select the check box then enter a limit from 4 to 100. When the limit is 
exceeded, old files are deleted.

File save destination

To select the save destination from the Browse for Folder dialog box, click the folder icon.

Browse For Folder dialog box

Click and enter the folder name to create a new folder within the save destination folder

Name of the record file Select the check box when adding the record date/time
information to the specified file name

The time when data is recorded to a new file every specified time interval

File comment (up to 127 characters)

Select the box and enter a number from 4 to 100 to limit the number of files created

The interval when data is recorded to a new file every specified interval

2.3  Setting the Data Acquisition Conditions
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Automatic Start Function
To automatically start monitoring or recording when loading files, perform the following. 

Procedure
1.	 From the File menu, choose Auto Start Configuration. 

				  

2.	 To start monitoring when a file is opened, select the check box in the Auto Start 
Configuration dialog box.

				  

3.	 To start recording when a file is opened, select the “The record is started 
automatically at the time of the file open” check box in the Auto Start Configuration 
dialog box.

				  

2.3  Setting the Data Acquisition Conditions
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Setting the Measurement Channels and Computation Channels to Be Recorded
1.	 Click Channel. The Channel setup screen appears.
2.	 Click the Meas. Channel tab to set measurement channels to be recorded; click the 

Math Channel tab to set the computation channels to be recorded.
3.	 Select the Record check boxes of the channels whose measurement/computation 

data you wish to record. 

		

Click here.

Click the channel of the measured data you wish to record (the same for Math Channel)

Explanation
Measurement Groups and Monitor Intervals
A data measurement (monitor) interval is assigned to each of the three measurement 
groups. The monitor update interval of the data and alarm detection interval follow the 
monitor interval. However, if the specified monitor interval is short, the monitor update 
interval of the data may be slower depending on the PC environment. If Monitor Interval 
is set greater than or equal to 2 min, the Logger acquires data from the MX100 at the 
specified monitor interval, but the measurement interval and alarm detection interval on 
the MX100 are 1 minute.

Note
The shortest interval that you can specify for the monitor interval is the longest measurement 
interval of the shortest measurement intervals of all the input modules assigned to the same 
measurement group. For example, if an input module with the shortest measurement interval of 
10 ms and an input module with 100 ms are assigned, 100 ms is the shortest interval that can 
be specified for the group. 

Record Step of Measurement Channels
The record interval is the interval at which the data of measurement channels is saved 
to a storage medium such as a hard disk. It is set as an integer multiple of the monitor 
interval (up to ×128).

Monitor Interval and Record Step of Computation Channels
The monitor interval of computation channels (computation interval) is the shortest 
monitor interval of the measurement group or 100 ms, whichever is greater. The record 
step set as an integer multiple of the monitor interval (up to ×128).

Record Start Condition
Select the start condition for saving the data of measurement/computation channels from 
the following.
•	 On Record
	 Immediately starts recording when the Start Recording button is clicked or Start 

Recording is chosen from the Acquisition menu.
•	 Fixed Time
	 Starts recording at the specified date/time. Set the date/time as “year/month/day 

hours:minutes:seconds” If the specified time has already been passed, the operation 
is the same as On Record.

•	 Interval
	 Starts recording at the specified time every day or the specified day. Set the time as 

“hours:minutes:seconds” 

2.3  Setting the Data Acquisition Conditions
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•	 Math
	 Starts recording when the StartRec() event function (see section 2.5, “Event 

Functions” is executed on a computation channel. This is valid when you click the 
Start Recording button and the word “Waiting” is displayed. 

Record Stop Condition
Select the condition for stopping the recording from the following:
•	 Continuous
	 Immediately stops recording when the Stop Recording button is clicked or Stop 

Recording is chosen from the Acquisition menu.
•	 Fixed Period
	 Stops recording after the specified time elapses after the recording is started. Set the 

time as “hours:minutes:seconds” 
•	 Fixed Time
	 Stops recording at the specified date/time. Set the date/time as “year/month/day 

hours:minutes:seconds” If the specified time has already been passed, the operation 
is the same as Continuously.

•	 Interval
	 Stops recording at the specified time every day or the specified day. Set the time as 

“hours:minutes:seconds” 
•	 Math
	 Stops recording when the StopRec() event function is executed on a computation 

channel. 

Record (Save) Destination and File Name of the Data File
Select the record (save) destination on the hard disk of your PC. The default setting is 
the Data folder in the MXLOGGER folder where the MXLOGGER is installed.

Note
Do not set the save destination to a storage medium other than the hard disk or to a network 
drive. Doing so may cause problems in terms of performance.

The default file name is “data” If the multiple files are created, it is “data-XXXX” (where 
XXXX is a four-digit sequence number starting with 0000). The extension is .mxd. You 
can also add the file creation date and time to the file name as follows. 
•	 When both the date and time are added:	data-0314-1316 (recording started at 13 

hours 16 minutes on March 14)
•	 When only the date is added:	data-20030314 (recording started on March 14, 2003)
•	 When only the time is added:	data-1316 (recording started on 13 hours 16 minutes)
If a file with the same name already exists, a hyphen and a four-digit sequence number 
starting with 0000 are added to the end of the file name.

Setting the Data File Divisions
The file can be divided every specified time interval. Set the time as “hours:minutes:
seconds” 
Even if file division is not specified, the file is automatically divided when the size of a 
single file exceeds approximately 1 GB or when the number of data points of any of the 
channels in the file exceeds 2 million.

Number of Characters That Can Be Entered for the Comment of the Data 
File
The number of characters that can be entered is up to 127 characters.

2.3  Setting the Data Acquisition Conditions
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2.4	 Setting the Measurement Conditions  
(Measurement Channel Settings)

Procedure
1.	 Click Channel. The Channel setup screen appears.
2.	 Click the Meas Ch tab.

Setting the Input Mode
3.	 Select the input mode from the Mode list box.

Setting the Measuring Range
4.	 Select the measurement range from the Range list box.

Setting the Span 
5.	 Click the Min box or Max box under Span and enter the minimum or the maximum 

value of the span.

Setting the Scale (Only When Scaling)
6.	 Select the Use check box under Scale.
7.	 Select the decimal point position from the Point list box under Scale.
8.	 Click the Min box or Max box under Scale and enter the minimum or the maximum 

value of the scale.
9.	 Click the Unit box and enter the unit of the scaled value.

Setting the Reference Channel for Difference Input (Valid Only When Measuring 
the Difference with Respect to the Measured Value of the Reference Channel)

10.	 Select the Use check box under Difference Input.
11.	 Select the reference channel for the difference input from the Ref. Ch. list box under 

Delta. 

Select the measurement range
When changed, Span and the items to the right of it are initialized (excluding Tag No. and Tag Comment)

Maximum/Minimum values of the scale*

Select the check boxes here to perform scaling*
Decimal point position of the scale*

Minimum/Maximum value of span

Select the input type
When changed, the Range and the items to the right of it are initialized (excluding Tag No. and Tag Comment)

* Cannot be used when Mode is set to RRJC

Check here to select 
the monitor channel Select the reference channel for

difference input*

Check here to measure the difference input
(difference with respect to the measured value
of the reference channel)*
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Setting the Remote RJC Reference Channel (Valid Only When the Input Mode Is 
Set to RRJC (TC))

12.	 Select the reference channel for the remote RJC from the Ref. Ch. list box under 
RRJC.

Note
If the reference channel setting for difference input or the reference channel setting for the 
remote RJC is inappropriate when  switching from the Channel screen to the Display or Monitor 
screen, a Channel dialog box opens (see the figure below). To disable the measurement 
channels with inappropriate settings (clear the Monitor check box on the Channel screen) and 
move to the Display or Monitor screen, click Yes. To change the settings of the inappropriate 
measurement channels without moving to the next screen, click No.

				  

Setting the Unit, Tag Number, and Tag Comment 
13.	 Click the Unit, Tag No., and Tag Comment text box and enter the unit, tag number, 

and tag comment, respectively.

Setting the Time Constant of the First-Order Lag Filter (Valid Only When the 
Input Mode Is Set to Something Other than DI) 

14.	 Select the time constant from the Filter list box.

Setting the Burnout (Valid Only When the Input Mode Is Set to TC)
15.	 Select the direction in which the measured value is set off the range (+OVER or –

OVER) when a burnout occurs from the Burnout list box.

Setting the RJC (When the Input Mode Is Set to TC)
16.	 Click the Type box under RJC and select Internal or External. 
17.	 If you select External, click the Volt box under RJC and enter the compensation 

voltage.

Enter the tag comment
(up to 30 characters)

Enter the unit (up to six characters, only
when the Use check box of Scale is selected)

Enter the tag No.
(up to 15 characters)

Select the reference channel for the remote RJC
(valid only when the input mode is set to RRJC (TC))

Set the RJC
(valid only when the input
mode is set to TC)

Set the burnout
(valid only when the input mode
is set to TC)

Set the time constant of the first-order
lag filter
(when the input mode is other than DI)

2.4  Setting the Measurement Conditions (Measurement Channel Settings)
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Setting the Initial Balancing for Strain Input Channels (Only When the Input 
Mode Is Set to STR) 

18.	 Click the Initial Balance button under Strain, or the Execute button under Reset. 
	 The Executing Initial balancing dialog box appears, and Executing is displayed in 

the Status box. When Execution is complete, the result is displayed in the Status 
box.

				  

Set the initial balance for strain input channels (only when the input mode is set to STR)

Note
•	 You can execute initial balancing and reset the initial balance value on multiple recording 

channels at once by selecting the channels and clicking the Execute All button. 

						    

Collective execution ON/OFF buttonChannel on which to perform initial 
balancing to select them
Selected channels are displayed with red 
characters against a gray background

•	 To execute initial balancing on a strain input module, you must enter channel settings and 
send them. Therefore, if invalid channel settings are entered, a dialog box will appear 
prompting you to correct the settings.

						    

2.4  Setting the Measurement Conditions (Measurement Channel Settings)
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Importing Tag Numbers and Tag Comments
You can import just the tag numbers and tag comments from the saved setup data and 
replace the current tag numbers and tag comments with the imported information.
From the File menu, choose Import Tag. Then, select an MXLOGGER project file (a file 
with the .mxe extension) in the Open dialog box.
Only the tag numbers and tag comments are imported.

		

Select the MXLOGGER project file
(file with .mxe extension) you wish to load

Note
When you carry out the procedure above, the tag numbers and tag comments of computation 
channels are also imported.

When Setting the Measurement Conditions for Each Channel Individually
Click a desired channel number and enter the settings in the area on the right to set the 
measurement conditions. 

Measurement channel to be configured

Click here to show or hide the Meas Ch. area

Click the channel number to be configured

To move to the next channel
To move to the previous channelClicking the slot number here displays the channel settings in the

corresponding module in red

2.4  Setting the Measurement Conditions (Measurement Channel Settings)
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Explanation
Input Mode and Measurement Range
The measurement channel settings differ depending on the combination of the 
MXLOGGER software version and the MX100 hardware style number. The table below 
shows the relationship between MXLOGGER measurement channel settings (by 
software version) and the MX100 hardware style. 

MXLOGGER MX100 Hardware 
Style Number*2

Notes

Software version*1 Connectable module types 
or setting items

S3 S2 S1

R2.05 or later 30ch module  
MX110-VTD-L30

Yes No No

GOST range Yes No No Can be set only for MX110-UNV-M10, 
MX110-UNV-H04, MX110-V4R-M06, and 
MX110-VTD-L30

Yes: Setting and operation allowed	 No: Setting possible, but not operation 
*1	 To check the version, see section 2.16, “Displaying the Software Version and Other 

Information.” 
*2	 The style number is printed on the MX100 main module name plate.

On the channels of the universal input module, select from the modes below according 
to the input signal. For details of the measurable range, measurement accuracy, and 
resolution, see chapter 4, “Specifications” in the MX100 Data Acquisition Unit User’s 
Manual (in the manual CD-ROM)
•	 VOLT (DC voltage)
	 Select the measurement range from 20 mV, 60 mV, 200 mV, 2 V (default), 6 V, 20 V, 

100 V, 60 mV (HQ), 1 V (HQ), and 6 V (HQ). HQ denotes high resolution.

Note
Current input is possible by attaching a shunt resistor to the input terminal and converting to voltage 
input. The shunt resistors in the table below are available for purchase separately. For example, a 
250 Ω shunt resistor is used to convert the signal in the range of 1 to 5 V for 4 to 20 mA input.
Part Name Model Resistance
Shunt resistor 415920 250 W ± 0.1%
(for clamp terminal) 415921 100 Ω ± 0.1%

415922 10 Ω ± 0.1%
Shunt resistor 438920 250 Ω ± 0.1%
(for screw terminal) 438921 100 Ω ± 0.1%

438922 10 Ω ± 0.1%

•	 TC (Thermocouple)
	 Select the thermocouple type (referred to as Range in the setup) from Type-R (default), Type-S, 

Type-B, Type-K, Type-E, Type-J, Type-T, Type-N, Type-W, Type-L, Type-U, and KpvsAu7Fe, 
PLATINEL, PR40-20, NiNiMo, WRe3-25, W/WRe26, Type-N(AWG14), and Type-XK.

•	 RTD1 (resistance temperature detector, measurement current: 1 mA) on the 4-CH, 
High-Speed Universal Input Module

	 Select the RTD type (referred to as Range in the setup) from Pt100 (default), JPt100, 
HQ Pt100, HQJPt100, Ni100:SAMA, Ni100:DIN, Ni120, RN Pt100, RN JPt100 and 
Pt100G. HQ and RN denote high resolution and noise resistance, respectively.

2.4  Setting the Measurement Conditions (Measurement Channel Settings)
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•	 RTD2 (resistance temperature detector, measurement current: 2 mA) on the 4-CH, 
High-Speed Universal Input Module

	 Select the RTD type (referred to as Range in the setup) from Pt100 (default), JPt100, 
HQ Pt100, HQ JPt100, Pt50, Cu10:GE, Cu10:L&N, Cu10 :WEED, Cu10:BAILEY, J263B, 
Cu10 a=0.00392, Cu10 a=0.00393, Cu25, Cu53, Cu100, Pt25, HQ Cu10:GE, HQ Cu10:
L&N, HQ C10:WEED, HQ Cu10:BAILEY, RN Pt100, RN JPt100, Cu100G, Cu50G, and 
Cu10G. HQ and RN denote high resolution and noise resistance, respectively.

	 The RTD2 selection is not available on the 10-CH, Medium-Speed Universal Input 
Module or the Six-Channel, Medium-Speed, Four-Wire RTD Resistance Input Module. 

•	 RTD1 (resistance temperature detector, measurement current: 1 mA) on the 10-CH, 
Medium-Speed Universal Input Module/Six-Channel Medium-Speed Four-Wire RTD 
Resistance Input Module

	 Select the RTD type (referred to as Range in the setup) from Pt100 (default), JPt100, 
HQ Pt100, HQ JPt100, Ni100:SAMA, Ni100:DIN, Ni120, Pt50, Cu10:GE, Cu10:L&N, 
Cu10 :WEED, Cu10:BAILEY, J263B, Cu10 a=0.00392, Cu10 a=0.00393, Cu25, 
Cu53, Cu100, Pt25, HQ Cu10:GE, HQ Cu10:L&N, HQ Cu:WEED, HQ Cu10:BAILEY, 
Pt100G, Cu100G, Cu50G, and Cu10G. HQ denotes high resolution.

•	 RTDEx (resistance temperature detector, measurement current: 0.25 mA) on the Six-
Channel, Medium-Speed Four-Wire RTD Resistance Input Module

	 Select the RTD type (referred to as Range in the setup) from Pt500 (default setting) or 
Pt1000.

•	 OHM (resistance) on the Six-Channel, Medium-Speed Four-Wire RTD Resistance 
Input Module

	 Choose 20 ohm (measurement current: 1 mA), 200 ohm (measurement current: 1 
mA), or 2 kohm (measured current: 0.25 mA). 

•	 DI (Digital Input)
	 On the channels of the 10-CH, High-Speed Digital Input Modules, only the DI (digital 

input) setting is available (no input mode selection). With numerical input module 
channels, select LEVEL (D10) (voltage input) for -D05, or CONTACT (D10) (contact 
input) for the measurement range to match the input. -DI24: LEVEL (24 V) only.

	 On the 4-CH, High-Speed Universal Input Module, select LEVEL (voltage input) or 
CONTACT (HS) (contact input) according to the input.

	 On the 10-CH, Medium-Speed Universal Input Module or the Six-Channel Medium-
Speed Four-Wire RTD Resistance Input Module, select LEVEL (voltage input) or 
CONTACT (SC) (contact input) according to the input.

•	 STR (Strain)
	 On the 4-CH Medium-Speed Strain Input Modules, select a measurement range of 

2000 µSTR, 20000 µSTR (default value), or 200000 µSTR.

•	 RRJC(TC) (Remote RJC)
	 In measuring temperature with thermocouples within the same unit, when the item 

to be measured is located at a great distance, you can setup relay terminals near 
the item, measure the temperature of the relay terminal section using thermocouples 
(reference channel), and use the resultant value as the reference junction 
compensation value for the temperature measurement. By connecting a copper wire 
between the relay terminal and input terminal of the input module, and a thermocouple 
between the DUT and relay terminal, you can measure the temperature of the DUT 
without the need for a large amount of expensive thermocouples.

2.4  Setting the Measurement Conditions (Measurement Channel Settings)
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* Use the same type of thermocouples.

Setting the Measurement Span
Set the minimum and maximum values of the range that is actually measured within the 
measurable range.

Setting the Scale 
Set this item when linearly scaling the measured values. Set the scale by entering the 
maximum and minimum values corresponding to the maximum and minimum values of 
the measurement span and selecting the decimal point position of the scaled value (see 
the figure below). The selectable range of the scale is -30000 to 30000. The decimal 
point position can be set to 4 (XXXXX), 3 (XXXXX), 2 (XXXXX), 1 (XXXXX), or 0 (XXXXX).
Also, you can specify units for the scale value.   You can set the units using up to six 
characters.

		

0 3[V]0

100

Span minimum

Scale minimum

Span maximum

Scale maximum

Setting the Reference Channel for Difference Input
Set this item when making the difference between the measured value of the channel 
and the measured value of the reference channel the measured value (referred to as 
difference computation). The reference channel can be set to a channel that is scaled.
Difference computation can be executed even if the measurement range of its own 
channel and that of the reference channel are not the same.
If the decimal point position setting is different between its own channel and the reference 
channel, the decimal point position of the measured value of the reference channel is 
matched to that of its own channel, and the difference is computed.
Example:	 When the measured value of the channel set to difference input is 10.00 and 

the measured value of the reference channel is 100.0
The computed result is 10.00 – 100.0 = –90.00.

Set the reference channel for difference input to a measurement channel that has the 
Monitor check box selected.

Setting the Remote RJC Reference Channel (Valid Only When the Input 
Mode Is Set to RRJC (TC))
This item sets the reference channel when the input mode is set to RRJC (TC).
Set the reference channel for remote RJC to a channel that meets the three conditions 
below.

2.4  Setting the Measurement Conditions (Measurement Channel Settings)
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•	 The reference channel is a measurement channel (channel existing on the 
measurement channel page) with the Monitor check box selected.

•	 The range of the reference channel and that of the corresponding measurement 
channel are the same.

•	 The channel is in the same unit (MX100).

Setting the Time Constant of the First-Order Lag Filter (Valid Only When 
the Input Mode Is Set to Something Other than DI) 
A first-order lag filter is available. Select from the Filter list box, the time constant N (time 
until 63.2% of the output value is reached) for the case when the measurement interval 
(Monitor interval in the settings) is set to 1 s. Time constants when the measurement 
interval is set to a value other than 1 s follow the equation below. 
Time constant = measurement interval × N (where N = 5, 10, 20, 25, 40, 50, or 100)
The table below lists the relationship.
Measurement Interval (s) Selectable Time Constants (s)
0.01 0.05 0.1 0.2 0.25 0.4 0.5 1
0.05 0.25 0.5 1 1.25 2 2.5 5
0.1 0.5 1 2 2.5 4 5 10
0.2 1 2 4 5 8 10 20
0.5 2.5 5 10 12.5 20 25 50
1 5 10 20 25 40 50 100
2 10 20 40 50 80 100 200
5 25 50 100 125 200 250 500
10 50 100 200 250 400 500 1000
20 100 200 400 500 800 1000 2000
30 150 300 600 750 1200 1500 3000
60 300 600 1200 1500 2400 3000 6000

		

Input
63.2% of the output value

Output curve when
the filter is used

Time constant in the table above

Setting the Burnout
When the input mode is set to TC, you can set the burnout detection behavior. (This 
setting is possible when the input mode is set to a mode other than DI, but the setting 
takes effect only when the mode is TC.) If set to Up, the measured value is fixed to 
+OVER when a burnout is detected (condition in which the input signal level exceeds 
the upper limit of the measurement range). If set to Down, the measured value is fixed 
to – OVER (condition in which the input signal level exceeds the lower limit of the 
measurement range). To not detect burnouts, select Off (default).

Setting the RJC
When the input mode is TC, select whether to use the internal reference junction 
compensation function of the input module or an external reference junction 
compensation function. (This setting is possible when the input mode is set to a mode 
other than DI, but the setting takes effect only when the mode is TC.) When using the 
external reference junction compensation function, set an appropriate reference junction 
compensation voltage (Volt in the setup) in the range of –20000 µV to 20000 µV. For 
example, if the reference junction temperature of the external reference compensation is 
T0°C, set the reference compensation junction voltage to the thermoelectromotive force 
of the 0-°C reference of T0°C.

2.4  Setting the Measurement Conditions (Measurement Channel Settings)
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Initial Balancing of Strain Input Channels (Initial Unbalance Adjustment)
When configuring a bridge circuit with a strain gauge, due to the slight deviation in 
resistance of the strain gauge, the bridge circuit will not necessarily be balanced even if 
the strain of the circuit under test is zero, and the measured value may not be zero (the 
value in such cases is called the initial unbalanced value.)
Therefore, when taking measurements you must first balance the bridge and, if the strain 
is zero, obtain a measured value of zero.  This is called initial balancing (setting the initial 
unbalanced value to zero).

		

Measured value

Strain

Initial unbalanced value

Reset

Initial balance

0

With the MX100, initial balancing is performed in the ±10000µ strain range.
Initial balance:	 The value when the command is executed is taken as the initial 

unbalanced value, and the measured value is set to zero.
Reset:	 The value set during initial balancing is reset to zero. The initial 

unbalanced value is used for the measured value as-is.

Note
If the measuring range is changed, the initial balancing is reset. After a range change, you must 
redo initial balancing.

The results of initial balancing are as follows.
Status box display Status
----- Not executed
Successful Initial balancing was executed successfully.
Failed Initial balancing failed.
OVER Initial balancing succeeded, but the output value exceeded the 

upper limit or fell below the lower limit, and the value was rounded 
to the upper or lower limit.  

Executing Executing initial balancing

Note
If initial balancing fails, the 7-segment LED on the MX100 displays “ ” Check the module’s  
installation status, then perform initial balancing again. If the error occurs even after 
recalibrating, servicing is required. Please contact your nearest Yokogawa representative.

Scaling Settings of the Strain Gauge Sensor
When using the scaling settings to measure physical quantities such as load and length 
using a strain gauge type sensor, set the scaling. For instructions on entering scaling 
settings, see chapter 1 of the MX100 Data Acquisition unit User’s Manual, “Functional 
Explanation.” 

2.4  Setting the Measurement Conditions (Measurement Channel Settings)
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2.5	 Setting Computations  
(Setting the Computation Channels)

Procedure
1.	 Click Channel. The Channel setup screen appears.
2.	 Click the Math Ch tab. 

Setting the Expression
3.	 Click the Expression box, and enter the expression.

Setting the Span 
4.	 Select the decimal point position from the Point list box under Span. 
5.	 Click the Min box or Max box under Span and enter the minimum or the maximum 

value of the span. 

Setting the Unit, Tag Number, and Tag Comment 
6.	 Click the Unit, Tag No., and Tag Comment text box and enter the unit, tag number, 

and tag comment, respectively.

Setting the User-Defined Constant 
7.	 Click the Label box under Constant and enter the name to identify the constant. 
8.	 Click the Value box under Constant and enter the value of the constant. 

Enter the equation (up to 127 characters, not case sensitive)
Equations that are appropriate are displayed in black
Equations that are inappropriate are displayed in peach

Select the number of digits after the decimal point for the span (0 to 4) 

Click here.
Enter the minimum and maximum value of span

Enter the label indicating the constant
Appropriate labels are displayed in black
Inappropriate labels are displayed in peach

Enter the constant value

Click the Math Ch. tab

Click here to hide the area of setup items related to timers Click here to hide the area of setup items
related to constants

Scroll to set the units, tag No. 
or tag comment
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Enter the unit of the computed value (up to six characters)

Enter the tag comment (up to 30 characters)
Enter the tag No. (up to 15 characters)

Click here to hide the area of setup items related to timers

To show the area of setup items related to
constants or timers, click here.

Note
Two hundred and forty computation channels are always shown. 

2.5  Setting Computations (Setting the Computation Channels)
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Importing Expressions
From the File menu, choose Import Expression. Then, select an MXLOGGER project 
file (a file with .mxe extension) in the Open dialog box. 
Only the saved expressions are imported. 

		

Select the MXLOGGER project file
(file with .mxe extension) you wish to load

Note
For instructions on saving MXLOGGER project files, see section 2.11, “Saving/Loading and 
Printing Setup Data (Project).” 

Importing User-Defined Constants
From the File menu, choose Import Constant. Then, select an MXLOGGER project file (a 
file with .mxe extension) in the Open dialog box. 
Only the saved user-defined constants are imported.

		

Select the MXLOGGER project file
(file with .mxe extension) you wish to load

Importing Tag Numbers and Tag Comments
You can import just the tag numbers and tag comments from the saved setup data and 
replace the current tag numbers and tag comments with the imported information. From 
the File menu, choose Import Tag. Then, select an MXLOGGER project file (a file with 
.mxe extension) in the Open dialog box. 
Only the tag numbers and tag comments are imported. 

		

Select the MXLOGGER project file
(file with .mxe extension) you wish to load

Note
When you carry out the procedure above, the tag numbers and tag comments of measurement 
channels are also imported.

2.5  Setting Computations (Setting the Computation Channels)
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Setting Timers (Only When Using Timers in the Computations)
7.	 Click Action of a timer and select Edge or Level.
	 When not using the timer, select Off (default).
8.	 Click the Interval box, and enter the interval.
9.	 If Action was set to Edge, click the On-period box and enter the time interval over 

which the timer is to be turned ON. If Action was set to Level, click the On-period or 
Off-period box and enter the time over which the timer is turned ON or OFF.

				    If Action is set to Level, enter the time when the timer is to turn OFF.

If Action is set to Edge or Level, enter the time when the timer is to turn ON.
Set the timer interval

To use a timer in the computation, select Edge or Level
When not using the timer, select Off (default).

When Calculating ±Overrange Values of Measurement Channels as the Maximum 
or Minimum Value of the Measurement Range

10.	 Select the Calculate +Over/–Over as the MAX/MIN value of a range check box.

				  
Check here to calculate +Over and –Over as maximum and minimum values
of the measurement range (see the explanation in this section, “Setting Computations”).

Resetting Computation
From the Action menu, choose Reset Math.

		

When Setting Computations for Each Channel Individually
Click a desired channel number and enter the settings in the area on the right to set the 
computation. 

		

Math channel to be configured

Click here to show or hide the Math Channel area

Click the channel number to be configured

2.5  Setting Computations (Setting the Computation Channels)
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Explanation
Overview of Computation
You can enter computing equations using constants, operators, and functions described 
below. The computed results can be displayed and recorded (saved) as computed data. 
Computation allows you to determine the average/maximum/minimum of a specified 
channel on a specified date/time or output events (start/stop record, reset time, etc.) 
under specified conditions. The number of available computation channels is 240, and 
the number of characters that can be used in the equation is 127. 

Setting the Computation Span 
You can set the span of transmission output for the analog output and PWM output 
modules. 

Constants
The following three types of constants can be used.
•	 User Defined Constants
	 A constant can be assigned to an arbitrary string (name). You can set up to 240 user-

defined constants. Set the Name of the constant using a string (up to 10 characters) 
that is not used by predefined constants or functions. They are not case-sensitive. 
The precision and range of the constant values are the same as the single-precision 
floating point format (32 bits, negative values: -3.4028235E+38 to -1.401298E-45, and 
positive values: 1.401298E-45 to 3.4028235E+38).

•	 Predefined Constants
	 The five strings below are used for predefined constants. They are not case-sensitive.

•	 NaN:	 Represents an invalid value or error value. For a description of the 
computed result when NaN is used in the computation, see “Notes on 
Computation” in this section.

•	 POver:	 Represents +Over (positive overrange). The expression POver > x is 
satisfied for any arbitrary value x.

•	 MOver:	 Represents –OVER (negative overrange). The expression MOver < x is 
satisfied for any arbitrary value x.

•	 Pi:	 Represents the ratio of the circumference (3.14...).
•	 e:	 Represents the base of the natural logarithm (2.718...).

•	 Numerical Constants
	 Numeric values that are written directly in the equation. They are expressed in the 

following form.
	 [digits][.digits][{d|D|e|E}[digits]]
	 Example: 1.0d+1 represents 10.0.

Channel Numbers
Channel numbers can be used to specify the <channel> (measurement or computation 
channels). The channel number is specified using five digits: the unit number is the 
highest two digits and the channel number within the unit is the lowest three digits. 
Measurement channels are specified using 990001 to 99240.

Tag Numbers 
Tag numbers can be used to specify the <channel> (measurement or computation 
channels). The tag numbers are enclosed in double quotation marks as in “TagNo.00001” 
They are case-sensitive.

Note
If the same tag number is specified on multiple channels, the operation is undefined.

Alarm Level
Use 1 to 4 to specify the level of alarms 1 through 4.

2.5  Setting Computations (Setting the Computation Channels)
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Manual, and User Output (DO Channels, AO Channels, and PWM 
Channels)
Specify an integer starting with 1. The arguments for the ManualDO() and ManualAO() 
functions are as follows. 
<ManualDONo.>:	 1-4
<ManualAONo.>:	 1-4

Operators
The operators listed below can be used.
Operator Explanation Example
+ Unary plus operator +ch(00010)
- Unary minus operator -ch(00010)
! Logical NOT operator; 1 when 0, or 0 when not 0. !ch(00010)
+ Addition ch(00010)+ch(00011)
- Subtraction ch(00010)-ch(00011)
* Multiplication ch(00010)*ch(00011)
/ Division ch(00010)/ch(00011)
% Remainder ch(00001)%ch(00002)<=1 ?  

AlarmAck() : 0
< Less than, 1 when the condition is met and 0 

when it is not
ch(00001) > ch(00002) ?  
AlarmAck() : 0

> Greater than, 1 when the condition is met and 0 
when it is not 

ch(00001) < ch(00002) ?  
AlarmAck() : 0

<= Less than or equal to, 1 when the condition is 
met and 0 when it is not

ch(00010)<=1.0 ? StartRec() : 0

>= Greater than or equal to, 1 when the condition 
is met and 0 when it is not

ch(00010)>=1.0 ? StartRec() : 0

== Equal to, 1 when the condition is met and 0 
when it is not

ch(00010)==1.0 ? StartRec() : 0

!= Not equal to, 1 when the condition is met and 0 
when it is not

ch(00010)!=0 ? StartRec() : 0

&& Logical product, also calculated after NOT ch(00001) && ch(00002)==1 ? 
AlarmAck() : 0

|| Logical sum, also calculated when true ch(00001) || ch(00002)==1 ?  
AlarmAck() : 0

^^ Exclusive OR ch(00001) ^^ ch(00002)==1 ?  
AlarmAck() : 0

? : Conditional operators ch(00010)>=1.0 ? StartRec() : 0  
(“if a then b otherwise c” expressed 
as [a?b:c])

, Order operator Condition?(ResetTimer(), 
StartRec()) : 0

The order of precedence of the operators is as follows. ← indicates that the left operator 
has precedence over the right operator.
+ - ! (unary operators) ← + - * / % (arithmetic operators) ← < > <= >= == != (relational 
operators) ← && || ^^ (logical operators) ← ? (conditional operator) ← ,(order operator)

2.5  Setting Computations (Setting the Computation Channels)
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Reference Functions and TLOG Functions
The functions below are used to retrieve measured values and alarm values. The 
functions are not case sensitive. For the format used to specify the <channel>, <alarm 
level>, and <manual> see “Channel Numbers,” ” Alarm Level,” and “Manual” in this 
section.
Function Description Example
ch (<channel>) Returns the current value of the specified 

channel (see page 2-36) 
ch(00001)/ch(“Tag”) 

prech (<channel>) Returns the previous value of the specified  
channel (see page 2-36)

prech(00001)/ 
prech(“Tag”) 

alarm (<channel>,  
<alarm level>)

Returns the alarm value of the specified 
channel and specified alarm level;   
ON=1, OFF=0

alarm(00001,2)/ 
alarm(“Tag” 2)

alarm (<channel>) Returns the alarm value of the specified  
channel, ON=1, OFF=0

alarm(00001)/ 
alarm(“Tag”) 

alarm() Returns the alarm value of an arbitrary  
channel, ON=1, OFF=0

alarm()==1 ? 
StartRec() : 0

tlogmax (<channel>) Returns the maximum value of the TLOG 
computation of the specified channel 

tlogmax(00001)/ 
tlogmax(“Tag”) 

tlogmin (<channel>) Returns the minimum value of the TLOG  
computation of the specified channel

tlogmin(00001)/ 
tlogmin(“Tag”) 

tlogpp (<channel>) Returns the (maximum-minimum) value of the 
TLOG computation of the specified channel 

tlogpp(00001)/ 
tlogpp(“Tag”) 

tlogsum (<channel>) Returns the sum of the TLOG computation  
of the specified channel

tlogsum(00001)/ 
tlogsum(“Tag”) 

tlogave (<channel>) Returns the average value of the TLOG  
computation of the specified channel

tlogave(00001)/ 
tlogave(“Tag”) 

ManualDO (<manual>)  Returns the values being output on the  
specified ManualDO.

ManualDO(1)

ManualAO((<manual>) Returns the values being output on an  
arbitrary channel.

ManualAO(1)

*1	 The TLOG computation computes the maximum, minimum, maximum-minimum, sum, 	
	 and average values of the specified channel.If the TLOG function is present in the equation, 	
	 the computation is executed. 
*2	 The reference function or TLOG function returns NaN in the following cases.
	 •	 When the data to be referenced by the CH function or PRECH function does not exist  
		  (when disconnected or immediately after starting the monitor operation)
	 •	 When the specified channel does not exist or when the specified alarm level is not 1 or 2.
	 •	 When the MX100 returns an INVALID value
*3	 Select the behavior taken when the value of the measurement channel is ±Over from the 	
	 following:	
	 •	 Continue the computation as ±Over (behavior when the check box is not selected)
	 •	 Continue the computation by setting ±Over to the maximum or minimum value of the 	
		  measurement range of the specified channel (see “Notes on Computation” in this section). 
	 The selection is made using the Calculate +Over/-Over as the MAX/MIN value of a range 	
	 check box. 
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Arithmetic Functions
Below are the arithmetic functions that are available. They are not case-sensitive.
Function Description Example
sin (<value>) Returns the sine of the <value> sin(ch(“TagNo.00001” ))
cos (<value>) Returns the cosine of the <value> cos(ch(“TagNo.00001” ))
tan (<tan>) Returns the tangent of the <value> tan(ch(“TagNo.00001” ))
asin (<value>) Inverse sine asin(ch(“TagNo.00001” ))
acos (<value>) Inverse cosine acos(ch(“TagNo.00001” ))
sinh (<value>) Hyperbolic sine sinh(ch(“TagNo.00001” ))
cosh (<value>) Hyperbolic cosine cosh(ch(“TagNo.00001” ))
tanh (<value>) Hyperbolic tangent tanh(ch(“TagNo.00001” ))
pow (<value1>, <value2>)  <value1> to the power of <value 2> pow(ch(00001), 

ch(00002))
sqrt (<value>) Square root sqrt(ch(00001))
logE (<value>) Natural logarithm logE(ch(00001))
log10 (<value>) Common logarithm log10(ch(00001))
expE (<value>) e to the power of <value> expE(ch(00001))
exp10 (<value>) 10 to the power of <value> exp10(ch(00001))
abs (<value>) Absolute value abs(ch(00001))
max (<value>, ..., <value>) Maximum value among multiple 

specified values
max(ch(00001), 
ch(00002),ch(00003))

min (<value>, ..., <value>) Minimum value among multiple 
specified  values

min(ch(00001), 
ch(00002),ch(00003))

pp (<value>, ..., <value>) (Maximum - minimum) among 
multiple specified values

pp(ch(00001),ch(00002), 
ch(00003))

sum (<value>, ..., <value>) Sum of multiple specified values sum(ch(00001), 
ch(00002),ch(00003))

ave (<value>, ..., <value>) Average of multiple specified values ave(ch(00001), 
ch(00002),ch(00003))

poly(<x>,<a0>,<a1>, ..., <an>) Polynomial with variable parameters 
Calculate 0xn+a1xn-1+...+anx0

poly(ch(00001) 
ch(00002),ch(00003)),

ceil (<value>) Returns the minimum integer greater 
than <value>

ceil(ch(00001)) 

floor (<value>) Returns the maximum integer less 
than <value>

floor(ch(00001)) 

limit(<x>,<a>,<b>) If x is outside the range defined by a 
and b,round the value to b.

limit(ch(00001),10,20)

rnd() Returns a random number between 
0 and 1

ch(00001)*rnd()

IsNaN (<value>) Returns 1 if \value is NaN, otherwise 
returns 0.

IsNaN(ch(00001)) 
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Time Functions
The table below shows the functions related to time. The functions are not case sensitive. 
Only integer numeric constants can be written in the function parameters <year>, 
<month>, <day>, <hours>, and <minutes> in the table below. The terminology used in 
the description in the table are defined below.
Edge: 	 Returns 1.0 for computation immediately after the specified absolute or 

relative time.
Previous edge: 	Returns 1.0 for computation immediately before the specified absolute 

or relative time.
Level: 	 Returns 1.0 during the specified absolute time or relative time.

•	 Parameter Setting Ranges
Year: 	 1970-2036
<month>:	 1-12  
<day>:	 1-31
<week day>:	 0 to 6 (0: Sunday, 1: Monday, ..., 6: Saturday)
<hours>:	 0-23
<minutes>:	 0-59

Function Description Example
time(<year>,<month>,<day> <hours>, 
<minutes>)

Edge operation on the date/time time(2003,6,3,9,53) ? StartRec() : 0

bfTime(<year>,<month>,<day>,<hours>, 
<minutes>)

Previous edge operation on the  
date/time

bfTime(2003,6,3,9,3) ? StartRec() : 0

time(<year A>,<month A>,<day A>,<hours A>, 
<minutes A>,<year B>,<month B>,<day B>, 
<hours B>,<minutes B>)

Level operation between date/time  
A and B

time(2003,6,3,8,53,2003,6,3,9,13) ? 
sum(ch(00001),ch(00002), 
ch(00003)) : 0

monthly (<day>,<hours>,<minutes>) Edge operation every month on the 
specified day, hour, and minute.

monthly(3,9,53) ? StartRec() : 0 

bfMonthly (<day>,<hours>,<minutes>) Previous edge operation every month on 
the specified day, hour, and minute.

bfMonthly(3,9,53) ? StartRec() : 0 

monthly (<day A>,<hours A>,<minutes A>,  
<day B>,<hours B>, <minutes B>)

Level operation between the specified 
day, hour, and minute of A to the specified 
day, hour, and minute of B every month.

monthly (3,9,3,4,9,3) ? StartRec() : 0

weekly (<week day>,<hours>,<minutes>) Edge operation every week on the 
specified week day, hour, and minute.  

weekly(3,9,53) ? StartRec() : 0

bfWeekly (<week day>,<hours>,<minutes>) Previous edge operation every week on 
the specified week day, hour, and minute.  

bfWeekly(3,9,53) ? StartRec() : 0

weekly (<week day A>,<hours A>, 
<minutes A>,<weekday B>, 
<hours B>,<minutes B>)

Level operation between the specified 
week day, hour and minute of A to the 
specified week day, hour, and minute of B 
every week. 

weekly(3,10,00,4,11,05) ? 
sum(ch(00001),ch(00002), 
ch(00003)) : 0

daily (<hours>,<minutes>) Edge operation at the specified hour and 
minute every day

daily (10,00) ? StartRec() : 0 

bfDaily (<hours>,<minutes>) Previous edge operation at the specified 
hour and minute every day

dfDaily(10,00) ? StartRec() : 0

daily (<hours A>,<minutes A>,<hours B>,  
<minutes B>)

Level operation between time A and time 
B

daily(10,00,11,05) ? 
sum(ch(00001),ch(00002), 
ch(00003)) : 0

hourly (<minutes>) Edge operation at the specified minute 
every hour

hourly(30) ? StartRec() : 0

bfHourly (<minutes>) Previous edge operation at the specified 
minute every hour and minute every hour

bfHourly(30) ? StartRec() : 0 

hourly (<minutes A>, <minutes B>) Level operation between minute A and 
minute B

hourly (10,20) ? sum(ch(00001), 
ch(00002),ch(00003)) : 0

timer(<timerNo>) Returns the status of the specified timer timer(1)==1.0 ? StartRec() : 0

2.5  Setting Computations (Setting the Computation Channels)
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•	 Timer (<timerNo>)
	 Up to eight timers can be specified. The timer is specified using a number between 1 

and 8.
	 Select the timer operation from the choices below. Select Off to disable the timer.
	 Edge operation:	 Returns 1.0 when performing computation after the ON time elapses 

after the beginning of each interval. Specify the interval for detecting 
the condition and the ON time in ms.

	 Level:	 Returns 1.0 from the time after the ON time elapses until after the 
OFF time elapses. Specify the interval for detecting the condition, 
ON time, and OFF time.

	 The condition detection interval that can be set is from 1000 ms to 232–1 ms. The 
ON/OFF time is specified from the beginning of the interval to the elapsed time. 

	 Timer Level Operation

			 

• When ON < OFF

• When ON > OFF

ON setting
OFF setting

t

Interval
Returns 1.0 Returns 1.0

Interval

ON OFF ON OFF

ON setting
OFF setting

t

Interval

Returns 1.0Returns 1.0 Returns 1.0

Interval

OFF ON OFF ON

Manual AO Function
Below are the pattern outputs that are available with the manual AO function. The 
functions are not case sensitive. Specify <manual> as described in the explanation for 
manual and user output in this section.  The operation does not take place if the relevant 
user output channel is not set to pattern output mode.
Function Description Example
StartPTN() Start pattern output 

Description
ch(00010) >=0 ? StartPTN() : 0   

StopPTN() Stop pattern output 
Description

ch(00010) >=0 ? StopPTN() : 0   

SuspendPTN() Pause pattern output 
Description

ch(00010) >=0 ? SuspendPTN() : 0   

ResumePTN() Resume pattern output 
Description

ch(00010) >=0 ? ResumePTN() : 0   

StartPTN(<manual>) Start pattern output on the 
specified user output channel

ch(00001) ==0 ? StartPTN(1) : 0 

StopPTN(<manual>) Stop pattern output on the 
specified user output channel

ch(00001) ==0 ? StopPTN(1) : 0  

SuspendPTM(<manual>) Pause pattern output on the 
specified user output channel

ManualDO(1)==1 ? SuspendPTN(1)    
: Resume(1)

ResumePTN(<manual>) Resume pattern output on the 
specified user output channel

ManualDO(1)==1 ? SuspendPTN(1) 
: Resume(1)

2.5  Setting Computations (Setting the Computation Channels)
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Event Functions
Function used to carry out a given operation (event). They are not case-sensitive. They 
are mainly used in conjunction with the conditional operator (?).The return values are 
indicated below. The event is actually executed after the computation is complete.
• Execution successful: 1.0
• Execution failed: 0.0
• Invalid parameter: NaN
Function Description Example
AlarmAck() Issue an alarm acknowledge ch(00001)>ch(00002) ? AlarmAck() : 0
ResetMath() Reset the computation ch(00010)>=1.0 ? ResetMath() : 0
ResetTimer() Reset the values of all timers ch(00010)>=1.0 ? ResetTimer() : 0
ResetTimer(<timerNo>) Reset the specified timer ch(00010)>=1.0 ? ResetTimer(1) : 0
ResetTLog() Reset the TLOG computation ch(00010)>=1.0 ? ResetTLog() : 0
StartRec() Start recording 

Valid after carrying out the  
record start procedure. 
Discarded if the recording is  
already started (returns 1.0).

ch(00010)>=1.0 ? StartRec() : 0

SplitRec() Move to the next data file  
Valid after carrying out the  
record start procedure.

ch(00010)>=1.0 ? SplitRec() : 0

StopRec() Stop recording 
Valid after carrying out the  
record start procedure. 
Discarded if the recording is  
already stopped (returns 1.0).

ch(00010) >=0 ? StopRec() : 0

Mark(“mark” Create a mark. The text inside 
the double quotation marks is 
arbitrary.

ch(00010) >=0 ? Mark(“mark” : 0

•	 If the spacing between the execution of StopRec() and StartRec() is short, StartRec() 	
	 may not be executed. When repeating start/stop frequently, consider using the Split 	
	 function.
•	 The computed result at the time record start is executed is not necessarily recorded to 

the file.

2.5  Setting Computations (Setting the Computation Channels)
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Notes on Computation
•	 The equation is not case sensitive. The exception is tag numbers specified on the 

Channel setup screen.
•	 The precision and range of computed values are the same as data in single-precision 

floating point format. 
•	 The sampling interval of the computed channel is 100 ms to 10 min.
•	 Measured values used in computations
	 The measured value with the closest time is used among the measured values 

existing at the time of computation. Resampling of the measured value or interpolation 
are not performed while computation is being executed.
Example 1:

	 If the measured values indicated by  and  exist and computation indicated by  
is performed, the measured value indicated by  on each channel is used. If the 
measured value does not exist such as in Ch 5, NaN is used as the measured value.

			 

Ch 1:
Ch 2:
Ch 3:
Ch 4:
Ch 5:
Math:

: Data at time t

: Newest data
: Oldest data
: NaN

t

: Data near tie t

Measured value used in
the computation of

Example 2:
	 If the disconnection (disconnected after ) is detected, NaN is used as the measured 

value of Ch 3.

			 

Ch 1:
Ch 2:
Ch 3:
Ch 4:
Ch 5:
Math:

: Data at time t

: NaN
: Oldest data
: NaN

t

: Data near tie t

Measured value used in
the computation of

•	 Alarm values used in computations
Basically handled the same as measured values except the behavior differs in the 

following two cases.
•	 When the alarm value does not exist (Ch 5 in example 1 above)
	 Always returns 0 (no alarm).
•	 When the communication is cut off (Ch 3 in example 2 above)
	 Always returns the most-recent value.

•	 Syntax error and execution error
•	 Syntax error
	 Equations containing items that are inappropriate are indicated in peach when the 

equation is being entered. If monitoring is started without correcting the equation, 
they are ignored.

•	 Execution error
	 Execution errors are detected after starting the execution. Below are the two cases. 

NaN is returned as the result in either case.
•	 When the reference destination does not exist when monitoring is started
•	 When the computed result is undefined.

2.5  Setting Computations (Setting the Computation Channels)
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•	 Handling of NaN values
•	 In the case of a TLOG function (tlogmax, tlogmin, tlogpp, tlogsum, and tlogave)
	 If NAN exists in the channel values, it is handled as though the value did not exist.
•	 In the case of the IsNan() function
	 This function can determine whether the value is NaN.
•	 In the case of min, max, sum, ave, and pp functions
	 NaN values are discarded.
•	 In the case of &&, ||, ^^, and ! operators
	 NaN values are considered true.
•	 For all other computations

Computation is performed taking NaN as a value. Thus, NaN is returned as the 
computed result.

	 • The numeric value display on the Monitor screen displays INVALID.
•	 Handling when the value of a measurement channel is ±Over (exceeding the upper 

and lower limits of the measurement range) 
	 If the measured value used in the reference function or TLOG function is ±Over, 

computation continues in one of two ways. Select the handling method using the 
Calculate +Over/-Over as the MAX/MIN value of a range check box.
•	 Continue the computation as ±Over.
•	 Continue the calculation by setting ±Over to the maximum or minimum value of the 

measurement range of the specified channel.
Use the following values as the maximum and minimum value of the measurement 

range.
•	 DC voltage: ±10% of the range
	 However, 0/+63.000 mV for 60-mV (HQ) range and 0/+6.3000 V for 6-V (HQ) 

range.
	 Example:	 6 V range
		  +OVER: +6.6 V
		  –OVER: –6.6 V
•	 Temperature: ±10°C of the rated measurement range
	 However, 0 K and 10 K for KpVsAu7Fe and J263B.
•	 Linear scaling: Maximum and minimum values of the scale corresponding to  

±10% of the measurement span
	 However, ±32000 when the scale value exceeds ±32000.
	 Example 1:	 When the measurement span is set to ±1 V and the scale is set to  

	 ±10000 at 2 V range
		  +OVER: +22000
		  –OVER: –22000
	 Example 2:	 When the measurement span is set to ±1 V and the scale is set to  

	 ±30000 at 2 V range
		  +OVER: +32000
		  –OVER: –32000

	 To suppress ±Over from occurring in the computation, use the limit function.
•	 Alarms for computation using the Alarm() function
	 The alarm corresponding to the current value is used for the alarm of a measurement 

channel.
	 The alarm corresponding to the current value is also used for the alarm of a 

computation channel. However, for computation channels that have not yet computed 
the current value, the alarm corresponding to the previous value is used.

2.5  Setting Computations (Setting the Computation Channels)
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2.6	 Setting Alarms

Procedure
1.	 Click Channel. 
	 The Channel setup screen appears.
2.	 Click the Meas. Ch tab or the Math Ch tab.
3.	 Select the alarm type from the Type list box under Alarm 1 to Alarm 4. 
	 When not using difference input on measurement channels, select OFF, High, or 

Low. When using difference input, select OFF, dHigh, or dLow.
	 On math channels, select OFF, High, Low, rHigh, or rLow.
4.	 Click the Value box, and enter the alarm value.
5.	 Click the Hysteresis box, and enter the alarm hysteresis value.
6.	 If you selected a rate-of-change alarm rHigh or rLow for the alarm type on a 

computation channel, select the interval used to detect the rate-of-change from the 
Interval of rate-of-change alarm list box. 

		
Hysteresis of alarm 1

Alarm value of alarm 1
Alarm 1 type

Set Alarm 2 in a similar fashion

For math channels

Rate-of-change interval when the Type is set to rHigh or rLow

Hysteresis of alarm 1
Alarm value of alarm 1

Alarm 1 type

Hysteresis of alarm 2
Alarm value of alarm 2

Alarm 2 type

Click here.
Click here to set the alarm
per channel

For measurement channels

Click here to set the alarm
per channel

Scroll the screen and set alarms 3 and 4 in the same manner
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Note
When using computation channel alarms, do not disconnect the MX100 and the PC software. 
Computation channel alarms will not occur because the computation function does not work 
when using only the MX100.

Explanation
Alarm Types
There are six types of alarms.
When not using difference input on measurement channels, select OFF, High, or Low. 
When using difference input, select OFF, dHigh, or dLow.
On math channels, select OFF, High, Low, rHigh, or rLow.

•	 Upper Limit Alarm (High)
	 An alarm occurs when the measured/computed value exceeds the alarm value.
•	 Lower Limit Alarm (Low)
	 An alarm occurs when the measured/computed value falls below the alarm value.
•	 Difference Input Upper Limit Alarm (dHigh)
	 An alarm occurs when the difference input (difference between the measured value of 

its own channel and that of the reference channel) exceeds the alarm value.
•	 Difference Input Lower Limit Alarm (dLow)
	 An alarm occurs when the difference input (difference between the measured value of 

its own channel and that of the reference channel) falls below the alarm value.

			 

Alarm value

Alarm reset
Measured value or
computed value

Alarm occurrence

Upper-limit alarm/difference input
upper limit alarm

Lower-limit alarm/difference input
lower limit alarm

Measured value or
computed value

Alarm reset

Alarm value
Alarm occurrence

•	 Rate of Change Upper Limit Alarm (rHigh)
	 An alarm occurs if the amount of change in the computed value in the rising direction 

exceeds the alarm setting value within the rate-of-change detection interval.
•	 Rate of Change Lower Limit Alarm (rLow)
	 An alarm occurs if the amount of change in the computed value in the falling direction 

exceeds the alarm setting value within the rate-of-change detection interval.

		

Change in the
computed value

T

Time

Interval

1

T2

t1 t2

2 1

Amount of change in
the setting T

Time

2

T1

t1 t2

C
om

pu
te

d 
va

lu
e

Change in the
computed value

t  –t
Interval

2 1t  –t

2 1T –T

High limit on rate-of-change alarm Low limit on rate-of-change alarm

C
om

pu
te

d 
va

lu
e

Amount of change in
the setting 1T –T2

The rate-of-change detection interval is equal to measurement interval x measurement 
count. Select the measurement count (1 to 15) using the Interval of rate-of-change alarm 
box.
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The table below shows the relationship between the number of MXLOGGER alarm 
settings (by version) and the MX100 hardware style number.

MXLOGGER MX100 Hardware 
Style Number*2

Notes

Software version*1 Connectable module types 
or setting items

S3 S2 S1

R2.05 or later Alarm level setting (alarm1 
to alarm 4)

Yes No No No: Operation possible with alarm 1 and 
alarm 2

Yes: Setting and operation allowed	 No: Setting possible, but not operation 
*1	 To check the version, see section 2.16, “Displaying the Software Version and Other 

Information.”
*2	 The style number is printed on the MX100 main module name plate.

When acquisition is started, the hardware style numbers, alarm settings, and operating 
statuses of the connected MX100s are displayed in the Unit Status area in the Run 
screen on the Main window.

		

For style S2 or earlier, 
alarm 3 and 4 do not operate even if set

Setting and operation with alarm1 to alarm 4 allowed

MX100 Hardware style number

Alarm Hysteresis
You can set a width (hysteresis) to the values used to activate and release alarms. 
Alarm hysteresis prevents frequent activation and release of alarms when the measured/
computed value is unstable around the alarm value.

		

Alarm value

Alarm resetMeasured value or
computed value

Alarm occurrence

Upper limit alarm Lower limit alarm
Measured value or
computed value Alarm reset

Hysteresis

Alarm value
Alarm occurrence

2.6  Setting Alarms
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2.7	 Digital Output

Procedure
1.	 Click Channel. The Channel setup screen appears.
2.	 Click the DO Ch tab. 
3.	 Select the Use check boxes for the DO channels you wish to output.

Setting the Digital Output of Alarms
4.	 Click the Alarm button under Action.
5.	 Click From or To under Ref. Ch. and then enter the range of reference measurement 

channel numbers or math channel numbers of the alarm output.
6.	 Click the Level 1 button or the Level 2 button or both under Ref. Ch.. 
7.	 Click the Energize box to select the output relay action, energize or de-energize.
8.	 Click the Hold box to select the output relay behavior, hold or non-hold.

		

Alarm reference channel range
Select output or not output
(Select the check box to select output)

Alarm 1 reference

Select the alarm

Alarm 2 reference
Alarm 3 reference

Alarm 4 reference
Select hold/non-hold
of output relay

Select energize/de-energize
of output relay

Setting the Digital Output Other Than Alarms
4.	 Click the option button under Action to select the action used as the digital output 

source.
5.	 If you set Action to Manual, click any of the Manual DO buttons 1 to 4. 
6.	 If you set Action to Manual or Error, click the Energize box to select the output relay 

action, energize or de-energize. 
7.	 If you set Action to Error, click the Hold box to select the output relay behavior, hold 

or non-hold.

	

Select the source action

Select output or not output
(Select the check box to select output) Select hold/non-hold of

output relay

Select energize/de-energize of
output relay

If Action is set to Manual, click any button from 1 to 4.



2-41IM WX103-01E

1

2

3

4

5

Index

Logger

Changing the Manual DO Name and Specified Output
1.	 Click Run. The Run screen opens.

Changing the Name
2.	 While data monitoring is stopped, click the manual DO button name box shown in 

the Manual DO area and enter the name. 

		

Click here.

Click here and enter the name.

Output ON/OFF Operation
The procedure below can be carried out when data is being monitored. 
2.	 Click the manual DO button or choose Manual DO1 to Manual DO4 from the Action 

menu. 
	 The output turns ON, and the word “OFF” on the manual DO button changes to “ON.” 

If “ON” is displayed, the output is turned OFF, and the word “ON” changes to “OFF.” 

				    Click here.

or

Explanation
Alarm Reference Channel Range
The alarm detection of multiple measurement channels and math channels can be 
assigned to a single DO channel. When an alarm occurs on any of the assigned 
channels, alarm output is activated. A range of consecutive channel numbers are 
assigned. The range can span over units.

Note
•	 The alarm detection in the unit and the DO output is processed within the unit. Therefore, the 

DO output continues even when the connection to the PC is cut off. If the alarm reference 
channel range spans over multiple units or if the digital output module is not available in the 
same unit, alarm detection is performed on the PC. In this case, alarm detection stops when 
the connection is cut off. In addition, even when the connection is established, the alarm 
detection interval may slow down.

•	 Alarms other than those on measurement channels do not function when not connected to 
the PC.

Digital Specified Output Other Than Alarm Output
The digital output can be enabled for the following causes.
•	 Manual DO [manual]
	 The relay contact signal of specified DO channels are turned ON/OFF collectively 

when you click the manual DO button shown on the Run screen or when you choose 
Manual DO1 to Manual DO4 from the Action menu.

•	 FAIL Output [Fail]
	 Outputs a relay contact signal when an error occurs in the main module CPU of a unit 

containing a digital output module.
	 When the CPU is normal, the relay is energized and FAIL output is ON. When the 

CPU is abnormal or if a power failure occurs, it is OFF.

2.7  Digital Output
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•	 Error Output [Error]
	 Outputs a relay contact signal when any of the following events occur in the main 

module CPU of a unit containing a digital output module. When the CPU is normal, 
the relay is energized and FAIL output is ON. When the CPU is abnormal or if a power 
failure occurs, it is OFF.
•	 A data output request timeout (60 s) occurs while recording data.
	 (except when the MX100 /DS option functions are enabled)
•	 A module error occurs.

•	 An input module detected at power-on that is able to make measurements is 
removed.

•	 A module breaks down.
•	 An unidentifiable module is attached.

When using the energize setting for contact output, the circuit switches from open 
to short when the output is enabled. When using the de-energize setting, the circuit 
switches from short to open.

Energized/De-energized Operation of Output Relays
You can select whether the output relay is energized or de-energized when an output 
event (such as an alarm) occurs. If de-energized is selected, the output relay behaves in 
the same fashion as when an output event occurs if the power is shut down. The default 
setting is Energized.

		

NOEnergize

De-energize

C NO C NO C

NO C NO CNO C

When power is
shut down

NO: Normally Opened, C: Common

When alarm is
not occurring

When alarm is
occurring

Hold/Non-Hold of Output Relays
Select the behavior of the output relay when an output event is released (recovers to a 
normal condition). The default setting is Non-hold.
•	 Turn OFF the output relay with the release of the output event (non-hold).
•	 Hold the output relay at ON until the Relay ACK button (see below) is clicked. 

			 

Relay ACK button

Output cause
occurrence

• When set to non-hold • When set to hold

Relay output ON

Relay output OFF

Relay ACK

Relay output ON

Relay output OFF

Output cause
occurrence

2.7  Digital Output
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2.8	 Analog/PWM Output Settings

Procedure

Setting Analog Output 
1.	 Click Channel to show the Channel setup screen.
2.	 Click the AO Channel tab.
3.	 Select the Use check boxes for the AO channels you wish to output.
4.	 Specify a channel operation of Transmission Output or User Output 1 through 

User Output 4. If user output is specified, you can enter settings in the monitor 
screen.

	 Of all the AO and PWM channels selected for user output, only one can be specified 
for each channel, for a total of four.

5.	 When Transmission Output is specified, enter the reference channel. The 
Reference Channel cannot be entered if the channel operation is user output.

6.	 Select a range from the Range list box.
7.	 Click the Min box or Max box under Span and enter the minimum or the maximum 

value of the span.

		

Select the source action Select the 
output rangeTransmission output reference channel

Select output or no output

Scroll to set the output action and pattern output

Minimum/Maximum value 
setting for the output span

Click hereClick the AO Channel tab.

8.	 Click the Power ON box under Specified Output and select Hold or Preset Value. 
9.	 Click the Error box under Specified Output and select Hold or Preset Value.
10.	 If you select Preset Value under Specified Output, click Preset Value under 

operation, and enter the voltage or current.
11.	 Click the Default box under Pattern Output and select ON or OFF for the initial 

operation in the loop settings.
12.	 Click the Type box under Pattern Output and select Continuous or Times.
13.	 If you select Times for Type under Pattern Output, click the Count box under 

Pattern Output, and enter the number of loops.
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14.	 Click Edit under Pattern Output to open the Edit Pattern window. 

		

Scroll to select an action or set the reference channel, output range, or span

Set the output value upon startup or error occurrence

Set the default pattern output, 
type, and times

Edit pattern button for pattern output

Select the output action upon startup
Select the output action upon errors

15.	 Edit the output pattern in the Edit Pattern window. For instructions, see “Editing 
Patterns” in this section. 

Setting PWM Output 
1.	 Click Channel to show the Channel setup screen.
2.	 Click the PWM Channel tab.
3.	 Select the Use check boxes for the PWM channels you wish to output.
4.	 Specify a channel operation of Transmit or User Output 1 through User Output 4. 

If user  output is specified, you can enter settings in the monitor screen.	 Of all the 
AO and PWM channels selected for user output, only one can be specified for each 
channel, for a total of four.

5.	 When Transmit is specified, enter the reference channel. The reference channel 
cannot be entered if the channel operation is User Output.

6.	 Click the Min box or Max box under Span and enter the minimum or the maximum 
value of the span.

		

Select the source action Transmission output 
reference channel

Select output or no output

Scroll to set the output action and pattern output

Set the minimum/maximum 
values for the output span

Click hereClick the PWM Channel tab.

2.8  Analog/PWM Output Settings
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7.	 Click the Power ON box under Specified Output and select Hold or Preset Value.
8.	 Click the Error box under Specified Output and select Hold or Preset Value.
9.	 If you select Preset Value under Specified Output, click Preset Value and enter 

the duty.
10.	 Select 1 msec or 10 msec in the Resolution box under Pulse. 
	 Click the Interval (msec) box under Pulse, and enter the pulse interval.
11.	 Click the Default box under Pattern Output and select ON or OFF for the initial 

operation in the loop settings. 
12.	 Click the Type box under Pattern Output and select Continuous or Times. 
13.	 If you select Times for Type under Pattern Output, click the Count box under 

Pattern Output, and enter the number of loops. 
14.	 Click Edit under Pattern Output to open the Edit Pattern window. 

				  

Scroll to select an action or set the reference channel, or span

Set the output value upon startup or error occurrence

Set the default pattern 
output and set the type 
and times.

Edit pattern button for pattern output
Select the resolution of the pulse output

Enter the 
pulse interval

Select the output action upon startup
Select the output action upon errors

15.	 Edit the output pattern in the Pattern Edit window. For instructions, see “Editing 
Pattern Output” in this section. 

Editing Pattern Output
Adding Points
1.	 Click Edit under Pattern Output to open the Edit Pattern window. 
2.	 Click the Add button under Edit Pattern to open the New Point window. (To edit at 

a particular time after the previous point, click the Insert button instead. )
3.	 Enter an elapsed time from the start time (or from the previous point) in the Time box 

in the New Point window. 
4.	 Enter an output value in the setting box in the New Point window. 
5.	 Click OK in the New Point window to create the new point.

Editing Points
1.	 Click the point you wish to edit in the Edit Pattern window. The point changes from 

gray (or orange) to red. 

2.8  Analog/PWM Output Settings
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2.	 Click the Edit button under Edit Pattern to open the Edit Point window (you can 
double-click a point to open the Edit Point window even if it is red.) 

3.	 Perform the same procedure as when editing new points.

Deleting Points
1.	 Click the point you wish to edit in the Edit Pattern window. The point changes from 

gray (or orange) to red.
2.	 Click the Delete button under Edit Pattern to delete a point . 

		

Select to enable. The Add button in the 
bottom right of the window changes to
 the Insert button.

Select the “Elapsed time from point before” check box under 
Edit Pattern to change the display to that of the elapsed time
 from point before.

The point that can be edited appears in red

For voltage output on the analog 
output module, the Y-axis units are V For current output on the analog 

output module, the Y-axis units are I

For PWM output on the 
analog output module, 
the Y-axis units are %

Click to add a new point

Enter the elapsed time

Edit the point displayed in red
Deletes the point displayed in red

Enter the setting value 
The units change to match the module setting

2.8  Analog/PWM Output Settings
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You can edit multiple points at the same time by dragging a selection of editable red 
points.

		

Displays the setting value 
when the point is moved

“Generate Automatically” Function
The following four types of patterns can be created. 
•	 Fixed output
•	 Rectangular waveform output
•	 Trapezoidal waveform output
•	 Pyramidal waveform output
Click the displayed button for any pattern in the upper right of the Edit Pattern window. 
The patterns can be edited after being created.

		  trapezoidal waveform output
pyramidal waveform output

rectangular waveform output
fixed output

Fixed Output
1.	 Click the Fixed Output button. 
2.	 Enter the time interval for the points in the Interval box. 
3.	 Enter an output value in the Set value box.
4.	 Enter the number of points in the Point Num. box. 
5.	 Click the Generate Automatically button to create the pattern.

				  

Input the interval between points

Specify the output value.

Enter the number of pointsClick here

Output setting

Interval

Execute the “Generate Automatically” function

2.8  Analog/PWM Output Settings
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Rectangular Waveform Output
1.	 Click the Rectangular Waveform Output button. 
2.	 Enter the pattern interval in the Interval box. 
3.	 Enter the pattern duty ratio in the DUTY Ratio box. 
4.	 Enter the maximum setting value for pattern output in the Max box. Or, enter the 

minimum setting value for pattern output in the Min box. 
5.	 Enter the number of points in the Point Num. box. 
6.	 Click the Generate Automatically button to create the pattern.

				  

Enter the pattern DUTY ratio*
Enter the pattern interval

Enter the minimum and 
maximum setting value 
for the pattern output 

Enter the number of pointsClick here

Minimum setting

Maximum setting

*DUTY ratio =               x 100 [%]

Interval

d

Interval
d

Execute the “Generate Automatically” function

Trapezoidal Waveform Output
1.	 Click the Trapezoidal Waveform Output button. 
2.	 Enter the time for the pattern’s slope in the Ramp Time box. 
3.	 Enter the time for the pattern’s constant portion in the Soak Time box. 
4.	 Enter the maximum setting value for pattern output in the Max box. Or, enter the 

minimum setting value for pattern output in the Min box. 
5.	 Enter the number of points in the Point Num. box. 
6.	 Click the Generate Automatically button to create the pattern.  
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Enter the ramp time
Enter the soak time

Enter the minimum and 
maximum setting value 
for the pattern output

Enter the number of pointsClick here

Execute the “Generate Automatically” function

Minimum setting

Maximum setting

soak timeramp time

Pyramidal Waveform Output
1.	 Click the Pyramidal Waveform Output button. 
2.	 Enter the time interval for the points in the Interval box. 
3.	 Enter the maximum setting value for pattern output in the Max box. Or, enter the 

minimum setting value for pattern output in the Min box. 
4.	 Enter the number of points in the Point Num. box. 
5.	 Click the Generate Automatically button to create the pattern.  

				  

Input the interval between points

Enter the minimum and 
maximum setting value 
for the pattern output 

Enter the number of pointsClick here
Execute the “Generate Automatically” function

Minimum setting

Maximum setting

Interval

2.8  Analog/PWM Output Settings
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Turning Transmission Output ON and OFF Collectively for Analog Output/PWM Output
1.	 From the Action menu, choose Transmit.
	 Transmission output on active channels on the AO and PWM channel tabs is 

performed collectively (All ON).
2.	 From the Action menu, choose Transmit again.
	 Transmission output on active channels on the AO and PWM channel tabs is 

stopped collectively (All OFF).

Explanation
Setting Output for AO Channels
[Transmit]:	 Computed values resulting from values measured on the MX100 and 

computation results set on the computation channels are converted to 
analog voltages (-10.000 V-10.000 V) or analog current (0.000mA-20.000 
mA) and output.

Note
The output range is -11.000-11.000V or 0.000-22.000 mA, but the span setting range is 
-10.000-10.000V or 0.000-20.000 mA. 

[User Output]:	 Output continuously or a specified number of times an analog voltage or 
analog current values using a previously set pattern.  Also, you can enter 
an arbitrary setting for User (Manual) in the Run screen.  The setting 
ranges are -10.000-10.000 V (voltage), or 0.000-20.000 mA (current).

Setting up Output for PWM Channels
[Transmission Output]:	Outputs a duty pulse waveform corresponding to the measurement 

values from the MX100 and the computation results set on the 
computation channel.

[User Output]:	 Output continuously or a specified number of times a pulse duty ratio 
(0.000 to 100.000%) using a previously set pattern. Also, you can enter 
an arbitrary setting for User (Manual) in the Run screen.

					   

Pulse interval

Output width

DUTY ratio = Output width
Pulse interval X 100 [%]

Setting Patterns
You can edit patterns when not monitoring. Point setting values consist of the elapsed 
time from pattern start and the output value. The elapsed time for the first point is fixed at 
0 seconds. Up to thirty-two points can be defined. Up to two points can occupy a single 
point in time.
Also, you can easily generate four types of patterns using the Generate Automatically 
function.

User Output
You can set up to four user outputs. With pattern output collective operation buttons, you 
can output, stop, or pause all user outputs at once.

		
Collective action buttons (output, stop, pause)

User Output Procedure
• Pattern
1.	 Click the Pattern tab in the User Output space.
2.	 Click the triangle button. The previously set pattern is output.  

2.8  Analog/PWM Output Settings
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Click the Pattern tab. 

Stop output Pause output (the PAUSE display appears)

Click the output pattern button to start pattern output

Select to output continuously or a specified number of times

Output value display

Displayed output pattern

Note
The Repeat check box in the User Output space is selected when the Default box under 
Pattern Output (Loop Setting) in the channel settings is turned ON.  

• Manual
1.	 Click the Pattern tab in the User Output space. 
2.	 To change the output value, turn the rotary switch icon by dragging it to the left or 

right, click a direction key, or type a value directly into the output value display box.  

				  

Click the Manual tab. 

Drag with the cursor to turn the rotary switch icon to the left and right

Turning the rotary switch icon*

You can also turn the rotary switch icon by 
holding down the Ctrl key (or Shift key) 
and turning the mouse wheel.

Click a direction key to change the output value

Output value display (can also be used for direct input)

*

Overview of Output during When Transmit Is Set

		

Measurement start Measurement stop Measurement restartsPower ON

Output
value

Value held

Operation Status of Transmission Output by Communication Status
Operation of analog output, PWM output and other forms of transmission output depend 
on the communication status as follows.  

•	 For transmission output within the same unit, the operation does not depend on the 
communication status.  

•	 For computation or transmission from other units, if communication is broken the 
operation is that specified for Error under Specified Output.  

•	 For user output, if communication is broken the operation is that specified for Error 
under Specified Output.  

2.8  Analog/PWM Output Settings
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2.9	 Event Processing

Event processing means to monitor for the specified type of event, and execute a 
specified process when conditions are met.  The following events are available. 
•	 Alarm Event
•	 Data file Event
•	 Communication Event
•	 Start Record Event
•	 Stop Record Event

Procedure
Choose Event > Setting on the menu bar or click the Event Setting icon. The Event 
Setting window appears. 

		

Event processing settings tab

Location of event log 
(click to display the destination 
folder in a separate window)

Select each event 

Setting Alarm Events 
1.	 Click Alarm. The screen changes to the Alarm Event setting screen.
Entering Conditions
2.	 Click the Condition tab.
3.	 If the check box in the Action space is selected, the event becomes active.
4.	 Enter the target channel for the event in the Channel Range box in the Condition 

Setting space.
5.	 Select the check box for the desired alarm under Ref. Alarm in the Condition 

Setting space.
Setting Processes
6.	 Click the Process tab.
7.	 Select the The File is set with FTP check box in the Event Processing space to 

send user files via FTP.
8.	 Select the Sending E-Mail check box in the Event Processing space and select the 

User File check box under Attach File to send user files as an e-mail attachment.
9.	 In the Sending E-Mail item in the Event Processing space, select the User File and 

Message check boxes under Body to copy the contents of the user file to the body of 
an e-mail message, and send the message.
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Setting Up FTP, E-mail, and User Files
10.	 For FTP settings, click the FTP tab.  For e-mail settings, click the E-mail tab.  For 

user file settings, click the User File tab.  For instructions on settings in each of 
these tabs, see the FTP Settings, E-Mail Setting, or User File Setting items in this 
section. 

				  

Click here.
Click the Condition tab. 

Select to enable

Enter the channels for the event

Select the alarm for reference

				  

Click the Process tab. 

Select to send user files by FTP

Select to attach user files to an e-mail
Select to add message to the body of the e-mail
Select to add user file to the body of the e-mail

Setting Up Data File Events
1.	 Click Data File.  The screen changes to the Data File Event setting screen. 
Entering Conditions
2.	 Click the Condition tab. 
3.	 If the check box in the Action space is selected, the event becomes active. 
Condition Processing
4.	 Click the Process tab. 
5.	 Select the The File is set with FTP check box in the Event Processing space to 

send data files via FTP.  
6.	 Select the Sending E-Mail check box in the Event Processing space and select the 

Data File check box under Attach File to send user files as an e-mail attachment.  
7.	 In the Sending E-Mail item in the Event Processing space, select the User File 

and Message check boxes under Body to copy the contents of the message to the 
body of an e-mail, and send the e-mail.  

2.9  Event Processing
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Setting Up FTP and E-mail
8.	 For FTP settings, click the FTP tab.  For e-mail settings, click the E-mail tab.  For 

instructions on settings, see the FTP Settings or E-Mail Setting items in this section. 

				  

Click the Condition tab. 

Select to enable

Click here.

Click the Process tab. 

Select to send data files by FTP 

Select to attach data files to an e-mail
Select to add message to the body of the e-mail

Setting Communication Events
1.	 Click Comm..  The screen changes to the Communication Event setting screen. 
Entering Conditions
2.	 Click the Condition tab. 
3.	 If the check box in the Action space is selected, the event becomes active. 
4.	 If the Disconnected check box in the Condition Settings space is selected, the 

condition becomes valid when a communications disconnection is detected. 
5.	 If the Reconnected check box in the Condition Settings space is selected, the 

condition becomes valid when a communications reconnection is detected. 
6.	 If the Data Lack check box in the Condition Settings space is selected, the 

condition becomes valid when a communications related data dropout is detected. 
Setting Processes
7.	 Click the Process tab. 
8.	 Select the The File is set with FTP check box in the Event Processing space to 

send unit information files via FTP.  
9.	 In the Sending E-Mail item in the Event Processing space, select the Message 

and Unit Information check boxes under Body to copy the message and unit 
information to the body of an e-mail, and send the e-mail.

2.9  Event Processing
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Setting Up FTP and E-mail
10.	 For FTP settings, click the FTP tab.  For e-mail settings, click the E-mail tab.  For 

instructions on settings, see the FTP Settings or E-Mail Setting items in this section. 

				  

Click the Condition tab. 

Select to perform an action when data 
dropouts are detected

Select to enable

Select to perform an action when 
communication reconnection is detected
Select to perform an action when broken 
communication is detected

Click here.

				  

Click the Process tab. 

Select to send unit information files by FTP 

Select to add unit information to the body of 
the e-mail
Select to add message to the body of the e-mail

Setting Start Record Events
1.	 Click Start Record. The screen changes to the Start Record Event setting screen. 
Entering Conditions
2.	 Click the Condition tab. 
3.	 If the check box in the Action space is selected, the event becomes active. 
Process Settings
6.	 Click the Process tab. 
7.	 Select the The File is set with FTP check box in the Event Processing space to 

send user files via FTP.
8.	 Select the Sending E-Mail check box in the Event Processing space and select the 

User File check box under Attach File to send user files as an e-mail attachment.  
9.	 In the Sending E-Mail item in the Event Processing space, select the User File 

and Message check boxes under Body to copy the contents of the user file to the 
body of an e-mail message, and send the message.  

2.9  Event Processing
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Setting Up FTP, E-mail, and User Files
10.	 For FTP settings, click the FTP tab.  For e-mail settings, click the E-mail tab.
	 For user file settings, click the User File tab.  For instructions on settings in each of 

these tabs, see the FTP Settings, E-Mail Setting, or User File Setting items in this 
section.

				  

Click here.Click the Condition tab. 

Select to enable

				  

Click the Process tab. 

Select to send user files by FTP

Select to attach user files to an e-mail
Select to add message to the body of the e-mail
Select to add user file to the body of the e-mail

Setting Stop Record Events
1.	 Click Stop Record . The screen changes to the Stop Record Event setting screen. 
Entering Conditions
2.	 Click the Condition tab. 
3.	 If the check box in the Action space is selected, the event becomes active. 
Setting Processes
4.	 Click the Process tab. 
5.	 Select the Synchronize Data File check box in the Event Processing space to 

execute synchronization.  When doing so, the File conversion check box becomes 
available for selection. 

6.	 Select the Excel, Lotus, or ASCII check box in the File Processing space to 
convert synchronized data to the corresponding format.  When doing so, the Select 
Range and Folder boxes becomes available for selection. 

7.	 Select the Select Range box under File Conversion to specify a range of 
synchronized data for conversion.  

8.	 Enter a folder name for saving the file in the Folder box. Select the Folder check 
box to save converted files to the specified folder.  

2.9  Event Processing
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9.	 Select the Synchronized File or Converted File check box under The File is sent 
with FTP in the Event Processing space to send synchronized or converted files 
via FTP.

10.	 Select the Synchronized File or Converted File check box under the Sending 
E-Mail item in the Event Processing space to send synchronized or converted files 
as e-mail attachments.  

11.	 In the Sending E-Mail item in the Event Processing space, select the User File and 
Message check boxes under Body to copy the contents of the message to the body 
of an e-mail, and send the e-mail.  

Setting Up FTP and E-mail
12.	 For FTP settings, click the FTP tab.  For e-mail settings, click the E-mail tab.  For 

instructions on settings, see the FTP Settings or E-Mail Setting items in this section. 

				  

Click here.Click the Condition tab. 

Select to enable

				  

Click the Process tab. 

Select to specify a storage folder
Enter a name for the storage folder

Select to enable

Select the desired format

Select to add message to the body of the e-mail

Select to send converted files by FTP 
Select to send synchronized files by FTP 

Select to attach converted files to an e-mail

Select to attach synchronized files to an e-mail

Select a range to convert
The input box shows the selected range

When specifying channels for the conversion 
range, the channel number input box appears. 

When specifying groups for the conversion 
range, the group number input box appears. 

2.9  Event Processing
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Configuring FTP
1.	 Click the FTP tab for an event.
2.	 Enter the name of the FTP server in the Server Name box.  
3.	 Enter the port used for connection in the Port No. box.  
4.	 Enter a login name in the Login Name box.  
5.	 Enter a password to be used during login in the Password box.  
6.	 Enter a directory name for transferring files in the Directory box.  

				  

Click the FTP tab. 

Enter these items

Enter the directory where the file is to be sent

Apply the copied settings
Copy the specified settings

Configuring E-Mail
1.	 Click the E-Mail tab for an event.  
2.	 Enter the name of the SMTP server in the Server Name box in the SMTP Server 

space.  
3.	 Enter the port used for connection in the Port No. box in the SMTP Server space.   
4.	 Enter the subject of the e-mail in the Subject box in the E-Mail Setting space.  
5.	 Enter the sender of the e-mail in the From: box in the E-Mail Setting space.  
6.	 Enter the recipient of the e-mail in the To: box in the E-Mail Setting space.  
7.	 Enter recipients of copies of the e-mail in the Cc: box in the E-Mail Setting space.  
8.	 Enter the message of the e-mail in the Message box in the E-Mail Setting space.  

				  

Click the E-Mail tab. 

Enter the items

Enter the name of the SMTP server

Enter the port number

Copy the specified settings
Apply the copied settings

User File Settings
1.	 Click the User File tab for an event. 
2.	 Select the Alarm Information check box to include alarm information in the user file 

output data.  
3.	 Select the Instantaneous Value check box to include instantaneous values in the 

user file output data.  
4.	 Enter channel numbers in the box to specify a range of output data channels. 

2.9  Event Processing



2-59IM WX103-01E

1

2

3

4

5

Index

Logger

5.	 Select the output data format. 

				  

Select to add alarm information to the user file

Select to add instantaneous values to the user 
file
Enter the range of data channels to add to 
the user file
Enter the format of the data to add to t he user 
file

Copy the specified contents

Apply the copied contents

Click here.

Enabling/Disabling Events
Enabling and disabling of each event can be performed using menus in addition to using 
the Event Setting window.  
Choose Event > Alarm Event (or other events). Select the check box next to an event 
item to enable it.  

Description
Data File Events
If the data file creation interval is extremely short, event processing may not be able to 
be carried out.  

Setting Up FTP and E-mail
This is available for all events.  Also, you can set FTP and E-Mail for each event.  To 
copy selected contents from one event to another, click the Copy button in the lower right 
of the setting screen. Then, click the Paste button in the FTP or E-Mail setting screen of 
the event to which you wish to copy the contents.  
Please consult with your network administrator regarding the FTP and SMTP server 
names. 

Note
•	 When sending e-mail, an extremely large number of e-mails can be generated.  
•	 When attaching files to e-mail, the file sizes can be extremely large.  

Executing Event Processing
An icon is displayed in the status bar when events occur and resulting processes are 
carried out only icons of events processes executed are displayed)

		
Start Record Event
Communication Event 
Data file Event
Alarm Event

Stop Record Event 

Logging of Events
The processing of each event is saved to the created LOG folder.  The location of the 
LOG folder is shown in the lower left of the Event Setting window.  
The log file contains one week’s worth of data.  

2.9  Event Processing
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2.10	 Starting/Stopping Data Monitoring and  
Displaying the Monitor

Procedure

Start Data Monitoring
Click the Start Mon. button, or choose Start Monitoring from the Acquisition menu. 

		
or

Click either one.

When you click the Start Mon. button, the Start Mon. button changes to the Stop Mon. 
button, and the Run screen appears. If communication is possible, connections to the 
MX100s selected on the System screen are established, and data monitoring starts. The 
Comm. column in the Unit Status area shows Connect. If the IP address is not correct 
or if another use is using the MX100, the Comm. column in the Unit Status area shows 
Disconnect.

		

Start Recording button changes to Stop Recording button

Connect: When data monitoring is in progress.
Disconnect: When the power to the target MX100 is OFF.

When the target MX100 is not connected to the network,
When another use is using the target MX100, or
When the IP address is not correct

For a description of other contents displayed on this screen, 
see the explanation in this section. 

Note
If you enable the automatic start function, monitoring or recording starts automatically upon 
starting of MXLOGGER.  For details, see section 2.3, “Setting the Data Acquisition Conditions.” 

Stop Data Monitoring
Click the Stop Mon. button, or choose Stop Monitoring from the Acquisition menu. 
Connections to all MX100s on which data monitoring is in progress are dropped, and 
data monitoring stops.
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When recording is stopped, the display changes to Start Recording

or

Click either one.

Displaying the Trend Monitor Window and Changing Display Settings
1.	 Click the Trend Monitor button on the toolbar or choose Trend Monitor from the 

Window menu.

				  
Click here

or

2.	 To change display settings, follow the instructions in the figure below.
	 If the channels of different measurement groups or channels of math groups are 

assigned to the same display group, a monitor is displayed for each measurement group 
or math group (see the figure below). (In other words, multiple monitors are displayed.) 
A single Trend Monitor window can display up to four waveform display areas.

	 When setting multiple units, if channels of different units assigned to the same 
measurement group are assigned to the same trend monitor display group, the trend 
is displayed in a separate window.

				  

Switch between channel number, tag No., and tag comment
Common to the Trend Monitor, Numeric Monitor, Meter Monitor, and Alarm Monitor

Switch the display group

Y-axis

Waveform display ON/OFF

Grid density

Switch the grid density

Channel number, tag No., tag 
comment, and measurement unit

Background color density

Zoom in or out of the time axis
Switch the display zone

Switch the Y-axis

Switch the thickness of the displayed waveform

Turn ON/OFF the waveform 
display limit (clip)

Alarm display area

Displays a red bar on the group with an alarm occurring

Time axis magnification

Monitor interval

Displaying the Numeric Monitor Window
Click the Numeric Monitor button on the toolbar or choose Numeric Monitor from the 
Window menu.

		
Click here.

or

2.10  Starting/Stopping Data Monitoring and Displaying the Monitor
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A Numeric Monitor window opens as shown below.

		

Level with respect to the scale width

Numeric display Unit Channel color

Channel number

+OVER: When the measured value exceeds the upper limit of the measurement range or scale display range
–OVER: When the measured value exceeds lower limit the measurement range or scale display range
INVALID: After the power is turned ON until the data monitoring is established or when invalid computation
 is found in the difference computation or remote RJC computation (see pages 2-18 and 2-19)
ILLEGAL: When a module is removed, when a module is broken, or when the MX100 module configuration
 and the module configuration detected on the PC do not match

Alarm indication

Displaying the Meter Monitor Window
Click the Meter Monitor button on the toolbar or choose Meter Monitor from the Window 
menu. 

		
Click here

or

A Meter Monitor window opens as shown below. 

		

Numeric display Unit

Channel color
Channel numberAlarm indication

Displays a red bar on the group with
an alarm occurring

ThermometerBar meter Analog meter

2.10  Starting/Stopping Data Monitoring and Displaying the Monitor
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Displaying the All Channel Monitor Window
Click the All Channel Monitor button on the toolbar or choose All Channel Monitor from 
the Window menu. 

		
Click here.

or

The All Channel Monitor opens as shown below. 

		

Zoom in or out of the time axis

Turn ON/OFF the waveform display limit Monitor Interval

Change the grid density

Change the background darkness

Switch the grid density

Switch the thickness of the waveform

Note
Since data from all channels are displayed, the screen may update more slowly. The All 
Channel Monitor dialog box will be displayed to warn you of this.  To compensate, you can 
increase the display magnification or decrease the size of the window.  

2.10  Starting/Stopping Data Monitoring and Displaying the Monitor
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Displaying the Alarm Monitor Window
Click the Alarm Monitor button on the toolbar or choose Alarm Monitor from the Window 
menu. 

		
Click here.

or

An Alarm Monitor window opens as shown below.
Click the Group tab to display alarms by display groups; click the Channel tab to display 
alarms by channels.

		

To display alarms per group, click Group.

Group name

Alarms per channel

To display alarms per channel, click Channel

Changes to red when an alarm occurs.

If unacknowledged alarms exist, a blinking
yellow ring appears around the signal lamp.
Click alarm indication area or choose Display-Alarm
ACK from the Action menu to acknowledge the alarm.
The ring disappears. 
You can also click the      icon that is displayed in
the status display bar at the bottom section of the
Main window to acknowledge alarms.

Status display bar at the bottom section of the Main window Click here to acknowledge the displayed alarms.

Note
•	 If you choose Cascade or Tile from the Window menu when multiple windows are displayed, 

the windows are displayed cascaded or tiled. 
	 If you choose Arrange Icons from the Window menu when multiple windows are minimized, 

the icons are rearranged at the bottom of the screen.
•	 If you click the Link ( ) button on the toolbar to enable the link, you can change the display 

group of other windows from a single window. 
•	 The maximum number of Monitor Windows that can be displayed for a single project is 20. 

For Alarm Monitor windows, only up to two windows can be displayed.
•	 If you choose Alarm Sound from the Action menu, an alarm can be sounded on the PC 

when an alarm occurs. 

2.10  Starting/Stopping Data Monitoring and Displaying the Monitor
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Changing Display Settings on the General Display Settings Window
1.	 While data monitoring is in progress, click the General Display Settings button on the 

toolbar or choose General Display Settings from the View menu.

				  
Click here.

or

2.	 Change the display settings according to the explanation in the figure below. 
	 Display settings are entered for each display group. You can set up to 50 display 

groups.

				  

Select the display format of the Y-axis (normal/exponential)

Switch the display group

Show the channel
selection dialog box

Group name

Display ON/OFF

Select the Y-axis type (linear/logarithmic)
Y-axis when using
multi-axes zone

Maximum/Minimum
value of the scale

Display zone
position

Turn ON/OFF the trip
point display

Trip point

Number of channels
assigned automatically

Channel color

Execute automatic channel
assignment

Selecting the
meter type

Initializing, Copying, and Pasting of Settings on the General Display 
Settings Window 
On the General Display Settings window, you can reset the settings to default or copy 
and pate the settings of one or multiple waveforms to the settings of other waveforms. 
You can copy and paste according to the procedure below.
Click the copy source waveform number (No. column), click the Copy button at the 
bottom of the window, click the copy destination waveform number, and click the Paste 
button at the bottom of the window.

		

Click this icon to turn ON/OFF the channels collectively

To copy/paste
the item, click
to show the flag

To not copy/paste
the item, click to
hide the flag

Click this icon to reset to default settings

Click this icon to automatically assign the channels
Click this icon to enter the same settings as the first channel in the selected range

Click to select all Drag to select a range of waveforms

To select a meter collectively, click the respective icon

2.10  Starting/Stopping Data Monitoring and Displaying the Monitor
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Explanation
Run Display
See the explanation in section 2.11, “Pausing/Resuming the Updating of the Monitor Display 
and Reading Measured Values Using Cursors” for further information on “Record Information.” 
•	 Main Status

Displays the main operating status of the MXLOGGER. 

			 

Communication error : Connected,          : Disconnected

Current time
Displays the data rate using a bar
Move the cursor here to display
the data rate in bytes/second

Monitor/Record status  : Stopped,         : Monitoring (green),        : Recording (red)

Write error
       : No,          : Yes

Data dropout : No,          : Yes

•	 Disk Information

			 
Used disk space

Displays the amount of used disk space using a bar
Move the cursor here to display the remaining space
as a percentage

Free disk space

•	 Unit Status
Displays the status of each unit. 

			 
     (yellow): Broken module
     (red): Module different from

the configuration
!    (yellow): Calibration error module

Data dropout : No,          : Yes
Monitor/Record status : Stopped,         : Monitoring (green),        : Recording (red)

Status and 
Capacity of the CF card

Communication error  : Connected,          : Disconnected

: Inserted, : Not inserted, : Inserted but not available
: Free space *.* MB
: Used space (orange)

•	 Status display bar at the bottom section of the Main window

		

Current
time/record time

Monitor/Record status
: Stopped

        : Monitoring
        : Recording

Show the Monitor Server window
Displayed only when the monitor server 
is running (See 2.14, “Setting Up the 
Monitor Server”) 

Show the DDE server window
Displayed only when the DDE server is 
running (See 2.15, “Setting Up the DDE Server”)

Display-Alarm ACK button
Displayed only when an alarm is occurring (see page 2-64)
Click here to acknowledge alarms

Icon indicating the writing is in progress
Displays the icon and the number of remaining data files to be written

Error indication while writing
To acknowledge, click the respective button
         : Write error ACK button
         : Data dropout ACK button

Communication status
 : Connected,          : Disconnected

Display when events are executing
Displayed only when events are being 
executed (see 2.9, “Event Processing”)

Note
If there are data files that have not been finalized (data writing have not been completed) in the 
previous connection, the finalization of the data file is carried out immediately when the Logger 
is started. If this happens, the remaining number of data files that have not been finalized is 
shown to the left of the icon indicating that the writing is in progress on the status display bar 
at the bottom section of the Main window. The remaining number indicates the progress of 
finalization. If the remaining number is zero, it is not displayed. 

2.10  Starting/Stopping Data Monitoring and Displaying the Monitor
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Simplified Display of the Run Screen 
If you carry out the procedure described in the figure below when the Run screen is 
displayed, the Run screen is reduced to a simplified display. 
This is useful such as when displaying the Run screen next to Trend Monitor windows.

		

Click here.

Simplifies the Run display
When manual DO settings exist,
the Manual DO area is also
displayed.

Click here.

Display Groups and Group Names
Trend, Numeric, Meter, and Alarm Monitor windows show channels using groups. The 
measured/computed values can be divided into up to 50 groups. Up to 32 channels can 
be registered to a single group. The channels that can be registered are those that have 
the Monitor check box selected on the Channel setup screen. When you click a channel 
selection button on the General Display Settings window, the numbers of the channels 
that can be registered are displayed (see the figure below).

		

To turn ON/OFF the trend waveform display on the Trend Monitor window, click the 
lightblue button below the scale bar as shown in the figure below. 

		

Hide the waveform

You can enter a group name using up to thirty characters. By default, group names 
Group 01 to Group 50 are assigned. The names of the display groups that have channels 
registered are displayed on each monitor window.

		

2.10  Starting/Stopping Data Monitoring and Displaying the Monitor
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Y-Axis Type
You can select linear or logarithmic scale for the Y-axis when displaying the waveforms.

		

Linear Logarithmic

Maximum and Minimum Values of the Y-Axis and the Display Format of the 
Scale Values 
Specify the maximum and minimum values of the Y-axis scale. The scale values can also 
be displayed using logarithmic format as shown below.

		
Select the exponential
format

Selecting the Display Zone of the Waveform
You can select from the following. In the Zone setting on the General Display Settings 
window, assume the bottom and top edges of the waveform display area to be 0% and 
100%, respectively, and set the waveform display position by specifying the minimum 
value (0 to 99%) and the maximum value (1 to 100%).
•	 User Zone
	 Displays each waveform at the position specified by Zone on the General Display 

Settings window. A single Y-axis scale of the active waveform is displayed.

			 

Select user zone

Click the bar to specify the
Y-axis you wish to activate

Displays the active Y-axis scale

Indicates the active Y-axis

Set the display zone

•	 Edit Zone
	 Like the user zone, each waveform is displayed at the position specified by Zone 

on the General Display Settings window. However, you can change the zone on the 
Trend Monitor window. A single Y-axis scale of the active waveform is displayed.

			 

Select edit zone

Drag the knob to change the minimum/maximum
value of the zone separately

Drag the bar to change the zone position without
changing the zone width

2.10  Starting/Stopping Data Monitoring and Displaying the Monitor
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•	 Full Zone
	 Displays all the waveforms over the full zone of the waveform display area regardless 

of the Zone settings on the General Display Settings window. A single Y-axis scale of 
the active waveform is displayed.

			 

Select full zone

Waveform display area (full zone)

•	 Slide Zone
	 Displays the waveforms by slightly offsetting the display position of each waveform 

vertically regardless of the Zone settings on the General Display Settings window. A 
single Y-axis scale of the active waveform is displayed.

			 

Select slide zone

Slide in this manner

•	 Auto Zone
	 Displays the waveforms by dividing the waveform display area evenly according to 

the number of displayed waveforms regardless of the Zone settings on the General 
Display Settings window.

			 

Select auto zone

Divided evenly automatically

•	 Multi-Axes Zone
	 All the Y-axes of the displayed waveforms are aligned horizontally. To hide a Y-axis, 

clear the Y-Axis check box on the General Display Settings window. The display zone 
is set to the position specified by Zone on the General Display Settings window.

Turn OFF the Y-axis
display of Ch00002

The scale of Ch00002 is not displayed.

Select multi-axes zone

Click the bar to move the
specified Y-axis to the left end

Indicates the active Y-axis

2.10  Starting/Stopping Data Monitoring and Displaying the Monitor
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Trip Points
You can display a trip line to indicate a particular value of interest (trip point) in the 
waveform display area. Two trip points (trip 1 is red, trip 2 is blue) can be set on each 
waveform. The trip line of the waveform corresponding to the left-most Y-axis is shown in 
the waveform display area.

		

Turn ON the trip line display

Trip 1 value

Trip 2 value Trip lineTrip 1 value
Trip 2 value

Channel Colors 
Clicking the channel color displayed in the Color column on the General Display Settings 
window opens the Color dialog box. You can select the color of each channel using the 
Color dialog box. To create custom colors, click the Define Custom Colors button in the 
Color dialog box.

		

Clipping of Waveforms 
By default (clip OFF), the waveform is not displayed when the measured/computed value 
exceeds the minimum/maximum value of the scale (see the lower left figure). When clip 
is turned ON, values that are smaller than the minimum value of the scale are displayed 
as the minimum value and the values that are larger than the maximum value of the 
scale are displayed as the maximum value.

		

Clip OFF Clip ON

Expanding or Reducing the Time Axis on the Waveform Display
On the waveform display, you can click the expand/reduce icon to expand or reduce 
the time axis for each waveform display area. The maximum magnification is x20. The 
minimum magnification varies depending on the size of the waveform display area.

		

Magnification

Time axis expand/reduce icon

2.10  Starting/Stopping Data Monitoring and Displaying the Monitor
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Adding Marks
You can display marks in the waveform display area (see the figure below). You can 
enter a text to be attached to the mark (“Mark” by default) using up to 15 characters. 
Click the Mark button or choose Mark Configuration from the Action menu. You can enter 
the text in the dialog box that opens.

		

Click either one

Up to two hundred marks can be displayed. When two hundred is exceeded, marks are 
overwritten starting from the oldest ones. However, when recording is in progress, the 
marks that are overwritten are saved to the data file.

		

MarkMark setup dialog box Text of the specified mark

Enter the text to be
displayed as a mark

If this check box is selected, the mark is placed without
displaying the dialog box when you choose Put a Mark
from the Action menu.

Note
Marks cannot be placed when the monitor update is paused.

Grid Density
You can change the displayed grid density. The available settings are standard, dense 
grid 1, or dense grid 2.  

		

Standard Grid Dense Grid 1 Dense Grid 2

2.10  Starting/Stopping Data Monitoring and Displaying the Monitor
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2.11	 Pausing/Resuming the Updating of the Monitor 
Display and Reading Measured Values Using 
Cursors 

Procedure

Pausing and Resuming the Updating of the Monitor Display
To pause the updating of the monitor display, click the Pause button or choose Pause 
from the Acquisition menu. When paused, the word “Pause” on the button toggles 
between red and orange.

		

Choose this.

or

Click either one.

Note
Recording continues even when the updating of the monitor display is paused.

To resume the monitor display, click the Pause button or choose Pause from the 
Acquisition menu. 

Reading Measured/Computed Values Using Cursors
1.	 Click the position where you wish to read the measured/computed data in the 

waveform display area of the Monitor screen. If you wish to read another point 
simultaneously, drag the cursor. Cursor A appears at the position where you first 
clicked; Cursor B appears at the position where you released the mouse button. A 
yellow circle is displayed where the waveform and the cursor cross.

	 You can move the waveform that is displayed in the waveform display area using the 
scroll buttons or scroll bar. 

				  

Cursor A Scroll button Scroll bar

Measurement point

Cursor B

2.	 From the View menu, choose Cursor’s Values.

				  
Choose this.
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A Cursor’s Values window opens as shown below. 

		

Channel number

Waveform
display color

Time between Cursors A and B
Time at Cursor B
Time at Cursor A

(Readout value of Cursor B) – (readout value of Cursor A)
Readout value of Cursor B

Readout value of Cursor A

To clear the cursors, choose Erase Cursor from the View menu. 

		  Choose this.

Explanation
Pausing the Updating of the Waveform Display
While monitoring the waveform, you can pause the updating of the waveform display and 
check the past waveforms. 
Pausing the display on the numeric display holds the current values immediately before 
the pause operation on display.

Reading Measured/Computed Values Using Cursors
When the updating of the waveform display is paused, you can read values using 
cursors. Two cursors can be displayed. Below are the values that can be read using 
cursors.
•	 Values at the cursors.
•	 Difference in the value between the cursors.
•	 The time at the cursor position.
•	 The time between the cursors.

2.11  Pausing/Resuming the Updating of the Monitor Display and Reading Measured Values Using Cursors
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2.12	 Starting and Stopping Data Recording

Procedure

Data monitoring must be in progress to start the recording operation. For instructions on 
starting the data monitoring, see section 2.10, “Starting/Stopping Data Monitoring and 
Displaying the Monitor.” 

Starting the Recording 
Click the Start Recording button, or choose Start Recording from the Acquisition 
menu. 

		
or

Choose this.
Click either one.

When recording starts, the display changes as shown in the figure below. To divide the 
file during recording, click the Save button or choose Manual Save from the Acquisition 
menu.

		

or

Choose this.

Click either one.

While the Record Start Condition specified on the Acquisition Condition screen is not 
met, the word “Waiting” appears on the Record Start button (see figure below). 

		

Displays Waiting while the record start condition is not met

Note
Clicking the Start Rec. or Stop Rec. buttons repetitively at short intervals or clicking the Manual 
Save button many times may hinder the measurement operation and file division process.

Stopping the Recording 
To stop recording when Stop Condition specified on the Acquisition screen is set to 
Continuous or before the Stop Condition is met, click the Stop Rec. button or choose 
Stop Recording from the  Acquisition menu.

		

or

Choose this.

Click either one.
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Click the Stop Rec button or the Stop button on the tool bar, or select Stop Recording 
from the Acquisition menu. Click OK in the dialog box that is displayed (like the one 
below).  

		

Click OK. When you click OK, the word “Stop Rec.” on the button changes to “Saving” 
until the recording actually stops. 

Explanation
Starting/Stopping the Recording 
Data is recorded according to the Start condition and Stop condition specified on the 
Acquisition setup screen. Recording starts immediately when you click the Start Rec 
button only when Start Condition is set to On Record. For all other settings, the detection 
of whether the start condition is met is started when you click the Start Rec button.

Note
•	 The creation of the data file starts after the recording is stopped. Therefore, it may take time 

for the data save operation to complete.
•	 You cannot exit the software if the saving of the data is not complete. If you attempt to do 

so, a dialog box with the message “Writing data files Currently” opens. In this case, the 
remaining number of data files to be finalized is displayed to the left of the icon indicating 
that the writing is in progress on the status display bar (see page 2-43) at the bottom section 
of the Main window. You can close the software when this number indication clears.

•	 If the specified directory for saving files does not exist when recording is started, the 
directory is created. If the directory cannot be created, the files are saved to the Data 
directory in the MXLOGGER installation directory.

•	 Do not specify the file save destination to a non-writable drive. 

Run Display
The Run screen displays the run information. For a description of the displayed contents 
on the Run screen other than those described below, see the explanation in section 2.10, 
“Starting/Stopping Data Monitoring and Displaying the Monitor.” 
•	 Record Information

			 

Record time
File creation progress indication bar
Move the mouse pointer here to display the remaining time value

Estimated completion time of the file currently being created
Estimated size of the file currently being created

Number of data files created

•	 Files created in the past

			 

Record files created in the past

Select a file and click the Open
button to start the Viewer.
(You can also double-click to
start the program.)

2.12  Starting and Stopping Data Recording
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2.13	 Saving/Loading and Printing Setup Data 
(Project)

Procedure

Saving Setup Data (Project)
1.	 From the File menu, choose Save or Save As.
2.	 If you choose Save As or choose Save when saving the setup data for the first time, 

enter the file name in the Save As dialog box and click Save. 
	 If you attempt to save the file using an existing file name, a dialog box appears for 

you to confirm whether the file is to be overwritten.

				  

or

Loading Setup Data (Project)
1.	 From the File menu, choose Close. 
	 If data monitoring is in progress, a message “Stop monitoring and quit?” appears. 

Click OK.
2.	 From the File menu, choose Open.
3.	 In the Open dialog box, select a project file and click the Open button.

				  

Note
When you carry out the procedure above, the current setup data is discarded and changed to 
the setup data of the project that is loaded. If you need the current settings, save the project 
first before loading the setup data.
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Printing Setup Data
1.	 From the File menu, choose Print. 
	 The Print dialog box opens.
2.	 In the Print dialog box, select the printer, print range, and the number of copies, and 

then click the OK button. 

				  

Display example of the Print Setup dialog box

Print Preview
From the File menu, choose Print Preview. 
The print image is displayed.

		

Setting Up the Printer
1.	 From the File menu, choose Print Setup.
	 The Print Setup dialog box opens.
2.	 Set the paper size, orientation, etc. Then, click the OK button. 

				  

Display example of the Print Setup dialog box

2.13  Saving/Loading and Printing Setup Data (Project)
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Explanation
Saving Setup Data (Project)
When the Logger is started, the screens are displayed according to the setup data of 
the project file that is automatically created (latest.mxe in the MXLOGGER folder). In 
this case, the setup specified on each screen is automatically saved when the Logger is 
closed.
If you save the setup data (project) as a project file by assigning a name and you open 
the project file, the setup specified on each screen is not automatically saved when the 
Logger is closed. To save the setup data, you must choose Save from the File menu.

Save Destination
The default save destination varies depending on the system that is running.

File Name
The extension is .mxe. The default file name is NewProject1.mxe. 

Creating a New Project
Create a new project when you wish to monitor the measured/computed data using new 
settings.

Print Contents of Setup Data
The following figure show how the setup data is printed.

		

2.13  Saving/Loading and Printing Setup Data (Project)
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2.14	 Setting Up the Monitor Server

Procedure

Starting and Exiting the Monitor Server
Starting
Click the Monitor Server button on the toolbar or choose Run Server from the File menu. 

		  Click here

or

The Monitor Server window opens as shown below. 

Status display bar at the bottom section of the Main window

Click here to display the Monitor Server window
Displayed only when the Monitor Server is running

Exiting
On the Monitor Server window, choose Exit from the Monitor Server menu. 

		

Choose this.

Changing the Port Number
1.	 From the File menu, choose Port No.. 
	 The Port No. dialog box opens.

				  

2.	 Enter the desired port number in the Port No. box and click OK. 

				    Port number (50284 by default)
Use this port number unless this number is
being used by another software program

3.	 In the dialog box with the message “Port No. is available for next time.” click OK. 
Then, restart the server to activate the new port number.
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Explanation
Monitor Server Function
The Monitor Server function allows PCs running the following software programs to 
monitor the data that the MXLOGGER is monitoring. 
•	 AddObserver
•	 AddObserver Runtime
•	 AddMulti
•	 AddTrigger

The MXLOGGER can hold up to 61 data memories*. A system No. between 0 and 60 is 
assigned to each data memory according to the monitor interval of the individual units 
specified on the Logger. Each system  number has information on the unit No., the 
channel range, the monitor interval, and the number of channels.
Clients (PCs running AddObserver, AddObserver Runtime, AddMulti, or AddTrigger) can 
monitor the data by specifying this system  number.
For instructions on monitoring the data on each software program, see the user’s manual 
for each software.

*	 Each unit (MX100) has three monitor intervals, and the MXLOGGER can connect up to 
20 MX100s. Therefore, the maximum number of data memories is 3 × 20 = 60. Adding the 
monitor interval of the computation channel makes it 61. 

	

Host name (computer name) of the connected client
Maximum number of connections: 32

Number of channels
Number of channels being monitored within the channel range

System No.
Number assigned to each data memory (0 to 60)

Monitor interval
Data monitor interval of the respective measurement group
Channel range
Channel range corresponding to the unit NO. and monitor interval
Unit No.
Unit number on the Logger
00 [Meas.] to 19 [Meas.]: Measurement data that the MX100 acquired
99 [Math]: Computed data

Port Numbers
The default value is 50284. Unless other software programs are using a different port 
number, it is recommended that this port number be used. 

2.14  Setting Up the Monitor Server
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2.15	 Setting Up the DDE Server

Procedure

Starting and Exiting the DDE Server
Starting
Click the DDE Server button on the toolbar or choose DDE Server from the File menu. 

		  Click here.

or

The DDE Server window opens as shown below. 

		

Status display bar at the bottom section of the Main window

Topic data tabTopic sdata tab

Click here to display the DDE Server window
Displayed only when the DDE Server is running

Exiting
On the DDE Server window, choose Exit from the DDE Server menu. 

		

Choose this.
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Description
DDE Server Function
The DDE server function displays the following data on application software that supports 
the DDE server.  
Parentheses indicate item names. 
Measured Data
	 Computed data
	 Date and time (date)
	 Time (time)
	 Seconds (sec)
	 Data number (no)
For Excel, enter “application|topics!item” in a cell. For example, to display measured data 
from channel 1, enter “MXDde|data!ch0001.” For details on data specification, see the 
documentation for the software you are using.  

2.15  Setting Up the DDE Server
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2.16	 Displaying the Software Version and Other 
Information

Procedure
Click the About button on the toolbar or choose About from the Help menu.
A dialog box showing the version number and other information opens. 

		

or

Click here.

Version
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3.1	 Loading Data Files

Procedure
1.	 Start the Viewer.
2.	 From the File menu, choose Open.
	 You can also click the  button on the toolbar.
	 The Open dialog box opens.

		

File information
In the case of data saved using the 
Integration Monitor of the MX100 
Standard Software, MX100 Standard 
Logger is displayed by Creator.

3.	 Select the file you wish to load and click Open.
	 The waveform display window opens.
	 If you open data files that were recorded using the Logger of the MXLOGGER or the 

Integration Monitor of the MX100 Standard Software, a dialog box is opened with 
the message, “File not synchronized. Synchronize data file?” before the waveform 
display screen appears. To synchronize the data, click Yes, otherwise, click No. 
If you open a file containing recorded data of multiple MX100s and you click the 
No button, the Select Unit No. dialog box opens. Click the desired MX100 unit 
number to display the data corresponding to the unit. When displaying data without 
synchronization, data of different units cannot be displayed simultaneously.

	 Opening Data Saved to the CF Card on the MX100 
	 Before the waveform display window is displayed, if a CF file that can be joined 

exists, a dialog box appears with the message “Join Related Files?” To join the data 
files, click Yes, otherwise, click No.

Chapter 3	 Viewer
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The waveforms of the measurement channels and math channels are divided by the Mon.
Interval specified on the Acquisition screen of the Logger even when in the same group.

Click the unit numberSynchronized file
A file with .mxs extension

Unsynchronized file
A file with .mxd extension

Note
If you click the Yes button in the synchronization confirmation dialog box when a synchronized 
file already exists, the message dialog box below opens. Click OK to load the synchronized file 
and open the waveform display window.

	

Explanation
Loadable Files
•	 Data files recorded using the Logger of the MXLOGGER or the Integration Monitor of 

the MX100 Standard Software (.mxd extension).
•	 Data files saved after performing synchronization using the Viewer (.mxs extension).
•	 Data files saved to the CF card using the MX100 (.mxd extension).
•	 Data files saved after being joined on the Viewer (with the .mxc extension)

Display Range, File Size, and Number of Data Points of the Loadable Data
•	 50 groups
•	 Maximum channels per group: 32
•	 Example: 2 GB
•	 Data points: 5 million

Note
•	 When loading a file of close to five million points, the error message “Insufficient Memory. 

Close immediately.” appears. If this happens, set Total paging file size for all drives to 2 GB 
or more. On PC, you can change the setting in the dialog box that opens by choosing from 
the System Properties dialog box, Advanced > Settings under Performance > Advanced 
> Change under Virtual memory.

•	 Please avoid loading multiple files containing close to five million data points. Doing so may 
degrade the PC performance greatly.

3.1  Loading Data Files
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Synchronization
The Logger of the MXLOGGER or the Integration Monitor of the MX100 Standard 
Software sends PC’s time information to the MX100 at measurement intervals. The PC’
s time information is received along with the measured data when the data is received 
from the MX100. When measured data is recorded, the PC time information (the MX100’
s time information is used on the monitor display of the Logger) is also recorded.

		
PC Time

MX100

Packet

Packet
Measured data

Measured data

PC Time
.  .  . .  .  .

PC Time
MX100

PC

MX100

On the other hand, each MX100 makes measurements based on the main module clock. 
Therefore, the PC’s time that is recorded with the measured data and the PC’s time when 
measurements were made may be offset. When loading the data, the Viewer can process 
the time information to match the PC’s time that was present at time of measurement. 
This process is called synchronization (for details, see Note on the next page). 

Note
•	 Details of Synchronization
	 Given M recorded data points of a given channel of a data file that has not been 

synchronized, synchronization (linear interpolation) is carried out as follows: 
1.	 From the record start/stop time and record interval, determine N, the number of data 

points that will result after synchronization of the relevant channel. 
2.	 From the record start time and record interval, determine Stn (n=0, ... , N-1), the PC time 

after synchronization of each data point. 
3.	 From the record start/stop time and the PC millisecond clock counter values at record 

start/stop, determine PCcntPerms, the clock counter value per millisecond. 
4.	 From the PC millisecond clock counter values recorded with the data before 

synchronization and PCcntPerms, determine Rtm (m=0, ... , M-1), the PC time of the 
data before synchronization. 

5.	 Determine m such that the expression Rtm-1 ≤ Stn < Rtm is satisfied and retrieve the 
data values before synchronization VRtm-1 and VRtm at the PC time of Rtm-1 and Rtm. 

6.	 Determine the data values after synchronization from the expression VStn = (Stn – 
Rtm-1) × (VRtm – VRtm-1)/(Rtm – Rtm-1) + VRtm-1 where (n=0, ... , N-1 and m=0, ... , 
M-1). 

7.	 Determine the data values after synchronization for N data points, and then write them to 
the synchronized file. 

								      

Rtm-2

VRtm-2

VRtm-1

VStn

VRtm

VRtm+1

Rtm-1 Stn Rtm Rtm+1 PC time

Data value

•	 When loading a data file saved by the MX100 to the CF card, synchronization is not possible 
because the PC time information needed in the data synchronization is not present.

3.1  Loading Data Files



3-4 IM WX103-01E

•	 Synchronization may take time depending on the number of divided files and the number of 
data points in the divided files. 

•	 It is recommended that synchronization be performed on a hard disk with adequate free 
space. 

•	 Even when synchronization is performed, the files before synchronization (.mxd extension) 
are not deleted.

•	 Performing synchronization on the Viewer or loading a file with a great number of data 
points while data monitoring/computation is in progress on the Logger of the MXLOGGER 
or the Integration Monitor of the MX100 Standard Software may adversely affect the data 
monitoring and computation (such as data dropouts). 

•	 If you change the PC’s time while data is being monitored on the Logger of the MXLOGGER 
or the Integration Monitor of the MX100 Standard Software, the error in the clock counter 
value per millisecond of the PC used in the synchronization process will become large. If the 
error in this value is greater than or equal to 2% when synchronizing the data file created at 
the time PC’s time was changed, the clock counter value of 1 millisecond is considered to 
be 1 for the purpose of synchronization.

•	 If communication is disrupted temporarily due to power failure or network failure during the 
recording operation, the PC time of the data measured by the MX100 while communication 
is disrupted (see “Details of Synchronization” above) is recorded as the old PC time before 
communication was disrupted in the file created immediately after communication recovers. 
If you attempt to synchronize this file, a dialog box with the message “Some channels do 
not have enough information to synchronize.” appears. In this case, synchronization is 
performed with the premise that the MX100 measured the data using the logical (estimated) 
record interval.

Data Files Created by Synchronization
The data file created by synchronization takes on the same file name with .mxs 
extension. 
When synchronizing, if the backup file is placed in the same folder, data dropout from 
the recording file is embedded in the backup file (data saved to the CF card), and 
synchronization of channel data is performed. Also, the between channel delay in the 
medium speed modules is compensated during synchronization.
Synchronized files created by the synchronization process are created in the same 
directory as the data file normally displayed. The file name is “the name of the file being 
displayed (excluding the .mxd extension)” + “mxs extension” However, if the destination 
storage medium is write-protected, the file is created in the temporary file directory. The 
temporary file directory is displayed in an error message dialog box.

Joining of Divided Files
When divided data files are loaded, they are joined by the synchronization process. 
If a file that can be joined to the displayed data exists and you synchronize the data, 
the existing synchronized file is overwritten. If the existing synchronized file cannot be 
overwritten (set to read-only attribute, for example), a new synchronized file is created. 
A sequence number is added to the name of the new synchronized file (“the name of the 
file being displayed” + “sequence number” + “mxs extension” For example, if the existing 
synchronized file name is “data-0000.mxs” the new file name is “data-0000- 1.mxs” 
The following limitations exist in the joining of files through synchronization. 
•	 If any of the divided data files are missing, the data files after (or before) the missing 

file are not joined. 
•	 If the total number of measured data points in the divided data files exceeds 5 million 

(including data that is dropped due to power failures and other failures), files that 
would not cause the total number of displayed data points to exceed 5 million are 
joined. 

3.1  Loading Data Files
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	 When synchronizing data files that exceed the 5 million point range, the file is used 
as the start file and succeeding files are joined. If 5 million points is not exceeded 
when the last file is joined, files before the start file is searched in order, and files that 
would not cause 5 million points to be exceeded are joined. In this case, because 
the files before the start file are also joined to the previous synchronized file, two 
synchronized files for this file would exist. If you open a file before the start file and 
perform synchronization, the viewer displays the first file the OS finds (either of the 
two existing synchronized files). In such cases, it is recommended that the files you 
wish to join are selected so that the limit is not exceeded, copied to the user’s working 
folder, and synchronized there. 

•	 Divided files can be joined up to the point in which the size of the joined file reaches 2 
GB. 

CF File Joining Function
Data saved to the CF card on the MX100 can be joined.  
•	 The data that can be joined are CF files that were created on the same unit from 

record start to record stop.  

		

[File 0]
Start condition: 

start
Stop condition: 

divide

Measurement
Interval 1

Group of files with 
file number 0

This group becomes the unit of joining

[File 1]
Start condition: 

divide
Stop condition: 

divide

•  •  • 

[File 2]
Start condition: 

divide
Stop condition: 

divide

[File N*]
Start condition: 

divide
Stop condition: 

stop

*Max number of files

time

[File 0]
Start condition: 

start
Stop condition: 

divide

Measurement
Interval 2

[File 1]
Start condition: 

divide
Stop condition: 

divide

•  •  • 

[File 2]
Start condition: 

divide
Stop condition: 

divide

[File N*]
Start condition: 

divide
Stop condition: 

stop

[File 0]
Start condition: 

start
Stop condition: 

divide

Measurement
Interval 3

Recording start Recording stop

[File 1]
Start condition: 

divide
Stop condition: 

divide

•  •  • 

[File 2]
Start condition: 

divide
Stop condition: 

divide

[File N*]
Start condition: 

divide
Stop condition: 

stop

•	 Data are joined by file groups of data with multiple measurement intervals of the same 
file number.

•	 If a number of files equalling the number of measurement intervals of the specified file 
number (if three measurement intervals are specified, the number would be 3) does 
not exist in the file group, files just prior to the file group of the relevant file number are 
joined.  

•	 The resulting files that are created are limited to five million points/2 GB.  
•	 The extension of the joined files is .mxc.  
The operation is carried out by choosing File > Join in the menu.   Also, when opening 
data files, if you choose data saved to the CF card in the MX100 main unit, the “Join 
related files” dialog box appears and the files are joined.  
CF files or joined data files displayed in the active window can themselves be joined, and 
Join in the menu is enabled.  
If the data files displayed in the active window are not CF or joined files, Join is disabled 
in the menu.  

Note
When joining or performing other such processes, copy the data files onto the hard disk of the 
PC from the CF card first.  

3.1  Loading Data Files
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3.2	 Setting the Display

Procedure

Changing the Display on the Waveform Display Window
Change the display settings according to the explanation is the figure below.

		

Switch the display group

Y-axis

Channel ON/OFF

Change the grid density

Channel number and measurement unit

Change the background
darkness

Zoom in or out of the time axis
Switch the display zone

Switch the active channel

Alarm display ON/OFF

Move the cursor to the point where
 the alarm changed

Clip display ON/OFF
Switch the grid density

Zone display section ON/OFF

Changing the Display Using the Toolbar
Change the display settings according to the explanation is the figure below.

		

Show the window for displaying statistical
computation over an area

Show the General Display 
Settings window

Show the window for displaying cursor values

Show the numeric display window
Alarm/marker list display

Show the waveform display window

Switching between Absolute and Relative time

Move cursor A to the right mark
Move cursor A to the left mark

Move cursor B to the left mark
Move cursor B to the right mark

Tag comment display
Tag No. display

Channel number display

Add a mark
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Changing the Display Using the Menu
Choose appropriate commands from the Edit, View, and Window menus to change the 
display.

		

Show the computation result display window
Show the window for displaying cursor values

Show the General Display Settings window

Add/Delete a mark

Erase the cursor
Select a mark search

Change the data file display
Switch between channel number, tag No.,
and tag comment displays
Switch between absolute and relative time*
Turn ON/OFF the toolbar
Turn ON/OFF the status bar

Arrange the display window (select cascade or tile)

Show the waveform display window
Arrange window icons

Show the numeric display window
Select how to arrange the display area from auto, horizontal, and vertical

Switch the display window

* Displays also the Format item during
 numeric display

Alarm/marker list display

Changing the Display Using the Display Settings Window
See the explanation in the figure below. Change the display settings and click OK.
Set the display for each display group.

		

Select the Y-axis display format

Switch the display group

Select channels (displays the channel selection dialog box)

Group name

Display ON/OFF

Select the Y-axis type (linear or logarithmic)
Turn Y-axis display ON/OFF when displaying multi-axes zone

Maximum/Minimum value of the scale

Turn ON/OFF the trip point display

Trip point value

Channel display color

Display zone position

3.2  Setting the Display
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Explanation
Display Groups and Group Names
The values of each channel that are loaded are divided into groups that were used during 
recording and displayed using waveforms or numeric values. The measured/computed 
values can be divided into up to 50 groups. Up to 32 channels can be registered to a 
single group. If you click the channel selection button on the General Display Settings 
window, the Channel No. dialog box opens (see the figure below). The labels used to 
identify the waveforms can be set to tag numbers or tag comments in addition to channel 
number on the View menu. The selected label type (channel number, tag number, or tag 
comment) is used in the Channel No. dialog box. Select <None>, if you are not assigning 
a channel.

		

To turn ON/OFF the trend waveform display on the waveform display window, click the 
button below the active channel switch bar as shown in the figure below. 

		

Hide the waveform

The name assigned to each group can be changed using up to 30 characters. The 
names of the display groups that have channels registered are displayed on the 
waveform display window or numeric display window.

		

Y-Axis Type
You can select linear or logarithmic Y-axis for displaying the waveforms.

		

Linear Logarithmic

3.2  Setting the Display
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Maximum and Minimum Values of the Y-Axis and the Display Format of the 
Y-Axis Values
The maximum and minimum values of the scale on the waveform display can be 
changed. If you click the Scale Calc. button on the General Display Settings window, 
the maximum and minimum values of the scale on the selected channels are calculated 
automatically according to the maximum and minimum values of the data.
The Y-axis can also be displayed using logarithmic format as shown below.

		
Select the exponential format

Selecting the Waveform Display Zone 
You can select from the following. In the Zone setting on the General Display Settings 
window, assume the bottom and top edges of the waveform display area to be 0% and 
100%, respectively, and set the waveform display position by specifying the minimum 
value (0 to 99%) and the maximum value (1 to 100%).
•	 User Zone
	 Displays each waveform at the position specified by Zone on the General Display 

Settings window. A single Y-axis active channel waveform can be displayed. 

			 

Select user zone

Click the bar to specify the active channel

Display the Y-axis of the active channel

Indicates the bar of
the active channel

Set the display zone

•	 Edit Zone	
	 Like the user zone, each waveform is displayed at the position specified by Zone 

on the General Display Settings window. However, you can change the zone on the 
waveform display window. A single Y-axis of the active waveform can be displayed. 

			 

Select edit zone

Drag the knob to change
the minimum/maximum
value of the zone separately Drag the bar to change the zone position

without changing the zone width

3.2  Setting the Display
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•	 Full Zone
	 Displays all the waveforms over the full zone of the waveform display area regardless 

of the Zone settings on the General Display Settings window. A single Y-axis of the 
active waveform is displayed. 

			 

Select full zone

Waveform display area (full zone)

•	 Slide Zone
	 Displays the waveforms by slightly offsetting the display position of each waveform 

vertically regardless of the Zone settings on the General Display Settings window. A 
single Y-axis of the active waveform is displayed. 

			 

Select slide zone

Slide in this manner

•	 Auto Zone
	 Displays the waveforms by dividing the waveform display area evenly according to 

the number of displayed waveforms regardless of the Zone settings on the General 
Display Settings window.

			 

Select auto zone

Divide evenly automatically

3.2  Setting the Display
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•	 Multi-Axes Zone
	 All the specified Y-axes of the displayed waveforms are aligned horizontally. To 

hide a Y-axis, clear the Y-Axis check box on the General Display Settings window. 
The display position is set using Zone on the General Display Settings window. 
Dragging the channel bar to the waveform display area shows the Y-axis of the 
corresponding channel. Drag the Y-axis to the zone display area hides the Y-axis of 
the corresponding channel.

			 
Turn OFF the Y-axis
display of Ch00002

The Y-axis display of Ch00002 is not displayed.

Select multi-axes
zone

Click the bar to move the specified Y-axis to the right end

Indicates the
specified Y-axis

Trip Points
You can display a trip line to indicate a particular value of interest (trip point) in the 
waveform display area. Two trip points (trip 1 is red, trip 2 is blue) can be set on each 
waveform using the Trip 1 and Trip 2 settings on the General Display Settings window. 
The trip line of the waveform corresponding to the right-most Y-axis bar is shown in the 
waveform display area.

		

Turn ON the trip line display

Trip 1 value*

Trip 2 value*

Trip line
Trip 1 value

Trip 2 value

* Can be moved
 by dragging

Channel Colors 
Clicking the channel color displayed in the Color column on the Display setup screen 
opens the Color dialog box. You can select the color of each channel using the Color 
dialog box. To create custom colors, click the Define Custom Colors button in the Color 
dialog box.

		

3.2  Setting the Display
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Clipping of Waveforms
By default (clip OFF), the waveform is not displayed when the measured/computed value 
exceeds the minimum/maximum value of the scale (see the lower left figure). When clip 
is turned ON, values that are smaller than the minimum value of the scale are displayed 
as the minimum value and the values that are larger than the maximum value of the 
scale are displayed as the maximum value.

		

Clip OFF Clip ON

Expanding or Reducing the Time Axis on the Waveform Display
On the waveform display window, you can click the expand/reduce icon to expand or 
reduce the time axis in the range of 20 to 1/1000 times for each waveform display area.

		

Magnification

Time axis expand/reduce icon

Adding Marks
In addition to the marks placed using other programs such as the Logger, you can add 
marks at the positions where you click (displays a cursor) on the waveform display 
area. You can enter a text to be attached to the mark (“Mark” by default) using up to 15 
characters. You can also select Left, Center (default), Right, or Flag (small mark without 
text) for the Type. For types other than Flag, the specified string and the relative or 
absolute time at the mark position are displayed.
You can set the string and type in the Mark dialog box that opens when you click the 
Append Mark icon (or choose Append Mark from the Edit menu). In the Mark dialog box, 
you can select whether to add the mark to the waveforms of all groups (default) or only 
the waveforms of the displayed group.
To delete specific displayed marks, select the range using cursors, and then choose 
Delete Mark from the Edit menu. To delete all the marks added using the Viewer, choose 
Reset Mark from the Edit menu.

	

Left endMark display icon CenterFlagDisplay the cursor

or
Marks added on the Viewer are green,
marks added created through
computation are yellow, and marks
created using the Logger or MX100
Standard Software are orange.

Double-click the mark to change the settings

Grid Density
You can change the displayed grid density. The available settings are standard, dense 
grid 1, or dense grid 2.  For instructions, see section 2.10, “Starting/Stopping Data 
Monitoring and Displaying the Monitor.” 

3.2  Setting the Display
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Switching between Absolute and Relative Time
By default, the time axis is displayed using absolute time. The time axis can also be 
displayed using time relative to the first data position.

		

Switch absolute/relative time

Absolute time Relative time

On the numeric display, you can select the display format of the absolute or relative time 
and turn ON/OFF the data numbers using Format on the View menu.

		

Showing/Hiding Alarms
You can hide the alarm display area that indicates the status of alarm occurrence. The 
alarms are displayed in the same fashion as the alarms displayed in the waveform 
display area of the Integration Monitor.

		

Show/Hide the alarms No alarm display

Alarm display area

3.2  Setting the Display
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Alarm/Mark List Display
Displays a detailed list of alarms and marks. 
From the Window menu, choose Alarm/Mark List Display. 
You can also click the  button on the toolbar.

•	 Alarm List Display

			 

Sorted by the clicked item
Currently sorted by the mark item 

•	 Marker List Display

	

Sorted by the clicked item
Currently sorted by the mark item 

Mark added by 
Viewer software

Mark added by 
computation

Mark added in the 
Monitor screen

Names of groups with marks
If no group is specified, all groups have marks

3.2  Setting the Display
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The alarm/marker list display’s cursors are linked with those of the waveform display and 
numeric display layout screens. Alarms or marks selected with the cursor in the alarm/
mark list display can be copied to the clipboard using the Edit > Copy command.
The alarm/mark list can be converted to ASCII, Excel, or Lotus format (see section 3.7).

Alarm display limitation:	 One file can display a maximum of 10000 alarms.

Left-to-Right Alarm Search (Waveform Display Screen Only)

		

Move cursor B to the next alarm change point on the left
Move cursor B to the next alarm change point on the right

Move cursor A to the next alarm change point on the right
Move cursor A to the next alarm change point on the left

Cursor A Cursor B

Alarm indication

Select the active channel

Left-to-Right Mark Search (Waveform Display Screen Only)
In the waveform display screen, move cursor A and B to the right or left side of the mark.
From the Edit menu, choose Mark Search. Or click the corresponding toolbar button.

		

Move cursor B to the left mark
Move cursor B to the right mark

Move cursor A to the right mark
Move cursor A to the left mark

Cursor A Cursor B

Mark
The marks added in the Monitor 
screen are orange, marks added in 
the computation (event function 
Mark) are yellow, and those added 
in the Viewer software are green.

3.2  Setting the Display
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Numeric Display 
Numeric display can be shown along with the waveform display window. When channels 
with different record intervals exist within the same group, the screen is divided. The 
display group, active channel, and mark display are synchronized to the waveform 
display.
If cursors are displayed on the waveform display window, the data values between the 
cursors are displayed in red. Also, the data column corresponding to the cursor position 
is displayed in gray.

		

Date/Time

Switch the
display group

Alarm

Channel display color

ValueData number

Active channel
(Y-axis display channel on
the waveform display)

Mark indication Horizontal scroll

Display per
record interval

Note
•	 If you open the numeric display window when two cursors are shown on the waveform 

display window, the numeric values in the interval between the cursors is displayed in red. 
If you choose Copy from the Edit menu (press the Ctrl + C key) in this condition, the data in 
the interval is copied to the clipboard as text data.

•	 Up to 1000 lines can be copied. (Copy on the Edit menu is not available if the number of 
lines specified by the cursors is above 1000.)

•	 If data with multiple record intervals is being displayed, the numeric values between the 
cursors on the data sheet of the active record interval are copied. The title line displaying the 
“Absolute Time [No.]” and channel number of the data sheet of the active record interval is 
displayed using grayish light blue color. The color of the title line and the color of the “Absolute 
Time [No.]” column are displayed using the same color on inactive sheets. You can activate 
a sheet by clicking the sheet.

Waveform/Numerical Display Layout
The waveform or numeric display of data with differing measurement intervals is 
arranged according to those intervals, but the layout of the display can be selected from 
Auto, Horizontal, or Vertical.
•	 Auto	 Switches between vertical and horizontal automatically according to the 

window size. 
•	 Horizontal	 Sets horizontal orientation regardless of the window size.
•	 Vertical 	 Sets vertical orientation regardless of the window size.

			 

Horizontal/landscape layout of the waveform display

3.2  Setting the Display
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Vertical/portrait layout of the waveform display

Initializing, Copying, and Pasting of Settings on the General Display 
Settings Window
On the General Display Settings window, you can reset the settings to default or copy 
and paste the settings of one or multiple waveforms to the settings of other waveforms. 
You can copy and paste according to the procedure below.
Drag the copy source waveform number (No. column), click the Copy button, drag the 
copy destination waveform number, and click the Paste button.

		

Click this button to turn ON/OFF the channels collectively

To copy/paste the item,
click to show the flag.

To not copy/paste the item,
click to hide the flag

Click this icon to reset
to default settings

Click this button to assign the channels in order

Click this button to enter the same settings as
the first channel in the selected range

Click to select all

Drag to select a range of waveforms

To paste the copied settings

To copy
the settings

To set the scale to match
the maximum and
minimum values of the data

3.2  Setting the Display
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3.3	 Reading Values Using Cursors

Procedure
1.	 On the waveform display window, click the tag of the group from which you wish to 

read the value using cursors.
2.	 Click the position where you wish to read the data in the waveform display area of 

the waveform display window. 
	 If you wish to read another point simultaneously, drag the cursor. Cursor A appears 

at the position where you first clicked; Cursor B appears at the position where you 
released the mouse button. A yellow circle is displayed where the waveform and the 
cursor cross.

	 You can move the waveform that is displayed in the waveform display area using the 
scroll buttons or scroll bar.

				  

Cursor A Cursor B

Measurement
point

Group selection tab

3.	 From the Window menu, choose Control.

				  

	 The Cursor Value window opens.

				  

Channel number and
measurement unit

Channel display color

Time between Cursors A and B

Time at the Cursor B position

Time at the Cursor A position

Value at the Cursor B position – value at the Cursor A position
Value at the Cursor B position

Value at the Cursor A position

Alarm indication

Data number at the Cursor A position

Move
Cursor A

Data number at the Cursor B position

Move
Cursor B Difference in the data number between Cursors A and B
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Clearing Cursors
From the Edit menu, choose Erase Cursor.
The cursors are cleared as well as the cursor values displayed in the Control dialog box.

Explanation
Reading Measured/Computed Values Using Cursors
Two cursors can be displayed. The following values can be read on the Control window.
•	 Values at the cursors.
•	 Difference in the value between the cursors.
•	 Absolute time and data number at the cursor position.
•	 Time between the cursors and the difference between the data numbers.
•	 Alarm status of the value at the cursor.

Note
•	 The cursors used to display cursor values and those used to specify the interval for 

statistical computation over an area are the same.
•	 The Cursor Value window and the Statistics window can be displayed simultaneously.
•	 If you click the tab of another group on the waveform display window while the Cursor Value 

window is open, the cursor values of the selected group are displayed on the Cursor Value 
window.

•	 You can change the cursor positions on the waveform display window while the Cursor 
Value window is open.

•	 If you choose Select All from the Edit menu, Cursor A is displayed at the first data position 
and Cursor B is displayed at the last data position.

3.3  Reading Values Using Cursors
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3.4	 Statistical Computation over an Area of 
Measured/Computed Data

Procedure
1.	 On the waveform display window, click the tab of the group on which you wish to 

perform statistical computation over an area.
2.	 Click the start position of the computation area in the waveform display area.
	 A light-blue cursor appears in the waveform display area. If multiple waveform 

display areas are displayed, the cursor is displayed at the time position each 
waveform display area.

3.	 Drag the cursor to the end position of the computation area
	 Another light-blue cursor appears at the position where the cursor was dragged.

				  

Cursor (the start of the statistical computation over an area)
Cursor (the end of the statistical computation over an area)

Group selection tab

4.	 From the Window menu, choose Statistics.

				  

	 The Statistics window opens.

				  

Channel number and
measurement unit

Channel display color

Data number at the start position
of the statistical computation
over an area

Data number at the end position of the statistical
computation over an area

Minimum value

Maximum value
Copy data to the clipboard

Maximum value – minimum value

Mean value

RMS value

Scroll
the channel
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Explanation
Copy data to the clipboard
If you click the Copy button, the results of statistical computation over an area are 
copied to the clipboard as text data. You can press the Ctrl + C key when the statistical 
computation over and area window is active to copy the displayed results as text data in 
the same manner to the clipboard.

Statistical Computation over an Area
Specify using two cursors the interval over which computation is to be performed. 
If the cursors are not displayed, all the data are used in the statistical computation. 
The statistical parameters are the minimum value, the maximum value, the P-P value 
(maximum – minimum), the average value,  and the rms value. 

Note
•	 To redo the computation after changing the computation area, you must select the button or 

the menu again.
•	 The cursors used to specify the interval for statistical computation over an area and those 

used to read values are common.
•	 The Statistics window and the Cursor Value window can be displayed simultaneously.

3.4  Statistical Computation over an Area of Measured/Computed Data
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3.5	 Saving Display Settings

Procedure
From the File menu, choose Save Display Setting File.
You can also click the  button on the toolbar.
The display setting file is created in the same folder as the data files.

		

When Closing the Viewer
If you open a file and change the display settings, the dialog box below opens when you 
attempt to close the Viewer. To save the changed display settings, click Yes.

		

Explanation
Display Settings That Are Saved
•	 Information about the group whose waveform or numeric display is open.
•	 Settings entered using the tool buttons at the top section of the waveform display area 

of each group.
	 Alarm display ON/OFF, magnification, scale, clip ON/OFF of the waveform display.
•	 Cursor position (absolute time).
•	 General Display Settings on the View menu.
•	 Channel No., Tag ID, or Tag comment setting on the View menu.
•	 Absolute Time or Relative Time setting on the View menu.
•	 Graph/Sheet Layout setting on the Window menu.
•	 Check box items in the File Information dialog box on the Information menu
	 The items are used as headers when the data is printed.
•	 Print Setting on the File menu.

Range, Color, Print Groups, and Comment.
•	 Marks created on the Viewer.
•	 Position of the display screen

Display Settings File
The display setting file (with .mxv extension) is created in the folder containing the data 
files. If the data file name is data.mxs, the display setting file name is data.mxs.mxv. The 
next time the data file is opened, the display opens according to the information in the 
display setting file.
If the display setting file is deleted or moved to another folder, the display opens 
according to the display settings used when the data file was created.

Note
•	 You cannot open a file containing the data you wish to view by selecting a file with .mxv 

extension.
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3.6	 Saving the Display Template

Procedure
Saving Templates

1.	 From the File menu, choose Save Template.
	 The currently displayed settings are saved as a template file to the same folder as 

the displayed data.

				  

Using Templates
1.	 From the File menu, choose Use Template.
	 If the currently displayed data file is not accompanied by its display settings file, it 

is displayed according to the setting information of the template file residing in the 
same folder. 

	 If the currently displayed data file is accompanied by its display settings file, it is 
displayed according to the setting information of the display settings file. 

Explanation
The template file is saved with the name default.mxt in the folder of the currently 
displayed data.
When using a template file, the template file residing in the same folder as the displayed 
data is used.
The setting information saved to the template file is as follows.
•	 Information about the group whose waveform or numeric display is open.
•	 Settings entered using the tool buttons at the top section of the waveform display area 

of each group.
	 Alarm display ON/OFF, magnification, scale, clip ON/OFF of the waveform display.
•	 General Display Settings on the View menu.
•	 Channel No., Tag ID, or Tag comment setting on the View menu.
•	 Absolute Time or Relative Time setting on the View menu.
•	 Graph/Sheet Layout setting on the Window menu.
•	 Check box items in the File Information dialog box on the Information menu
	 The items are used as headers when the data is printed.
•	 Print Setting on the File menu.

Range, Color, Print Groups, and Comment.
•	 Position of the display screen
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3.7	 Converting Data Formats

Procedure
1.	 From the Convert menu, choose To ASCII, To Excel, or To Lotus.

				  

2.	 After entering required settings in the dialog box that opens, click OK. 
	 The file is created at the specified destination.

Enter the range of group numbers to be converted

Select whether to set the range
to be converted using groups
or channels

Select the range of channels to be converted
Click to open the selection dialog box.Select the record interval

Only the channels with the selected
record interval are converted

Enter the data range to be converted
Can be specified using cursors before
opening this dialog box

Displays the time of the specified data

When changing the save destination or file name
Click to open the save destination and file name setup
dialog box.

Step when saving data at certain intervals

Select normal/trans position for the format 
used for data conversion

Displays the save destination and file name

Explanation
Convertible Data Formats
•	 ASCII

Text data with each data point separated by a comma. The extension is .txt.
•	 Excel
	 Data that can be opened using Microsoft’s spreadsheet application Excel version 4.0 

or later. The extension is .xls.
•	 Lotus
	 Data that can be read using IBM’s Lotus 1-2-3 spreadsheet program version 2.0 or 

later. The extension is .wj2.

Converted Data
Specify the range using group numbers or channel numbers. You can select the channel 
number by clicking in the dialog box as shown below.

		

If multiple recording intervals exist in the data to be converted, select the recording 
interval. Only the data of the channels having the selected record interval is converted.
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Conversion Range and Step
You can specify the range using data numbers or by using cursors. For the method 
of specifying the range using cursors, see the procedure in section 3.4, “Statistical 
Computation over an Area of Measured/Computed Data.” 
By specifying the step, you can save data sampled at certain intervals rather than 
converting all the data in the range (when step is set to 1).

Specifying Formats
Select the format for the converted data. When outputting channel data in columns select 
Normal, and for rows, select Trans position.  

		

Display Example of the Converted Data (normal) Display Example of the Converted Data (trans position)
Version
Version

Version
Version

Notes When Converting Data
•	 There is a limit in the number of data points that Excel and Lotus1-2-3 can handle. 

Before executing the conversion, set the channels/groups to be converted, the 
conversion range, and the step so that the number of data points is appropriate. If the 
limit is exceeded, perform automatic division prior to conversion. Serial numbers are 
attached to divided-converted files.  In addition, if the free memory space on the PC is 
low, you may not be able to load the data using Excel or Lotus 1-2-3.

•	 If you set the save destination to a storage medium that has slow access such as a 
floppy disk, the saving of the data may take an extended time. It is recommended that 
such storage medium not be selected for the save destination.

•	 Select a save destination with adequate free space.
•	 The measured data during a burnout or measured data that exceeds the upper/lower 

limit of the measurement range are indicated as “+OVER” or “-OVER” 
•	 If invalid data exists in the converted data (measured value of a channel without input 

or computed value when the data used in the equation does not exist), the data is 
indicated as “INVALID” 

3.7  Converting Data Formats
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3.8	 Printing Data

Procedure

Setting the Contents to Be Printed
1.	 From the File menu, choose Print Setting.

				  

2.	 In the Print Setting dialog box, set Range, Color, and Print Group, and then click OK. 
Enter a comment in the Comment box as necessary.

	 When printing numeric values, you only need to set the range.

				  

Enter the comment to be printed

Switch to settings for numeric values

Select the groups when Selected Groups
is selected
Click to open the group selection dialog box

Select black/white or color print

Select the group to be printed

Settings for numeric values

Select to print all or print only the range specified by cursors
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Executing the Print Operation
1.	 From the File menu, choose Print.
	 The Print dialog box opens.
2.	 In the Print dialog box, select the printer, print range, and the number of copies, and 

then click the OK button. 
	 When printing waveforms, you cannot set the print range.

				  

Display example of the Print dialog box

Print Preview
From the File menu, choose Print Preview.
The print image is displayed.

		

Setting Up the Printer
1.	 From the File menu, choose Print Setup.
	 The Print Setup dialog box opens.
2.	 Set the paper size, orientation, etc. Then, click the OK button. 

				  

Display example of the Print Setup dialog box

3.8  Printing Data
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Explanation
Printed Items
To print waveforms, open the waveform display window; to print numeric values, open 
the numeric display window. If multiple waveform display windows or numeric display 
windows are open, click the window you wish to print.
To print cursor values or statistical computation over an area, open those windows also.
You can also print a list of alarms and marks. 
Print Range
If you wish to print a specified range of the waveform, specify the range using cursors. 
For the method of specifying the range using cursors, see the procedure in section 3.4, 
“Statistical Computation over an Area of Measured/Computed Data.” 
Printed Colors of Waveforms
You can select black/white print or color print.
Print Groups
•	 On Display Only
	 Only the groups whose waveforms are displayed are printed.
•	 All Groups
	 All groups that can be displayed on the waveform display window are printed.
•	 Selected Groups
	 Groups selected in the dialog box that opens (see the figure below) when the Select 

button is clicked are printed.

			 

Printing a Comment
You can enter a comment using up to 127 characters. The comment is printed in the Print 
Comment column.
Printing File Information
When you print data, the file information is also printed. You can check the file information 
in the dialog box that opens by choosing About Data from the Information menu. You can 
also select the items to be printed using the check boxes.

		

3.8  Printing Data
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Print Example
•	 When only the waveforms are printed

			 

File information about
the printed data

Note
If you wish to arrange the waveform graphs vertically when printing the waveforms of multiple 
record intervals, choose Tile Vertical under Graph/Sheet Layout from the Window menu. To 
arrange the waveform graphs horizontally, choose Tile Horizontally. 

•	 When cursor values, values of statistical computation over an area, and waveforms 
are printed

			 

File information about
the printed data

Statistical computation
over an area

Cursor values

3.8  Printing Data
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•	 When printing a list of numeric values

			 

3.8  Printing Data



3-31IM WX103-01E

1

2

3

4

5

Index

View
er

3.9	 Displaying the Software Version and Other 
Information

Procedure
Click the About button on the toolbar or choose About from the Help menu. 
A dialog box showing the version number and other information opens.

		
Version
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4.1	 Connecting the MX100 Data Acquisition Unit

Notes on Using the Calibration Software
•	 If another user or another software program is connected to the MX100, drop the 

connection before connecting with the Calibration Software. 
•	 If you change the module configuration before connecting with the Calibration 

Software, carry out system configuration on the Logger (see section 2.2, “Configuring 
the System”). 

•	 When calibrating, do not perform other operations. Use extra caution in the operation, 
because the module may malfunction if you execute a wrong operation while 
calibration is in progress.

Procedure
1.	 Start the Calibrator.
	 The Unit Information window opens.
2.	 In the IP Address/Host Name box, enter the IP address or host name of the MX100 

to be calibrated.
3.	 Click Connect.

				  

Enter the host name or IP address of the MX100 to be calibrated.

Execute connection

	 When the connection is established, information about the unit’s module 
configuration is displayed. If you click the Check button, the 7-segment LED on the 
main module of the connected unit shows the text “—CALL—” flowing from right to 
left.

				  

To disconnect the connected MX100

To turn on the 7-segment
LED on the connected
MX100 to check which unit
is the one connected

Information about the connected MX100

Modules attached to the
connected MX100 Data
Acquisition Unit

Chapter 4	 Calibrator
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	 If the specified IP address or host name is not correct, or the MX100 is connected by 
another software program, the following dialog box opens. 

				  

Note
•	 The Calibrator cannot be used to change the MX100 network settings (such as the IP 

address). Use the Logger for this purpose.
•	 If you change the module configuration before connecting with the Calibrator or if modules 

that are not operating properly exist, X marks are displayed on the modules as shown 
below. If you change the module configuration, reconfigure the system.

						    

When Setting a Password for Startup
You can use the following procedure to set the Calibrator up so that it prompt the user to 
enter a password upon startup.
1.	 From the File menu, click Set Password.
	 The New Password dialog box opens.

				  

2.	 Click the New Password box, and enter a password.
	 There are no restrictions on the characters that can be used in the password. You 

can enter up to 30 characters for the password.
3.	 Enter the same password in the Confirm New Password box, then click OK.
	 If you restart the Calibrator, a password confirmation dialog box opens. If you enter 

a wrong password and click OK, a dialog box with the message “The password is 
wrong.” opens. Click OK to close the Calibrator.

				  

Note
To set up the Calibrator so that no password dialog box is displayed, open the password setting 
dialog box, make sure the entry boxes are blank, and click OK. There are no other means of 
clearing the password. Be sure not to forget the password.

4.1  Connecting the MX100 Data Acquisition Unit
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4.2	 Calibration Procedure

Procedure
1.	 Click the illustration of the universal input module that you wish to calibrate. 

				    Moving the cursor over
an input module that can
be calibrated shows the
word “Calibrate”

2.	 On the calibration detail setup screen that appears, select the channel and 
measurement range to be calibrated and click the >> button. 

	 The figure below is an example of the 4-CH, High-Speed Universal Input Module.

				  

Items to be calibrated
You can also click to select

To move to the calibration
execution screen 1

Select the channel and
the measurement range
to be calibrated from
the list
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	 The figure below is an example of the 10-CH, Medium-Speed Universal Input 
Module. Channels are not selected.

				  

Items to be calibrated
You can also click to select

To move to the calibration
execution screen 1

Select the measurement range
to be calibrated from the list

	 The figure below is an example of the 30-CH, High-Speed Analog DCV/TC/DI Input 
Module. A range is not selected.

				  

Items to be calibrated
You can also click to select

To move to the calibration
execution screen 1

Select the measurement range
to be calibrated from the list

	 The figure below is an example of the 6-Channel, Medium-Speed, Four-Wire RTD 
Resistance Input Module. Channels are not selected.

				  

Items to be calibrated
You can also click to select

To move to the calibration
execution screen 1

Select the measurement range
to be calibrated from the list

4.2  Calibration Procedure
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	 The figure below is an example of the 4-CH, Medium-Speed Strain Input Module. 
Channels are not selected.

				  

Items to be calibrated
You can also click to select

To move to the calibration
execution screen 1

Select the measurement range
to be calibrated from the list

	 The figure below is an example of the 8-CH, Medium-Speed Analog Output Module. 
A range is not selected.

				  

Items to be calibrated
You can also click to select

To move to the calibration
execution screen 1

Select the measurement range
to be calibrated from the list

4.2  Calibration Procedure
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3.	 After making the connections according to the explanation given on the calibration 
execution screen 1, click the Calibrate button.

	 The figure below is an example of the 4-CH, High-Speed Universal Input Module.

				  

Start calibration

To return to the Unit Information screen

To return to the previous screen

	 The figure below is an example of the 8-CH, Medium-Speed Analog Output Module. 

				  

Start calibration

To return to the Unit Information screen

To return to the previous screen

	 When you click the Calibrate button, a message “Please wait and do not perform any 
other operation.” appears.

	 When the calibration completes successfully, the calibration execution screen 2 
appears.

	 If the calibration fails, a message “Failed to calibrate.” appears.

				  

Note
For a description of the accuracy of the connected input module, the calibration accuracy, 
and the environmental conditions for calibration, see the MX100 Data Acquisition Unit User’s 
Manual.

4.2  Calibration Procedure
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4.	 After making the connections according to the explanation given on the calibration 
execution screen 2, click the Calibrate button.

	 The figure below is an example of the 4-CH, High-Speed Universal Input Module.

				  

Start calibration

	 The figure below is an example of the 8-CH, Medium-Speed Analog Output Module.

				  

Start calibration

	 The figure below is an example of the 30-CH, Medium-Speed DCV/TC/DI Input 
Module.

	 Example of the clamp terminal

				  

Start calibration

4.2  Calibration Procedure
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	 Example of the M4 screw terminal

				  

Start calibration

	 When you click the Calibrate button, a message “Please wait and do not perform any 
other operation.” appears.

5.	 Repeat steps 1 to 4 until all calibrations are completed.

6.	 From the File menu, choose Write.
	 The calibration values are written to the input module.

				  

Note
During calibration, do not perform any other operations (particularly turning OFF the MX100 or 
dropping the connection). Doing so may cause the MX100 to malfunction.

4.2  Calibration Procedure
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Explanation
Calibrated Parameters
•	 4-CH, High-Speed Universal Input Module (MX110-UNV-H04)

Measurement Range to Be Calibrated Input Value 1 Input Value 2
20 mV 0 mV 20 mV
60 mV 0 mV 60 mV
200 mV 0 mV 200 mV
1 V 0 V 1 V
2 V 0 V 2 V
6 V 0 V 6 V
20 V 0 V 20 V
100 V 0 V 100 V
RTD (1 mA) 200 mV 0 Ω 200 Ω
RTD (1 mA) 600 mV 0 Ω 300 Ω
RTD (1 mA) 1 V 0 Ω 500 Ω
RTD (2 mA) 60 mV 0 Ω 30 Ω
RTD (2 mA) 200 mV 0 Ω 100 Ω
RTD (2 mA) 600 mV 0 Ω 300 Ω
RTD (2 mA) 1 V 0 Ω 250 Ω

•	 10-CH, Medium-Speed Universal Input Module (MX110-UNV-M10)
Measurement Range to Be Calibrated Input Value 1 Input Value 2
20 mV 0 mV on Ch1 20 mV on Ch2
60 mV 0 mV on Ch1 60 mV on Ch2
200 mV 0 mV on Ch1 200 mV on Ch2
1 V 0 V on Ch1 1 V on Ch2
2 V 0 V on Ch1 2 V on Ch2 
6 V 0 V on Ch1 6 V on Ch2
20 V 0 V on Ch1 20 V on Ch2
100 V 0 V on Ch1 100 V on Ch2
RTD (1 mA) 60 mV 0 Ω on Ch3 60 Ω on Ch6
RTD (1 mA) 200 mV 0 Ω on Ch3 200 Ω on Ch4
RTD (1 mA) 600 mV 0 Ω on Ch3 300 Ω on Ch5

•	 30-CH, Medium-Speed DCV/TC/DI Input Module (MX110-VDT-L30)
Measurement Range to Be Calibrated Input Value 1 Input Value 2
20 mV 0 mV on Ch1 20 mV on Ch2
60 mV 0 mV on Ch1 60 mV on Ch2
200 mV 0 mV on Ch1 200 mV on Ch2
1 V 0 V on Ch1 1 V on Ch2
2 V 0 V on Ch1 2 V on Ch2 
6 V 0 V on Ch1 6 V on Ch2
20 V 0 V on Ch1 20 V on Ch2
100 V 0 V on Ch1 100 V on Ch2
RTD (1 mA) 60 mV 0 Ω on Ch3 60 Ω on Ch6
RTD (1 mA) 200 mV 0 Ω on Ch3 200 Ω on Ch4
RTD (1 mA) 600 mV 0 Ω on Ch3 300 Ω on Ch5

4.2  Calibration Procedure
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4.2  Calibration Procedure

•	 Six-Channel, Medium-Speed Four-Wire RTD Resistance Input Module (MX110-
V4R-M06)
Measurement Range to Be Calibrated Input Value 1 Input Value 2
20 mV 0 mV on Ch1 20 mV on Ch2
60 mV 0 mV on Ch1 60 mV on Ch2
200 mV 0 mV on Ch1 200 mV on Ch2
1 V 0 V on Ch1 1 V on Ch2
2 V 0 V on Ch1 2 V on Ch2
6 V 0 V on Ch1 6 V on Ch2
20 V 0 V on Ch1 20 V on Ch2
100 V 0 V on Ch1 100 V on Ch2
RTD (1 mA) 20 mV 0 Ω on Ch3 20 Ω on Ch4
RTD (1 mA) 60 mV 0 Ω on Ch3 60 Ω on Ch5
RTD (1 mA) 200 mV 0 Ω on Ch3 200 Ω on Ch6
RTD (1 mA) 600 mV 0 Ω on Ch3 300 Ω on Ch4
RTD (0.25 mA) 600 mV 0 Ω on Ch3 2400 Ω on Ch5
RTD (0.25 mA) 1 V 0 Ω on Ch3 3000 Ω on Ch6

•	 4-CH, Medium-Speed Strain Input Module (MX112-B12-M04, MX112-B35-M04, 
MX112-NDI-M04)
Measurement Range to Be Calibrated Connect1 Connect2
2000 µSTR (strain) 120.000 Ω on Ch2 117.154 Ω on Ch2
20000 µSTR (strain) 120.000 Ω on Ch2 113.010 Ω on Ch2
200000 µSTR (strain) 120.000 Ω on Ch2 80,000 Ω on Ch2

	 Use a 4-gauge method connection when performing calibration. For information on 
this connection, see section 2.4 of the MX100 Data Acquisition Unit User’s Manual (IM 
MX100-01E).

•	 8-CH, Medium-Speed Analog Output Module (MX120-VAO-M08)
	 Adjust so that all channels output 0 V and 10 V. This differs from other input modules.

Range to Be Calibrated Output val. 1 Output val. 2
10 V 0 V 10 V

Note
For a description of the measurement range and accuracy of each input module, see sections 4.4 
and 4.5 in the MX100 Data Acquisition Unit User’s Manual (IM MX100-01E).
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5.1	 Troubleshooting

If servicing is necessary, or if the instrument is not operating correctly after performing 
the corrective actions below, contact your nearest YOKOGAWA dealer for repairs.

The 7-segment LED does not illuminate.
Probable Cause Corrective Action Reference Page
The power switch is not ON. Turn ON the power switch. *
The supply voltage is too low. Check whether the voltage is within the supply voltage rating 

range.
*

The fuse is blown. Servicing required. -
The power supply is broken. Servicing required. -

* See the MX100 User’s Manual (IM MX100-01E).

The 7-segment LED blinks repeatedly.
Probable Cause Corrective Action Reference Page
The power supply is shorted inside 
the input/output module.

Remove the module one by one and determine which module 
is broken. (Servicing required.)

*

The power supply is shorted inside 
the main module.

Replace the main module. (Servicing required.) *

* See the MX100 Data Acquisition Unit User’s Manual (IM MX100-01E).

After power up, the 7-segment LED displays something other than “ ”(when the unit 
number is 00).
Probable Cause Corrective Action Reference Page
The display is b*  
(where * is any character other than F) 
The dipswitch settings are not correct.

Turn OFF the power, remove the CF card, turn ON all 
dipswitches, and power up again.  If the situation does not 
change, servicing required.

*

The display is bF.  
The dipswitch settings are not correct. 

Powering up in setup reset mode. Turn OFF the power, turn 
ON all dipswitches, and power up again. Since all settings 
such as the IP address are initialized, reconfiguration is 
necessary.

2-3,2-4
*

The display is F* 
(where * is any character).  
Hardware error on the main module 

Servicing required. -

The display is E*  
(where * is any character). 
Hardware error on the input/output 
module.

The slot number is indicated by * in the n* display following the 
E* display. 
Remove the relevant module and power up again. 
The relevant module must be serviced.

* 

The display is P0.  
Media (CF card) operation error. 

Do not manipulate the CF card while it is being accessed. *

The display is P1.  
Media (CF card) error. 

Reformat the CF card or replace the CF card. *

The display is P2.  
Format error. 

Check whether the CF card is inserted correctly. 
Then, reformat the CF card or replace the card.

*

The display is P3.  
Insufficient free space 

Delete the files on the CF card to free up some space. -

The display is P4.  
Number of files over the limit

The number of created files exceeded the allowed amount.  
Stop the recording. Replace the CF card or delete files and 
restart.

*

The display is P5.  
Overwrite error in the data storage 
buffer

The time needed to store the file must be reduced.
Delete unneeded data to increase the free space, or format 
the CF card. 

*

The display is C1. 
Multiple TCP connections 

Turn OFF the power and reconnect. *

* See the MX100 Data Acquisition Unit User’s Manual (IM MX100-01E).

Chapter 5	 Troubleshooting
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The MX100 cannot be detected from the PC or cannot be detected with the Search 
button.
Probable Cause Corrective Action Reference Page
The LINK LED does not turn ON.  
The cable is broken. 

Replace the Ethernet cable. -

The LINK LED does not turn ON.  
There is a problem with the hub. 

Check the hub’s power supply. If it still does not work, replace the 
hub and check the hub’s operation. Also, try to connect the MX100 
using the 10-Mbps fixed mode. 

-

The LINK LED does not turn ON.  
There is a problem with the PC.

Check whether the PC can connect to the network. 
Replace the PC’s NIC.

-

The ACT LED does not turn ON.  
There is a problem in the connection  
between the hub and the MX100. 

Check the hub’s power supply. If it still does not work, replace the 
hub and check the hub’s operation. Also, try to connect the MX100 
using the 10-Mbps fixed mode.

*

The ACT LED does not turn ON.  
There is a problem with the PC.

Check whether the PC can connect to the network.
Replace the PC’s NIC.

-

There is a problem in the network  
configuration. 
The settings are not correct. 

Check that the IP address, subnet mask, and default gateway 
settings of the PC correspond to the MX100 settings.

2-3, 2-4

There is a problem in the network 
configuration. 
The setting changes have not taken 
effect.

Turn OFF the power to the PC and the MX100, and carry out 
reconnection.

-

The PC and the MX100 are not in the 
same segment.

Connect the PC and the MX100 in the same network segment. 
If the PC and the MX100 are connected as shown in the following 
figure, the Search button cannot be used to detect the MX100. 
However, you can make a connection manually by specifying the 
IP address.

MX

PC

Router

Network A

Network B

2-3, 2-4

* See the MX100 Data Acquisition Unit User’s Manual (IM MX100-01E).

The MX100 is detected by clicking the Search button, but connection cannot be made. 
Probable Cause Corrective Action Reference Page
The IP address is set to the default 
value. 
The default value cannot be used to 
make the connection.

Enter the correct IP address. 2-3, 2-4

There is a problem in the network 
configuration.

Check that the IP address, subnet mask, and default gateway  
settings of the PC and the MX100 settings are correct.

2-3, 2-4

Follow the rules for I/O on the PC 
software module style number, and 
release number

Check the PC software release number and main unit style 
number Upgrade to a later style.
[PC software release no.] ≥ [main unit style no.] ≥ [module style 
no.]

*

*	 See the MX100 User’s Manual (IM MX100-01E).

Six-Channel Four-Wire RTD resistance input module recognized as a 10-CH universal 
input module 
Probable Cause Corrective Action Reference Page
The MX100 main unit style number 
remains at 1.

Upgrade to a later style. **

**	See the MX100 Upgrade Kit user’s manual (IM MX100-77).

5.1  Troubleshooting
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MX100 cannot be connected using the Calibrator 
Probable Cause Corrective Action Reference Page
Attempting to make multiple connections.  
Another software program is already 
connected. 

Exit all other software programs. -

The connected input/output module is not detected.
Probable Cause Corrective Action Reference Page
Module connection or module startup 
error. 
Attached the module while the power was 
ON. 

Turn OFF the power. Detach the input/output module once 
and  
attach it again.

*

Carried out an incorrect calibration. Recalibrate. 4-1

*	 See the MX100 User’s Manual (IM MX100-01E).

Alarms are not output.
Probable Cause Corrective Action Reference Page
There is a problem in the alarm setting. Both the alarm and output relay must be set appropriately. 

Make the alarm and output relay settings appropriate.
2-37~2-42

Current is not output from the analog output module, and no output comes from the 
PWM output module.
Probable Cause Corrective Action Reference Page
External power supply required. Connect an external power supply. *

Transmission output is not output from the analog output module, nor from the PWM 
output module.
Probable Cause Corrective Action Reference Page
“Transmit not enabled” Enable it. Enable it. 2-50

No output from the PWM output module
Probable Cause Corrective Action Reference Page
The output current limit (1A) has been 
exceeded. Turn OFF the external power 
supply, check the load, power cycle.

Once the limit is exceeded the protection circuit activates, 
and you must power cycle the external power supply or it 
will not recover.

-

No output from the PWM output module
Probable Cause Corrective Action Reference Page
The fuse is blown. 
(4A/module limit has been exceeded)

Servicing required. -

The CF card is not detected.
Probable Cause Corrective Action Reference Page
There is a problem with the CF card. Replace the CF card. 

Eject and format the CF card, then insert it again.
*

*	 See the MX100 Data Acquisition Unit User’s Manual (IM MX100-01E).

5.1  Troubleshooting
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The measured value is not correct.
Probable Cause Corrective Action Reference Page
The input wiring is not correct. Check the input wiring. *
The measured value is at +Over or –Over. 
The measurement range setting and input 
range do not match. 

Change to an appropriate setting. *

The temperature error is large or is 
unstable. The TC type setting and the type 
actually connected are different.

Change to the correct setting. *

The temperature error is large or is 
unstable. 
The RJC setting is not correct.

Change to the correct setting. *

The temperature error is large or is 
unstable. 
The wind is hitting the terminals.

Block the wind from hitting the terminals. -

The temperature error is large or is 
unstable. 
The ambient temperature change is 
drastic.

Suppress changes in the ambient temperature such as by 
placing the MX100 in a box.

-

The temperature error is large or is 
unstable. 
There is an error in the wiring resistance  
(in the case of an RTD).

Match the thickness and length of the three wires. *

The measurement error is large or is  
unstable. 
Noise effects.

Take measures against noise. *

The measurement error is large or is 
unstable. 
Effects from the signal source resistance.

Reduce the signal source resistance such as by inserting  a 
converter.

-

The temperature error is large or is  
unstable. 
 Effects from parallel connections.

Stop parallel connections. 
Do not use the burnout setting.

-

Measured value from strain gauge type 
sensor not correct.

When using a sensor without a remote sensing wire, 
use the DV450-001 (conversion cable).

*

On the strain module (-B12, -B35), the 
gauge method dipswitch settings is not 
correct.

Enter the correct settings. *

On the strain module (-B12, -B35), the 
gauge resistance and internal bridge 
resistance values are different.

Use a module that supports the resistance value of the strain 
gauge (For 120Ω, -B12, and for 350Ω, -B35.)

*

On the strain module, scaling 
corresponding to the gauge method is 
not set. (for 2 gauge, 4 gauge methods, 
the amount of strain is doubled or 
quadrupled.)

Displayed with 1 gauge method conversion. Depending on the 
gauge method, set scaling appropriately.

*

On the strain module (-NDI), a strain 
gauge type sensor without a remote 
sensing wire is being used.

When using a sensor without a remote sensing wire, use the 
DV450-001 (conversion cable).

*

*	 See the MX100 User’s Manual (IM MX100-01E).

5.1  Troubleshooting
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5.2	 Error Messages and Their Corrective Actions

Error Messages on the Logger 
Code Message Corrective Action/Description Reference Page
– Undetermined Directory. The save destination of the record file cannot be found.  

Check whether the save destination exists.
2-11

E5501 Recording or Working. Try again once recording stops. 1-22
E5502 Cannot open file.Check viewer. If a dialog box is open in the Viewer, close it. –
E5503 It failed in acquisition of CF 

information. Please verify the usage 
condition of the equipment

Check whether the host name is correct, and whether the 
main unit is connected.

2-6

E5504 Failed to get channel and network 
configuration.

Check the disk capacity and whether the file system is 
correct.

2-6

E5505 Failed to get information. Check 
connecting MX.

Check the disk capacity and whether the file system is 
correct.

2-6

E5506 Failed to create folder. Check the disk capacity and whether the file system is 
correct.

–

E5507 Invalid folder name.
Please enter a new name.

Specify a valid folder name. –

E5508 Cannot contain any of the following 
characters:\n \\ / : , ; * ? " < > |\nCON 
PRN AUX CLOCK$ NUL COM1-9 
LPT1-9

Use characters other than the following: “ \\ /: , ; * ? " < > 
|CON PRN AUX CLOCK$ NUL COM1-9 LPT1-9”

–

W5531 The current channel setup contains 
invalid use of reference channels.
Channels whose mode is set to RRJC.
Channels used for difference input.
Transmission AO channels.
Transmission PWM channels.
Do you wish to continue after 
disabling the invalid channels?

Click No and change the settings of inappropriate 
channels. 
To disable the inappropriate channels, click Yes.

2-20 to 2-23

W5532 In order to balance the strain 
channels, it’s necessary for channels 
to be set up correctly.
The current channel setup contains 
invalid use of reference channels.
Some measurement channels set to 
RRJC mode.
Channels used for difference input.
Transmission AO channels.
Transmission PWM channels.
Do you wish to continue after 
disabling the invalid channels?

Click No and change the settings of inappropriate 
channels. 
To disable the inappropriate channels, click Yes.

2-20 to 2-23

W5533 Invalid modules exist. do you get 
configuration after reconstructing?

Click OK to reconfigure the system based on the 
information acquired from the main unit. 

1-6

M5561 Stop record? Click OK to stop recording. 2-74
M5562 Stop monitoring and quit? Click OK to stop acquisition. 2-76
M5563 Assign all modules to appropriate 

measuring groups?
Click OK to assign automatically. 1-6

M5564 Please wait until writing of data is finished. –
M5565 Restart the monitor server to apply the changed port 

number.
2-79

M5566 State: Active
Max.: □□□ bytes
Free: □□□ bytes

– 2-9

M5567 Check whether the CF card is formatted. –
M5568 Insert a CF card. *
M5569 Apply the edited network 

configuration of MXs?
Click OK to send settings. 2-3

M5570 Modules of Slot□ - Slot□ will be 
changed. Ok to continue?

Click OK to change the specified module. Cancel to return 
to the previous screen.

2-6

*	 See the MX100 User’s Manual (IM MX100-01E).
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Error Messages on the Viewer
Code Message Corrective Action/Description Reference Page
E0002 Insufficient memory. Please close at 

once.
Attempting to load multiple files containing close to five 
million data points. Insufficient free memory in the PC 
virtual memory. Set the size of the PC’s virtual memory to 
2 GB or more.

3-2

E0004 File write error. The file cannot be created for some reason. –
E3111 Channels of the specified recording 

interval do not exist. 
Channels with the specified measurement interval do not 
exist in the conversion of the data format.  
Change to the correct setting.

3-24

E3114 Sampling data number is over the 
Viewer display limit of 5 M.

Attempting to load a file containing 5 million or more data 
points.

3-2

W3115 Converting operation exceeded the 
limitation of MS Excel.

Change the range to be converted so that it is within the 
allowed range of Excel.

3-25

W3116 Converting operation exceeded the 
limitation of Lotus 1-2-3.

Change the range to be converted so that it is within the 
allowed range of 1-2-3.

3-25

E0212 Can’t read file. The file cannot be loaded, or the file has been deleted. 3-2
E3120 Not an MX file. Cannot load the file. 3-2

Error Messages on the Calibrator
Code Message Corrective Action Reference Page
W4700 Connection failure.   

Check the IP Address/Host Name.
To change the network settings such as the IP address, 
start the Logger.

2-3

W4701 Failed to write the calibrated value. Recalibrate. If still displayed, service required. 4-3 to 4-7
W4702 Failed to calibrate. Recalibrate. If still displayed, service required. 4-3 to 4-7

5.1  Troubleshooting
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